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Preface 
This guide enables you to configure the Oracle Retail Macro Space Management, along 
with the server-side components required for the application.  

Audience  
This Configuration Guide is written for the following audiences:  

  Database administrators (DBA)  

  System analysts and designers  

  Integrators and implementation staff  

Related Documents  
For more information, see the following documents in the Oracle Retail Macro Space 
Management Release 5.4.027.1 and In-Store Collaboration Release 5.4.46.1 documentation 
set:  

  Oracle Retail Macro Space Management Configuration Guide 

  Oracle Retail Macro Space Management Release Notes 

  Oracle Retail Macro Space Management User Guide 

  Oracle Retail Macro Space Planning Installation Guide 

  Oracle Retail Macro Space Planning Licensing Information 

For more information on In-Store Space Collaboration see the following documents in the 
Oracle Retail In-Store Space Collaboration Release 5.4.46.1 documentation set: 

  Oracle Retail In-Store Space Collaboration Release Notes 

  Oracle Retail In-Store Space Collaboration User Guide 

Customer Support  
To contact Oracle Customer Support, access My Oracle Support at the following URL: 

  https://metalink.oracle.com  
When contacting Customer Support, please provide the following: 

  Product version and program/module name 

  Functional and technical description of the problem (include business impact) 

  Detailed step-by-step instructions to re-create 

  Exact error message received 

  Screen shots of each step you take 

Conventions  
Navigate: This is a navigate statement. It tells you how to get to the start of the procedure 
and ends with a screen shot of the starting point and the statement “the Window Name 
window opens.”  

Note: This is a note. It is used to call out information that is 
important, but not necessarily part of the procedure.  
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This is a code sample  

It is used to display examples of code  

A hyperlink appears like this. 
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1 
Overview of the Admin Module 

The Administration Module is used for configuring global settings used with both 
Macro Space Management and In-Store Space Collaboration. 

 

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management. All aspects of the Admin Module where 
settings can be made affecting the operation of In-Store 
Space Collaboration will be clearly identified.  

All options in the Administration Module are applicable to Macro Space Management. 
Options directly applicable to In-Store Space Collaboration are: 
1. Data Security 
2. Functional Security 
3. Statuses 
4. System Variables 
5. User Defined Attributes 
See the individual sections for more information. 
 

The Admin Module 
The Admin Module contains a menu bar. 
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Clicking any of the options discloses a pull down menu giving access to further options. 
 
   

The File Pull Down Menu 
The File pull down menu has two options – configure and exit. 

 

Configure brings up the Configuration Module, where a series of basic settings affecting 
the operation of Macro Space Management can be changed.  
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Exit allows the user to close the Admin Module 
 

The General Pull Down Menu 
The General pull down menu gives access to options used for overall planning within 
Macro Space Management.  

 
 

Option Comment 

Calendars Configure the calendars used for financial planning. 

Manufacturers Configure the list of manufacturers used for fixtures and for merchandise 



The Planning Pull Down Menu 
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Option Comment 

Status Configure the statuses used for Store, Floors, Revisions, Files, Fixtures, 
Products and Planograms 

Status Levels Configure the sequence statuses will be used in 

System 
Variables 

Change the values of the system variables used by Macro Space Management 
and In-Store Space Collaboration 

Tax Codes Set the values of the tax bands used for merchandise 

Units Set the units used for information 

User Defined 
Attributes 

Set the options for information associated with Users, Stores, Files, Fixtures, 
Products and Planograms. 

 
   

The Planning Pull Down Menu 
The Planning pull down menu gives access to options used for laying out drawings 
within Macro Space Management.  

 
 

Option Comment 

Hatch Styles Hatch styles allow the user to configure the patterns used to color in Zones.   

Scales Scales allows the user to specify the scales used in Paper Space in AutoCAD 
(Planner Module) 

Text Styles Text Styles are the parameters used for annotation within the drawing 

Title Blocks Title Blocks are used in Paper Space in AutoCAD (Planner Module) to display 
information about the store plan 

Zone Types Zone Types are the broad classes Zone Definitions fall into 

Zone Definitions Zone Definitions are areas of a store plan used for a specific retailing purpose.  

 
   

The Merchandising Pull Down Menu 
The Merchandising pull down menu gives access to options used for Products and 
Planograms. 
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Option Comment 

Adjacency Rules Allows the user to specify rules on which products should or should not be 
adjacent to each other 

Severity Types Allows the use to specify the comments associated with the adjacency rules 

Planogram 
Substitution 

Allows the use to specify which planograms to change in a drawing 

Product Code 
Types 

This option allows the user to specify the masks used for Product Codes  

Ranges Specifies temperature or weight options for products 

Seasons Allows the user to specify the seasons specifying whether time sensitive 
merchandise is valid to place.  

Styles This option allows users to configure Styles and Style Relationships 

 
   

The Logs Pull Down menu 
The Logs pull down menu gives access the logs used to record user activities. 

 
 

Options on the Logs pull down menu allow users to call dialogue boxes displaying the 
varying logs available 
 
   

The Security Pull Down Menu 
The Security pull down menu gives access to options used for assigning access. 
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Option Comment 

Security Options Security Options allows the users to specify options about passwords 

Functional 
Security 

Functional Security allows Administrators to create users and to define the 
access allowed to those users  

Data Security Data security allows Administrators to specify access to stores, products and 
statuses 

 
   

The Tools Pull Down Menu 
The Tools pull down menu gives access to varying administrative options. 

 
 

 

Option Comment 

Purge Purge allows administrators to permanently delete items marked for deletion 

Update ID Table This option causes the AVTTB_NEXTID table to be manually updated 

Unlock Tables This option allows Administrators to check back in information in tables that 
might have been checked out for some reason - for example a software failure 
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The Window pull down menu 
The Window pull down menu allows the user to arrange the windows open in the Admin module. 

 
 

The Cascade function arranges open drawing windows so that they overlap. 
The Minimise All function allows the user to minimise all open dialog interfaces.  
The Maximize All function allows the user to open for view all minimised dialog 
interfaces. 
 
   

The Help pull down menu 
The Help pull down menu calls this Help File. 

 
 

About displays information on the version of Macro Space Management currently in use. 
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2 
General Options 

Calendars 
The Calendars Option allows the user to set up a series of calendars - each Calendar 
covering a set period of time for retailing activities.  

 
 

These Calendars can then be used to control information within Macro Space 
Management including: 

  Financial Reporting 

  Importing EPOS data within specific date ranges. 

  Displaying KPI's for specific date ranges.  

  Roll ups - 4/5 week months 
Calendars can be set up within the Admin Module.   
It is more usual to import calendars using Data Importer. This means that the time 
periods used within Macro Space Management will be aligned with the time periods 
used in other databases - for example those used by accounting software.  
 

Financial Reporting 
Calendars are often used for financial reporting. 



Calendars 

General Options 9 

 
 

When data is imported, it is normally associated with one or more Calendar Periods. This 
allows users to identify the time period that the data is associated with. For example data 
for a specific SKU might show Purchase Price, Sales Price, Sales Margin and Profit for the 
past day, week, month, quarter and year. 
Associating SKU (PRD_ID) with a Calendar Period (CAL_ID) enables KPIs, Reports, etc, 
to be structured by time intervals. 
 

Importing EPOS Data Within Specific Date Ranges 
EPOS data for a specific product may be associated with many time periods. For 
example, a product may have data based on:  

  Years  

  Quarters 

  Seasons 

  Months 

  Weeks 

  Days 
If there are 50,000 products at SKU level and 'day' data is held for three years, there 
would be nearly 55 million records in the EPOS table. Accordingly, many customers 
choose to consolidate data. If an EPOS table was being deleted and re-populated weekly, 
the data import might bring in: 

  Data by years for the last three years   

  Data by quarters for the last four quarters 

  Data by seasons for the last three seasons 

  Data by months for the twelve months 

  Data by weeks for the last three months 

  Data by days for the last four weeks 

Note: EPOS data types are identified by Calendar ID 
(CAL_ID). 

This substantially reduces the amount of data held in the EPOS table and increases 
performance when KPIs, etc, are run. 
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Note: performance can also be improved by indexing the 
EPOS table, partitioning the EPOS table, etc. 

 

Using Calendars in KPIs 
Calendars are used in KPIs to select data by date range. Using calendars is in four 
stages: 

  The calendar is imported or set up 

  Data is imported into the table holding EPOS data 

  The KPI is configured 

  The KPI is selected and used 
Importing or Setting up the Calendar 

The calendar is either imported or set up. One option that can be set is the calendar type. 

 
 

Data is Imported into the table holding EPOS (Electronic Point Of Sale) Data 
The table used to hold the imported EPOS data will differ from implementation to 
implementation but will require certain mandatory columns.  
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  PRD_ID (Product ID) identifies the Product  

  STR_ID (Store ID) identifies the Store 

  CAL_ID (Calendar ID) identifies the time period in the calendar 
In addition at least one item of financial data is required. 
The KPI is Configured 

The KPI is then configured. It can either be set up as a View or as a Stored Procedure. The 
KPI will typically take financial information from the EPOS table and combine it with 
information from other MSM tables. For example the AVTTB_PRODUCT table contains 
information on which products are on what fixtures - enabling the KPI to specify 
financial performance by fixture. 
Where it is necessary to filter data by time period, the KPI should also include the 
CAL_ID. 
The KPI is Selected and Used 

When the KPI is selected for use, the user selects a date and a data type. The options in 
the data type drop down list match those in the Type drop down list in the Calendar 
dialog box.  

Note: selecting the Data Type is specifying the CAT_ID in 
the AVTTB_CALENDAR table. 

 
 

When a date and the data type has been selected, the software will select data from the 
AVTTB_CALENDAR table where the date is within the CAL_ID or the required 
Calendar Type (CAT_ID) 
For example, if a customer selects a date of 5/6/09 and a data type of 'Month', the 
software will identify the calendar period (CAL_ID) of calendar type (CAT_ID) = 4 
containing the date 5/6/09. The calendar period (CAL_ID) is then used as a filter to 
select data.  
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Roll-ups 
Sometimes, for accounting purposes, it is necessary to know exactly how a calendar 
period is sub-divided, or how many weeks are in each month (some may contain 4 weeks 
and some may contain 5). After Calendar Information has been imported, it is possible to 
use the AVTTB_CALENDAR table to concatenate information for reporting purposes.  

 
 

All calendar periods (with the exception of the root) have a Calendar ID (CAL_ID) and a 
Calendar Parent ID, (CAL_PID).  
The type of calendar period can be identified from the Calendar Type ID (CAT_ID). This 
is a foreign key to the AVTTB_CALENDAR_TYPE table. The CAT_ID's are as follows: 

CAT_ID Description 

0 All 

1 Year 

2 Season 

3 Quarter 

4 Month 

5 Week 

6 Day 

 
It is then possible to use SQL to produce very specific reports. For example, all weeks 
have a CAT_ID of 5. By looking at the Parent ID's of each week, (CAL_PID), it is possible 
to assign each weeks to a specific month, thus allowing Administrators to identify 4 and 
5 week months within a report.  
 

The Calendars Dialogue Box 
The Calendars Dialogue Box has a number of parts. 
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  The Menu Bar gives access to a series of options. 

  The Toolbar also gives access to most of those options. 

  The Calendar Hierarchy allows users to see the available calendars. 

  The Calendar Details section gives more information on the selected calendars. 

  The Status Bar gives information on the number of calendars in the selected section.  
 
   

Calendars Menu Bar and Toolbar 
The File pull down menu allows users to exit the application.  

 
 

The Edit pull down menu allows users to add, edit and delete calendars. It also allows 
users to expand or collapse sections of the calendar hierarchy. 
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The View pull down menu allows users to turn the Toolbar and status bar display on or 
off. It also enables users to refresh the hierarchy with any changes made by other users. 

 
 

The Help pull down menu allows users to call hep and to get information on the version 
of the software. 

 
 

Toolbar 

 
 

 
Exit 

 
Add Calendar 

 
Edit Calendar 

 
Delete Calendar 

 
Refresh 
Calendars 

 
   

Adding a Calendar 
To Add a Calendar, pick the point in the hierarchy to add a calendar and then click on 
the Add Calendar icon. 
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This will open a new line in the Calendar Details section. 

 
 

Type in the details and press <Return>. The calendar will be added to the list.  

Note: If <Return> is not pressed, the data will not be saved 
to the database.  

 
 

Calendars are set by means of a drop down calendar option. 
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There are two ways of selecting the month. 

 
 

Users can use the left or right arrows (left hand image) to move between months.  
Alternatively, position the mouse pointer over the month bar and hold down the left 
mouse key. This will bring up a scrollable menu of months.  
Hold the mouse pointer just above or below it to move through it. 
 
   

Editing and Deleting Calendars 
Editing a Calendar is done by selecting the appropriate entry and changing the selected 
values. 
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Note: Caution should be used in editing calendars in case 
Import Routines and KPI's reference the calendar. 

To Delete a Calendar highlight the required calendar and click on the delete icon 
The calendar will be deleted without further warning if not in use. If in use, a delete 
conformation will be requested. 
 

Manufacturers 

Overview 
The Manufacturers Option is used to create a list of manufacturers for use within the 
Macro Space Management software.  

 
 

The list of manufacturers is used in two places in the software: 
1. It allows Manufacturers to be assigned to Fixtures in Fixture Studio. 
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1. It allows Manufacturers and Suppliers to be assigned to Products at the SKU level in 
Product Studio. 
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Note: A Manufacturer would typically be the company that 
produces the product, a Supplier the wholesaler that 
supplies it.  

The list of manufacturers can either be entered manually in the Admin Module, or 
imported from a third party database using Macro Space Management's Data Import 
module. The Manufacturers option in the Admin Module allows this list of 
manufacturers to be reviewed, then edited.  
 

Adding A Manufacturer 
To Add a Manufacturer click on the Add Manufacturer icon. 
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(Alternatively, click in the name box if a manufacturer has already been added).  
Type in the Manufacturers Name and Code into the pertinent boxes.  
Select the Manufacturer's Type from the drop down list.  

 

Manufacturers classed in the Fixtures Category will become available in the Fixture 
Studio Module. Similarly, manufacturers classed in the Products Category will become 
available in the Product Studio Module.  
Finally, press <Return>. This will store the Manufacturer in the central Macro Space 
Management database. 

Note: Ensure <Return> is pressed for every entry. If not, the 
information will not be stored in the central Macro Space 
Management database. 
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Editing a Manufacturer 
To Edit a Manufacturer click on the entry in the table of manufacturers.. 

 

Edit the entries as required. 
Finally, press <Return>. This will store the changes to that Manufacturer in the central 
Macro Space Management database. 

Note: Ensure <Return> is pressed for every entry. If not, the 
information will not be stored in the central Macro Space 
Management database. 

 
     

Deleting a Manufacturer 
Deleting a manufacturer is a three stage operation.  
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First, the required manufacturer is highlighted in the list then the Delete icon is clicked.  
A confirmatory dialogue will appear. 

 

Clicking on Yes will delete the selected entry. 

Note: at present the software does not validate if the 
Manufacturer is referenced elsewhere in the software - for 
example by Fixtures or Products. Before manually deleting a 
Manufacturer, it is suggested that it is verified that the 
Manufacturer is not in use. This may require a query in the 
database. 

 

Refreshing and Exiting 
Refreshing is of use when multiple people are using the same option in Admin.  
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Clicking on the Refresh Icon will cause the list of manufacturers to be updated based on 
current information from the central Macro Space Management database. 
This allows users to see changes being made by other users. 
Users can exit the Manufacturers dialogue box by clicking on the exit icon.  

 

Note: Ensure <Return> is pressed for the entry before 
exiting. If not, the information will not be stored in the 
central Macro Space Management database. 

 

Using Manufacturers in Data Import 
Macro Space Management has a Data Import module. This can be used to import data 
from third party software.  
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Information on Manufacturers is held in the AVTTB_MANUFACTURER table. 

 

Using Manufacturer Information for Products 
Data from this table can then be used for Products (MAN_TYPE = 0) in the 
AVTTB_PRODUCT_DEF Table. The AVTTB_PRODUCT_DEF table holds two fields that 
are foreign keys for the AVTTB_MANUFACTURER table; 

 

MAN_ID holds the name of the manufacturer that appears in the Manufacturers Drop 
down list on the SKU dialog box in Product Studio  
MAN_ID_SUPPLIER holds the name of the Supplier that appears in the Suppliers Drop 
down list on the SKU dialog box in Product Studio  
Using Manufacturer Information for Fixtures 
Data from this table can also be used for Fixtures (MAN_TYPE = 1) in the 
AVTTB_BLOCK_DEFINITION Table. This table holds the MAN_ID field that acts as a 
foreign key for the AVTTB_MANUFACTURER table. 

Note: Before manufacturer related data can be added to 
Fixtures or Products during imports via the Data Importer 
module, it is first necessary to make sure that the list of 
Manufacturers in the database contains all the 
manufacturers referenced in the data to be imported.  
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Status & Status Levels 

Overview 

Overview of Statuses 
Statuses are used within Macro Space Management to indicate where an object is within 
a business life cycle. They also influence the behavior of In-Store Space Collaboration. 
Statuses are maintained using the Status dialogue box accessed from the General menu. 

Note: Customizing Macro Space Management may be done 
to customer specific requirements. Because of that 
customization, there may be small differences between the 
generic examples in this Help file and a specific 
implementation of Macro Space Management. For advice on 
any aspect of customization or terminology, please contact 
Oracle's Technical Support Team. 

For example a store could have Proposed status, Open status or Closed status depending 
on whether it was at the planning stage, was in operation, or had been closed for 
refurbishment. Similarly, a planogram could be at the planning stage (Proposed status), 
in use (Current status), or superseded by a newer version (Historical status).  

Note: Once a status flow has been set up and is in use, it is 
generally difficult to change it because the software will not 
allow you to significantly edit or delete statuses that are in 
use. Accordingly, status flow should be carefully planned 
during the implementation of the software so that 
subsequent changes are not required. 

Statuses can be given to:  

Object Comment 

Blocks Blocks are typically fixtures and other AutoCAD objects used in the Planner 
environment 

Files Files are store plans associated with a floor of a store 

Floors A floor is the layout for a specific level within a store  

Planograms Planograms are arrangements of products designed to go onto specific fixtures 

Products Products can be given statuses at all levels in the hierarchy 

Reports Statuses can be given to Planogram Report Layouts (not to the report themselves).  

Revisions Revisions are folders containing a specific implementation of a store plan 

Stores A store is a specific retail outlet. 

Some objects have independent status: for example Stores and Floors can have their 
status changed without affecting the status of any objects below them in the hierarchical 
tree. 
Other objects have their behavior determined by their status. For example, it is not 
possible to place a product of Historical status in a drawing. 
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Some status changes are reversible. For example a file may generally be swapped 
between Proposed and Authorised status. Other changes are irreversible. For example, 
once a file's status has been changed from Current to Historical it cannot normally be 
changed back. 
Understanding the changing status of objects is fundamental to the operation of Macro 
Space Management. 
Status Levels 
Each status must be assigned to a unique status level. The Status Level determines the 
sequence the Status is used in. Status Levels are maintained using the Status Level 
dialogue box accessed from the General menu. 
 

Factors Affecting Statuses 

Note: these system variables only affect the behavior of 
statuses in Macro Space Management. They have no 
influence on In-Store Space Collaboration. 

System Variables 
Some System Variables have an influence on Statuses.  

Note: System Variables can be changed using the System 
Variable option on the General Menu. 

ENABLE_FILE_TRIGGER_DATES 
ENABLE_FILE_TRIGGER_DATES can be set to one of three values: 
 

Value Result Other Actions 

0 or 1 UpdateStatus.exe is disabled and has no 
effect on File or Revision statuses. 
Publish and Effective dates are disabled 
and cannot be set. 

Publish and Current statuses need to be 
selectable so that files can manually be 
taken through the software cycle. 

2 Effective date is enabled. 
UpdateStatus.exe will change file status 
if the Effective date is exceeded. 

Publish needs to be manually selectable. 

3 Publish and Effective dates are enabled.  Publish and Current status should not 
be selectable by the user so that update 
status is the required method to change 
them. 

 

Note: If ENABLE_FILE_TRIGGER_DATES is set to 0, 
running UpdateStatus.exe will still change the status of a 
store from Proposed to Open or from Open to Closed if the 
Birth or Death dates are exceeded. 

 

Note: this system variable should not be changed with the 
Planner or Merchandiser modules open or unpredictable 
results may occur. 
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MERCH_TREE_EFFECTIVE_DATE 
This system variable can be set to On (1) or Off (0). If set to On, it affects whether fixtures, 
products and planograms can be selected from the hierarchy in the object browser. 
Effective Date Set 
If an Effective date has been set for the drawing, fixtures, products and planograms 
cannot be placed if: 
1. Their Effective date is after the Effective date of the drawing 
2. Their Expiry date is before the Effective date of the drawing 
If an Active date has been set for the drawing, this overrides the Effective date for the 
drawing. then, fixtures, products and planograms cannot be placed if: 
1. Their Effective date is after the Active date of the drawing 
2. Their Expiry date is before the Active date of the drawing 

Note: MERCH_TREE_EFFECTIVE_DATE does not affect the 
Object Grid 

Custom SQL  
Custom SQL can be used in conjunction with statuses to control what displays in the 
hierarchies in the object grid. With the right custom SQL it is possible to: 
1. Restrict the display of fixtures to those of Current status 
2. Restrict the display of products to those of Current status 
3. Restrict the display of planograms to those of Current status 
At present the default is to display fixtures, products and planograms of all statuses. 
Modifying the SQL to restrict the display of objects in the Object Browser can only be 
done by administrators with access to the database. 
Data Importer 
If data is imported using Data Importer, it is possible to set the status for imported 
objects to some default value - for example 'Proposal'. 
 

Statuses and UpdateStatus.exe 
UpdateStatus.exe is found in the C:\Program Files\Oracle Retail\MSM\APPS. When 
run, it will: 
1. Change the status of a file from Authorised to Published if the Publish Date has been 

exceeded 
2. Change the status of a file from Published to Current if the Effective Date has been 

exceeded 
3. Change the status of a file from Current to Historical if another file in that floor has 

had its status changed to Current 
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Note: If Files (Store Plans) at Authorised, Published or 
Current have been set to be visible in In-Store Space 
Collaboration (Data Security) then running UpdateStatus.exe 
might change them to a status they are not visible at. 

4. Change the status of a Store from Proposed to Open if the Opened Date has been 
exceeded 

5. Change the status of a store from Open to Closed if the Closed date has been 
exceeded 
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For UpdateStatus.exe to work correctly, the generic statuses associated with ID's in the 
Status Levels dialogue box in the Administration module should not be changed. For 
example, when UpdateStatus.exe changes statuses from Authorised to Current, it 
changes the ID in the database from 4 to 2.    

 

Making (for example) Current Status anything other than ID 2 will cause problems with 
UpdateStatus.exe (and other Macro Space Management functionality.  
 

Where Statuses are Set in Macro Space Management 
Statuses can be manually set in the software. 
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Note: Customizing Macro Space Management may be done 
to customer specific requirements. Because of that 
customization, there may be small differences between the 
generic examples in this Help file and a specific 
implementation of Macro Space Management. For advice on 
any aspect of customization or terminology, please contact 
Oracle's Technical Support Team. 

Clusters 
Clusters (and sub clusters) do not have statuses. 
Stores 
Store status is set in the Store Manager Module from the Add or Edit Store dialogue 
boxes.  

 

Floors 
Floor status is set in the Store Manager Module from the Add or Edit Floor dialogue 
boxes.  
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Revisions 
Revision status is set in the Store Manager Module from the Add or Edit Revision 
dialogue boxes.  

 

Files (Store Plans) 
File status is set in the Store Manager Module from the Properties dialogue box.  
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The status of a file can also be changed by clicking the Accept or Reject buttons on exiting 
a changed store plan in In-Store Space Collaboration. 

 

Blocks (Fixtures) 
Block (fixture) status is set in the Fixture Studio Module from the Block Details dialogue 
box. 
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Products 

Product status is set in the Product Studio module. they can be set at all levels in the 
hierarchy except for display styles. For levels in the hierarchy between Company to Item, 
the status is set in dialogue boxes similar to that below. 
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 For items at SKU level, the status is set in the Product SKU dialogue box. 
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Planograms 
Planogram status is set in the Merchandiser module from the Details tab of the 
Planogram Design dialogue box. 
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Reports 

Report Status is set in Report Designer in the Report Properties dialogue box (accessed 
from the File menu when a report is open). 
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Statuses and In-Store Space Collaboration 

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management.  

Overview 
Although statuses cannot be directly configured in In-Store Space collaboration: 
1. The status of a store plan determines whether it can be seen in In-Store Space 

Collaboration or not. 
2. Clicking on Save Submit, Accept or Reject when closing a drawing in In-Store Space 

Collaboration changes the status of the drawing. This will affect whether the drawing 
is still visible in In-Store Space Collaboration and the status it is at in Macro Space 
Management. 

Note: the users can see when closing store plans in In-Store 
Space Collaboration will depend in settings in the database. 
Some users will only have a Save button and cannot affect 
the status of the drawing; some users will have a Save 
Submit button and can advance the status of a drawing and 
some users will have Accept and Reject buttons and can 
either advance the status of the drawing, or set it to a prior 
status. 

Status of Store Plan 
Store Plans can only be seen at specific statuses. This is configured using the Data 
Security option in the Admin Module. User Groups can be assigned to Statuses. 
Members of those User Groups will be able to see Store Plans (Files) belonging to those 
statuses in In-Store Space Collaboration. 

 

In the above example, users in the In-Store user group will be able to see files that have 
been set to ISSC status in Macro Space Managements' Store Manager module. 
Effect of Accept or Reject in In-Store Space Collaboration 
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When a drawing is closed in In-Store Space Collaboration (after making changes) a Save 
dialogue box comes up. Depending on settings in the database a specific user may see: 
1. Save, Discard and Cancel buttons only 
2. An additional Save Submit button 
3. Additional Accept and Reject buttons.  

 

Clicking Save Submit or Accept will change the current status of the drawing to one 
further on in the status flow for the drawing; clicking Reject will change the status of the 
drawing back to a prior status. 
Although the status itself can be set up using the Status Level and Status dialogue boxes, 
the statuses ISSC changes the status too to on clicking  'Save Submit', 'Accept' or 
'Reject' can only be set up directly in the database. 
 

Setting up Statuses in the Database 
Setting up statuses for MSM can be done fully via the Status Levels and Status dialogue 
boxes in the administration module, however, some aspects of configuring statuses for 
use in In-Store Space Collaboration can only be done in the database. These aspects are: 
1. Setting the statuses that will be set on clicking the Accept or Reject buttons in the 

Save dialogue box in ISSC 
2. Setting the statuses that will appear for Manager Approval 
3. Setting the type of Save dialogue box that will appear in ISSC 
Setting the statuses that will be set on clicking the 'Save Submit', 'Accept' or 'Reject' 
buttons in the Save dialogue box in ISSC 
When you save a (changed) drawing on exiting In-Store Space Collaboration the Save 
dialogue box appears. Clicking on 'Save Submit', 'Accept' or 'Reject' will change the status 
of the store plan.  

 

Note: There are slightly different forms of the Save dialogue 
box. The above example shows one form. Which form 
appears depends on settings in the 
AVTTB_PROCESS_FLOW table - see below.  

The AVTTB_STATUS table contains two columns called STA_ID_REJECT and 
STA_ID_ACCEPT. For any specific status, these are the statuses that it will be changed to 
on clicking Accept or Reject in ISSC.  
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The extract below from the AVTTB_STATUS table shows a simple example. 

 

1. If the user clicks the 'Save Submit' or 'Accept' button in In-Store Space Collaboration, 
the ISSC status will be changed to Published (STA_ID 29) when exiting the drawing. 

2. If the user clicks the 'Reject' button in In-Store Space Collaboration, the ISSC status 
will be changed to Authorised (STA_ID 25) when exiting the drawing. 

Setting the statuses that will appear for Manager Approval 
There is a button in the ISSC Select Store dialogue box that allows users belonging to 
appropriate user groups to select all drawings of specific statuses that require approval.  
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The statuses that will appear when the icon is clicked are set in the AVTTB_STATUS 
table - they are set to 1 in the STA_APPROVAL column. 

 

Setting the type of Save dialogue box that will appear in ISSC 
The type of dialogue box that will appear in In-Store Space Collaboration is listed in the 
AVTTB_PROCESS_FLOW_OPTION table. 

 

1. The MSF_ID details the type of dialogue box that will appear - the Save dialogue box 
is MSF_ID. 

2. The PFO_ID details the options that will appear in the Save dialogue box. 
a. A PFO_ID of 1 will only give Save and Discard buttons in the dialogue box 
b. A PFO_ID of 2 will give Save, Discard and Submit buttons. On clicking Submit, the 
status will change to that specified in the STA_ID_ACCEPT column of the 
AVTTB_STATUS table. 
c. A PFO_ID of 3 will give Save, Discard and Accept and Reject buttons. On clicking 
Accept, the status will change to that specified in the STA_ID_ACCEPT column of the 
AVTTB_STATUS table. On clicking Reject, the status will change to that specified in the 
STA_ID_REJECT column of the AVTTB_STATUS table. 
How it is used is specified in the AVTTB_PROCESS_FLOW table. 
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1. The MSF_ID is the ID for the form. It is determined from the 
AVTTB_PROCESS_FLOW_OPTION table. In this instance the appropriate form ID is 
3. 

2. The PFL_ID (Process Flow Level ID) is not in use. It can be set to 1. 
3. The STA_ID is the ID for the Status the form is appropriate for. It is determined from 

the AVTTB_STATUS table. 
4. The USG_ID is the ID of the User Group the form is appropriate for. It is determined 

from the AVTTB_USER_GROUP table. 
5. The PFO_ID (Process Flow Operation ID) determines the options that will appear on 

the Save dialogue box. They are determined from the 
 AVTTB_PROCESS_FLOW_OPTION table. 

In the simple example above, there are two options for STA_ID 33: 
1. Users belonging to the Admin User Group (ISG_ID = 1) will get Save, Discard, 

Accept and Reject buttons. 
2. Users belonging to the ISSC User Group (ISG_ID = 4) will only get Save and Discard 

buttons. 
It is also possible to specify actions for more than one status.  
 

Configuring Statuses in Admin 

Overview of Status Levels 
Status Levels are the generic stages where actions related to statuses can be triggered in 
the software. Status levels are called from the General menu.  

 

This will bring up the Status Levels dialogue box 
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Generic Status Levels 

On installation, the software contains a series of generic statuses, each associated with a 
status ID. The software (particularly for Stores, Files and Revisions) will carry out specific 
actions associated with the Status Level ID (not the Status Level Description). 

  In some circumstances, manually changing the status of a Revision will change the 
status of the files within it. 

  In some circumstances, the status of files and revisions can be changed automatically 
by UpdateStatus.exe. 

  In some circumstances, the status of stores can be changed automatically by 
UpdateStatus.exe. 

These generic statuses should not be edited or deleted or there may be problems with 
software functionality. The generic statuses are that should not be changed are:: 

  Authorised 

  Published 

  Current 

  Historical 

  Custom Status Levels 

It is possible to add custom status levels to the default status levels. This is because each 
status must be associated with a unique status level. If a status work flow has ten statuses 
in it, there must be ten status levels configured in the Status Levels dialogue box. 
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Accordingly, the generic description can be slightly modified - for example changing 
'Proposed' to 'Proposal' - but the generic description associated with a particular Status 
Level ID should not be changed. For example associating 'Historic' status with Status 
Level ID 4 (rather than 3) will cause problems with the operation of the software.  
Custom Status Levels should therefore be added to the generic Status Levels, and not 
substituted for them. 
 

Using Status Levels 
The Descriptions in the Status Level dialogue box appear within the Status dialogue 
box as the Level for a specific status. Each status must be associated with a specific and 
unique status level.  
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In the example below it has been decided to add an ISSC status to the statuses to denote 
store plans (files) available to users in In-Store space collaboration. In order to add the 
Status in the Status dialogue box, it is first necessary to add an ISSC status level to the 
Status Levels dialogue box. 
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If you attempt to create a new status and associate it with a status level that is not unique 
to that status, a warning will result.  

 

 

About Status Options 
The Status dialogue box is used to configure the varying Statuses used to control 
business flows within Macro Space Management. It can also be used to partially 
configure the behavior of statuses within In-Store Space Collaboration, although the rest 
of this configuration has to be done directly in the database. 
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Note: When Macro Space Management is implemented, the 
statuses and status levels may be set up to customer specific 
requirements. Accordingly, there may be small differences 
between the generic examples in this Help file and a specific 
implementation of Macro Space Management. For advice on 
any aspect of customization or terminology, please contact 
Oracle's Technical Support Team. 

 

Statuses may be added, edited or deleted by selecting the appropriate options from the 
menu bar or toolbar.  
It is recommended each status type contain a minimum of three status levels. These 
would normally include Proposed, Current and Historic.  

Note: As changes to the configuration of statuses may have 
wide effects within Macro Space Management, it is 
suggested that modifications are only made after consulting 
Oracle's Technical Support Team. 

Type 
Type defines the type of object the status will be assigned to. It is selected from a drop 
down list that is not user configurable. 
Level 

Level indicates where in the flow for that object that status comes. Each level must 
correspond to a unique status level defined in the Status Levels dialogue box.  

Note: Status Levels are assigned a Status ID in the database. 
These Status ID's are not visible to or configurable by the 
user. Certain Macro Space Management actions are tied to 
those Status ID's. For example archiving is carried out on 
files with a Status ID of 4. If superseded (Historical) files are 
given a Status with an ID of anything other than 4, archiving 
will not work.  
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Description 
This is a user configurable field that allows users to customize the description of 
associated with the level. this description then appears in the varying dialogue boxes that 
use status. For example, it would be possible to assign the description 'Superseded' to the 
Historical level.  
Order 
This is the order that the statuses will be used (and the order they will appear in any 
dialogue boxes). 
Reversible 
If a status is set to reversible, it can be changed back to a status lower in the order by the 
user. If a status is not reversible, then the user cannot revert to an earlier status. It would 
not be normal (for example) for the change between Authorised and Current Status to be 
reversible. 

Note: at present only file statuses are non-reversible. 

Read Only 
If a Status is set to read only status, all associated objects and files will be able to be 
viewed, but not altered. Objects with Statuses that are not set to read only status may be 
freely edited. As example of an object set to read only status would be a fixture that has 
been set to historic status - as the fixture is no longer in service, there would be no need 
to edit it. 

Note: at present only files are set to read only status. This 
can be directly as a result of the file having its status 
changed, or indirectly as a result of the parent store, floor or 
revision having its status changes to one with read only 
attributes.  For example, changing a floor to closed status 
will generally result in the files associated with that floor 
becoming 'read only'. 

Selectable 

If a status is selectable it can be set by the user. If it is not selectable, then the status can 
only be changed by the software. 
 
  

Basic Example of Configuring Statuses 
A basic example for configuring statuses is the flowchart below for planograms designed 
within the Merchandiser module. 

 

This allows planograms to be started at the design stage, be accepted by a manager, go 
into service and be retired (historical). This is set up in the Status dialogue box as follows: 
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Type 
This is obviously set to planogram. 
Levels and Descriptions 
These are selected from the Status Levels dialogue box, ensuring that the description we 
will use later matches up to the appropriate level. 

 

In this instance the Proposed Status Level is matched to the Design description, the 
Authorised Status Level is matched to the Accepted Description, the Current Status Level 
to the In Service description and the Historic Status Level to the Historical description. 
Order 
The order is set to the sequence the statuses will be used in: 1 for Design, 2 for Accepted, 
3 for in Service and 4 for Historical.  
Reversible 
Only Authorised status needs to be reversible - giving the option of revering back to 
Design status. Current and Historical statuses should not be reversible as planogram in 
service or having been retired (historical) should not be capable of being edited. 
Read Only 
Typically statuses would be set to read only when the planogram design has been fixed - 
for example at 'In Service' or 'Historical' status.  
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Note: at present setting planograms to Read Only status has 
no effect.  

Selectable 
Statuses have been marked as selectable to be visible in the Planogram design dialogue 
box. In this case, we need all statuses to be selectable, so all have been checked. They will 
then be available in the Planogram Design dialogue box. 

 

 

Advanced Example of Configuring Statuses 

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management.  

An advanced example of configuring file statuses can be seen in the flowchart below. 
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Here the file has three statuses that are set in Macro Space Management's Store Manager 
Module. The third of these statuses (ISSC) is has also been set to be visible in In-Store 
Space Collaboration (using Data Security), where users can click the Accept or Reject 
buttons on exiting the drawing.  
Clicking the Accept button in In-Store Space Collaboration will change the status to 
authorized, clicking the Reject button in In-Store Space Collaboration will change the 
status back to Accepted. 
When the drawing reaches Authorised status (and Publish and Effective dates have been 
set), the UpdateStatus.exe tool will result in the file successively changing to Published, 
Current and Historical status. 
This is set up in the Status dialogue box as follows: 
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In order to add two additional statuses (Accepted and ISSC) to the existing statuses, two 
additional levels must first be added to the Status Levels dialogue box. 

 

The additional statuses can then be added to the Status dialogue box. 
Type 
This is obviously set to planogram. 
Levels and Descriptions 
These are selected from the Status Levels dialogue box, ensuring that the description we 
will use later matches up to the appropriate level. 
In this instance the Proposed Status Level is matched to the Proposed description, the 
Accepted Status Level is matched to the Accepted Description, etc.  



System Variables 

52 Oracle Retail Macro Space Management  Administration Guide 
 

Note: care was taken to map the Authorised, Published, Current and Historical 
descriptions to their respective levels in the status levels dialogue box. This is because the 
software will carry out specific actions associated with these statuses. 
Order 
The order is set to the sequence the statuses will be used in: 1 for Proposed, 2 for 
Accepted, etc.  
Reversible 
Several statuses have been made reversible (Authorised, ISSC and Accepted). This allows 
users to change the status back to an prior one if the store plan is not regarded as 
acceptable. 
Read Only 
Statuses have been set to Read Only at Published, Current and Historical status. This is 
because once a drawing has been Published (sent to a store for implementation) it should 
be 'locked' to prevent further changes in it. 
Selectable 

Statuses have been marked as selectable to be visible in the Properties dialogue box. In 
this case, we need the Proposed, Accepted and ISSC statuses to be selectable, so they 
have been checked.  
Authorised status has not been made selectable. This means that the status can only be 
reached by clicking the Accept button in In-Store Space Collaboration. This is an example 
of how statuses can be used to ensure business processes are followed. 
 
In-Store Space Collaboration 
The Save dialogue box in In-Store Space Collaboration contains Accept and Reject 
buttons. 

 

Setting up these buttons to change status within MSM has to be done directly within the 
database - consult Oracle technical support for more information. (More Info) 
 
   

System Variables 

Overview of System Variables 

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management. Some of the System Variables control settings 
within the In-Store Space Collaboration application. These 
System Variables have no influence over the operation of 
Macro Space Management. 
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A System Variable is a parameter within the Macro Space Management database that 
specifies how one aspect of the software operates. System variables are often used as 
switches to toggle features on and off, hold dimensions and positions of dialogue boxes, 
etc.  
The following principles should be followed when working with system variables: 
1. System Variables should not be added or deleted. 
2. The only information that should be edited for a System Variable is the 

Description and the Value. 

 

System Variables can be changed in several ways. 
1. Through dialogue boxes in the software 
2. Through the Configuration Module 
3. Through the Administration Module 
Through the Software 
System variables can be changed through the software. This may be explicit, as when the 
user deliberately selects a value in a dialogue box. It may also be implicit, as some system 
variables are used to hold the values of (for example) the positions and sizes of dialogue 
boxes. 
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For example, the Merchandiser Module allows the 'Add Shelf with Product Silently' 
option to be toggled on or off. The value of this setting is stored in the 
ADD_PRODUCT_WITH_SHELF system variable. 
Through the Configuration Module 
The Configuration Module allows a series of settings to be customized by the user. Some 
are saved as system variables. 



System Variables 

General Options 55 

 

For example, the colors for the connection points set in the Fixturing tab are stored in a 
series of system variables called MALE_BACK_COLOUR, MALE_BOTTOM_COLOUR, 
etc 
Through the Administration Module 

This option allows system variables to be directly changed instead of doing it via the 
software. This is done using the System Variable option from the General Menu. 

 

This allows a user with Administrator's privileges to change the value of a system 
variable.  
Changing system variables can have wide ranging effects on the way Macro Space 
Management. Before making a change it is recommended users should: 
1. Ensure they understand the effect of changing the system variable 
2. If necessary seek advice from Oracle's Technical Support team 
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System Variables 

Overview of System Variables 
A System Variable is a parameter within the Macro Space Management database that 
specifies how one aspect of the software operates. System variables are often used as 
switches to toggle features on and off, hold dimensions and positions of dialogue boxes, 
etc.  

 

System Variables can be changed in several ways. 

  Through dialogue boxes in the software 

  Through the Configuration Module 

  Through the Administration Module 
Through the Software 

System variables can be changed through the software. This may be explicit, as when the 
user deliberately selects a value in a dialogue box. It may also be implicit, as some system 
variables are used to hold the values of (for example) the positions and sizes of dialogue 
boxes. 
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For example, the Merchandiser Module allows the 'Add Shelf with Product Silently' 
option to be toggled on or off. The value of this setting is stored in the 
ADD_PRODUCT_WITH_SHELF system variable. 
Through the Configuration Module 
The Configuration Module allows a series of settings to be customized by the user. Some 
are saved as system variables. 
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For example, the colors for the connection points set in the Fixturing tab are stored in a 
series of system variables called MALE_BACK_COLOUR, MALE_BOTTOM_COLOUR, 
etc 
Through the Administration Module 

This option allows system variables to be directly changed instead of doing it via the 
software. This is done using the System Variable option from the General Menu. 

 

This allows a user with Administrator's privileges to change the value of a system 
variable.  
Changing system variables can have wide ranging effects on the way Macro Space 
Management. Before making a change it is recommended users should: 

  Ensure they understand the effect of changing the system variable 
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  If necessary seek advice from Oracle's Technical Support team 
 

System Variable Options 
Each System Variable has a series of options associated with it. 

 

Name 
This is the name of the system variable. The name should not be changed as the software 
references these names - changing a name will result in the software failing to find data 
in the database. 
Description 
This describes what the system variable does. It can be edited to suit customer needs. 
Type 
This specifies whether the system variable is System (global), User (specific to an 
individual) or File (associates properties with a file). System Variable Types are 
determined by the software code and changing the type from the Type dropdown list has 
no influence on where the system variable value is stored. The Type should not be 
changed from the value it was set to on implementation. More Information 
Value 
This is the current value held for the system variable. The value must be consistent with 
the data type. 

Note: System variables of the form 100|100|100|100 are 
known as pipe-delineated system variables. They hold the 
multiple values required for that system variable.  

For example, a system variable holding the position of a dialogue box might be of the 
form 100|300|600|600 where the data specifies the left bottom and top right co-
ordinates of the dialogue box. When editing a pipe-delineated system variable, all 
pertinent values must be entered or the system will error. 
Data Type 

This is the type of data. It must be consistent with the value to be stored for the system 
variable. Types can selected from a drop down list, but should not be changed from those 
set on implementation. They are of the following types: 
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Data Type Example 

String Any alphanumeric input (ABC123) 

Integer Any Integer (1,2,3) in the range -2 billion to +2 billion 

Long Any Integer (1,2,3) in the range -9 x 1018 to 9 x 1018. 

Single Any number (1.23, 2.2345) in the range -3 x 1038 to 3 x 1038. 

Double Any number (1.23, 2.2345) in the range -2 x 10308 to 2 x 10308. 

Date Date (10/10/07 12.15:00:00) 

Boolean True or False values (0,1) 

Image Bit Maps, GIF and JPG images 

Currency Financial data (£1234.00) 

 

Active 
This specifies whether the system variable is in use or not. Settings should not be 
changed from those set on implementation.  
Category 

This specifies which module the system variable affects. Settings should not be changed 
from those set on implementation as the software uses this setting to see which system 
variables should be read when opening a module. 
 
   

System Variable Types 
The System Variable Type determines the purpose of the system variable. There are 
three system variable types:  

  System 

  User  

  File 
System  
System Variables of type 'System' are global system variables. Changing the value of this 
type of system variable will affect all users of the system. The values of this type of 
system variable are written to the AVTTB_SYSTEM_VARIABLE table in the database. 
User 
System Variables of type 'User' are specific to one user. They are typically used to hold 
that users' preferences. The values of this type of system variable are written to the 
AVTTB_USER_VARIABLE table in the database.  
When a user first uses functionality on becoming a Macro Space Management, they start 
with the defaults from the  AVTTB_SYSTEM_VARIABLE table, thereafter, their 
preferences are stored in the  AVTTB_USER_VARIABLE table. 
File 

System Variables of type 'File' are used to assign properties to files on creation. Users can 
then overwrite the default with their own value. The values of this type of system 
variable are written to the AVTTB_SYSTEM_VARIABLE table in the database. The 
default value is then also written to the appropriate table for a file when that file is 
created. 
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AVTTB_SYSTEM_VARIABLE and AVTTB_SYSTEM_VARIABLE_TYPE Tables 
There is some information on the AVTTB_SYSTEM_VARIABLE and 
AVTTB_SYSTEM_VARIABLE_TYPE Tables that may be useful to Database 
Administrators. 

 

The SVR_TYPE field in the  AVTTB_SYSTEM_VARIABLE table does not hold 
information on the Type field in the System Variables dialogue box. Information is 
determined from the SVR_IS_USER_DEF and SVR_ISFILE_PREF fields. If both these 
fields are set to false (0) the system variable will be of type 'System'. If either of the fields 
are true (1), the system variable type will be set to 'User' or 'File'. (The fields cannot both 
be set to true simultaneously). 
The SVR_TYPE field corresponds to the category for the system variable. It references the 
 AVTTB_SYSTEM_VARIABLE_TYPE table - which contains a list of the different parts of 
the application the system variable could apply to. 

 

 

Adding, Editing and Deleting System Variables 
Adding, Editing, or Deleting system variables is via the options on the Toolbar or Menu 
Bar. 
 
Adding System Variables 
There is no purpose in adding system variables. These will only have an effect if they are 
referenced the code in the software. 
Editing System Variables 
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System variables can be edited via the Admin Module as an alternative to changing them 
via the software. This should be done with caution.  
Deleting System Variables 

System Variables should only deleted after consulting the Oracle Support team. Deleting 
a system variable in use with the software can cause significant problems.  

Note: Deleting keys system variables referenced by the 
software may cause the system to suffer a critical failure. 

 
   

Grouping by Columns 
The user has the option of grouping system variables together by column header types. 
To do this drag a column header into the indicated space at the head of the dialogue box. 

 

This will group all the system variables by the selected criteria - for example Type. 

 

Clicking on the '+' sign will expand the list and allow users to see all system variables in 
that group. 
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To return to the default display, just drag the selected column header out of the space at 
the head of the dialogue box. 
 
   

System Variable Descriptions 

In-Store Space Collaboration 

General Options 

CLIENT_VERSION 
The CLIENT_VERSION system variable is set automatically on installation of In-Store 
Space Collaboration. It will be updated automatically if upgrade scripts, etc, are run. 
There is no need to manually change the value. 
 

SERVER_VERSION 
The SERVER_VERSION system variable is set automatically on installation of In-Store 
Space Collaboration. It will be updated automatically if upgrade scripts, etc, are run. 
There is no need to manually change the value. 
 

IN-STORE_SMTPSERVER 
The IN-STORE_SMTPSERVER system variable is used to identify the email server that 
will be used to send messages when authentication for In-Store Space Collaboration is 
done via LDAP (Lightweight Directory Access Protocol). The value stored for the system 
variable must be a valid address for the STMP server.  
The emails are triggered when the status of the drawing is changed; either through the 
'Save and Submit' button or via the Accept and Reject buttons. 
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Note: Which a form of the dialogue box a user can see is 
determined by settings in the AVTTB_PROCESS table in the 
database. 

Save and Submit Button 

(This dialogue box is typically assigned to a Store Planner). 

 

If the Save and Submit button is clicked, the status of the drawing will be changed and an 
email sent to the manager defined as the user's manager in the LDAP system. 
Accept and Reject 
(This dialogue box is typically assigned to a Store Planner's Manager). 

 

If the Accept or Reject buttons are clicked., the status of the drawing will be changed and 
an email sent to the last person to work on the drawing before the manager accepted or 
rejected the drawing. 
Email Template 
The template for the email message that will be sent is located in the C:\Program 
Files\Oracle Retail\ISSC\ISSC Server Service folder. It is the EmailFormat.xml file. 
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IN-STORE_HELPLOCATION 
The IN-STORE_HELPLOCATION system variable contains the URL (Uniform Resource 
Location) for the help files for In-Store-Space Collaboration. It should detail both the path 
to the directory and the name of the file used to open the help. 

Note: In-Store Space Collaboration Help is in Webhelp 
format. This differs from the CHM files used for Macro 
Space Management.  

 

IN-STORE_TIMEOUT 
The IN-STORE_TIMEOUT system variable sets the time in seconds that the In-Store 
Space Collaboration Client will wait for a response from the database before it detects a 
time out has occurred.  

 

Once the time out time has been exceeded, a warning dialogue will appear. The time the 
dialogue box displays is controlled by the IN-STORE_TIMEOUT_MESSAGE system 
variable. 
 

IN_STORE_TIMEOUT_MESSAGE 
The IN-STORE_TIMEOUT_MESSAGE system variable determines the amount of time 
the warning message will display after a time out has occurred. After the time set in the 
IN-STORE_TIMEOUT_MESSAGE has expired, In-Store Space Collaboration will 
automatically shut down (unless the wait button is clicked). 

 

Note: The time before a time out is triggered is determined 
by the  IN-STORE_TIMEOUT system variable. 

 

IN-STORE_MERGE_PLANOGRAMS 
The IN-STORE_MERGE_PLANOGRAMS system variable allows the user to specify 
whether planograms are merged or not. There are two possible values: 
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0 - do not Merge Planograms 
1 - Merge Planograms 
If Merge Planograms is on, the software looks for instances of the same planogram 
placed on multiple adjacent fixtures and converts then to a single, multiple bay 
planogram in the database. 

Note: This feature is not yet fully implemented.. 

 

MODULE_BLK_ID 
The MODULE_BLOCK_ID system variable is used to identify the block used when 
moving products temporarily into a aisle. This functionality is used in In-Store Space 
Collaboration, but not in Macro Space Management. The value should correspond to the 
ID of a suitable block in the table of Block Details in Fixture Studio.  

 

 

SKIP_ZONE_SELECT 
The SKIP_ZONE_SELECT system variable affects whether the Select Data dialogue box 
is shown during the process of selecting a store plan to work on in In-Store Space 
Collaboration. All users see the Select Store dialogue box. 
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When a store has been selected, an optional Select Data dialogue box allows users to 
select which of the zones they wish to display.  

 

SKIP_ZONE_SELECT determines where the Select Data dialogue box displays or not; 

  If set to 0, the dialogue box will display and users will be able to select zones before 
opening the store plan 

  If set to 1, the dialogue will not appear and the store plan will open displaying all 
zones 

 

Controlling Text 

OPTIONS_LEGEND_FONT 
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The OPTIONS_LEGEND_FONT system variable is used to specify the fond used for the 
legend displayed on screen and in printed output for KPI's. 

 

Users may choose any font in the Windows Collection.  

Note: it is suggested a common, easily read font is selected. 
Such fonts include Arial, Times New Roman, Tahoma or 
Verdana. 

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will 
default to a suitable font. 

Note: This functionality is not yet fully implemented.. 

 

OPTIONS_LEGEND_FONT_SIZE 
The OPTIONS_LEGEND_FONT_SIZE system variable is used to specify the font size 
used for the legend displayed on screen and in printed output for KPI's. 
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Note: This functionality is not yet fully implemented. 

 

OPTIONS_FOOTER_FONT 
The OPTIONS_FOOTER_FONT sets the font used for the footer in all printed reports.  



System Variables 

70 Oracle Retail Macro Space Management  Administration Guide 
 

 

Users may choose any font in the Windows Collection.  

Note: it is suggested a common, easily read font is selected. 
Such fonts include Arial, Times New Roman, Tahoma or 
Verdana. 

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will 
default to a suitable font. 
 

OPTIONS_FOOTER_FONT_SIZE 
The OPTIONS_FOOTER_FONT_SIZE sets the size used for the font in the footer in all 
printed reports.  
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OPTIONS_HEADER_FONT 
The OPTIONS_HEADER_FONT sets the font used for the header in all printed reports.  
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Users may choose any font in the Windows Collection.  

Note: it is suggested a common, easily read font is selected. 
Such fonts include Arial, Times New Roman, Tahoma or 
Verdana. 

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will 
default to a suitable font. 
 

OPTIONS_HEADER_FONT_SIZE 
The OPTIONS_HEADER_FONT_SIZE sets the size used for the font in the header in all 
printed reports.  
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Dimensions, Mark-ups and Notes 

IN-STORE_DIMENSION_AROW 
The IN-STORE_DIMENSION_ARROW system variable currently has no effect. 
 

IN-STORE_DIMENSION_STYLE 
The IN-STORE_DIMENSION_STYLE system variable controls the way dimensions 
display. 
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There are three options for the system variable: 
0 will display the dimension without ticks or arrows (left hand image) 
1 will display the dimension using ticks (centre image) 
2 will display the dimension using arrow heads (right hand image). 
 

IN-STORE_MARKUP_LINEWIDTHMAX 
The IN-STORE_MARKUP_LINEWIDTHMAX System Variable is used in In-Store space 
collaboration. User can select the Mark Up option from the toolbar then draw a freehand 
mark round part of the drawing. The IN-STORE_MARKUP_LINEWIDTHMAX system 
variable controls the weight of the heavy line produced when the user holds down the 
right mouse button while drawing the Mark Up. 

 

 

IN-STORE_MARKUP_LINEWIDTHMIN 
The IN-STORE_MARKUP_LINEWIDTHMIN System Variable is used in In-Store Space 
Collaboration. User can select the Mark Up option from the toolbar then draw a freehand 
mark round part of the drawing. The IN-STORE_MARKUP_LINEWIDTHMIN system 
variable controls the weight of the thin line produced when the user holds down the left 
mouse button while drawing the Mark Up. 
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IN-STORE_MARKUP_TEXT_SIZE 
The IN-STORE_MARKUP_TEXT_SIZE System Variable allows users to select the Font 
Size used for annotating dimensions. 

 

The font size is in arbitrary units and users may need to experiment before finding a 
suitable setting. 
 

IN-STORE_MARKUP_TEXT_FACE 
The IN-STORE_MARKUP_TEXT_FACE System Variable allows users to select the Font 
Type used for annotating dimensions. 
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Users may choose any font in the Windows Collection.  

Note: it is suggested a common, easily read font is selected. 
Such fonts include Arial, Times New Roman, Tahoma or 
Verdana. 

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will 
default to a suitable font. 
 

NOTE_FONT 
The NOTE_FONT system variable determines the font used for Notes (initiated from the 
toolbar) within In-Store Space Collaboration. 

 

Users may choose any font in the Windows Collection.  

Note: it is suggested a common, easily read font is selected. 
Such fonts include Arial, Times New Roman, Tahoma or 
Verdana. 

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will 
default to a suitable font. 
 

NOTE_FONT_SIZE 
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The NOTE_FONT_SIZE system variable determines the size of the font used for Notes 
(initiated from the toolbar) within In-Store Space Collaboration. 

 

 

Fixture Attributes 

IN-STORE_FIX_ATTRIBUTES_VERSION 
The IN-STORE_FIX_ATTRIBUTES_VERSION system variable allows users to control 
the type of Attributes dialogue box that appears when the Fixture Attributes option is 
selected from the toolbar. 

 

There are two options: 

  A setting of 1 will show a basic dialogue box. 

  A setting of 2 will show a more complex dialogue box. 

Note: At present only the 'complex' dialogue box is available 
- changing the system variable has no effect. 

 

IN-STORE_FIX_ATRIB_VER 
The IN-STORE_FIXTURE_ATTRIB_VER system variable is not current used. 
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IN-STORE_FIX_ATTRIBUTES_PRINT_FONT 
The IN-STORE_FIX_ATTRIBUTES_PRINT_FONT system variable changes the font used 
for the information in the Fixture Attributes report. 

 

Users may choose any font in the Windows Collection.  

Note: it is suggested a common, easily read font is selected. 
Such fonts include Arial, Times New Roman, Tahoma or 
Verdana. 

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will 
default to a suitable font. 
The Fixture Attributes Report is called by clicking the Print button in the Fixture 
Attributes dialogue box called from the Fixture Attributes icon on the toolbar. 

 

 

IN-STORE_FIX_ATTRIBUTES_PRINT_FONT_SIZE 
The IN-STORE_FIX_ATTRIBUTES_PRINT_FONT_SIZE system variable is used to set the 
size of the font used in the for the information in the Fixture Attributes report. 
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The Fixture Attributes Report is called by clicking the Print button in the Fixture 
Attributes dialogue box called from the Fixture Attributes icon on the toolbar. 

 

 

IN-STORE_FIX_ATTRIBUTES_PRINT_HEADING FONT 
The IN-STORE_FIX_ATTRIBUTES_PRINT_HEADING_FONT system variable changes 
the font used for the Heading in the Fixture Attributes report. 
 

 

Users may choose any font in the Windows Collection.  

Note: it is suggested a common, easily read font is selected. 
Such fonts include Arial, Times New Roman, Tahoma or 
Verdana. 

If a font name is misspelled, or the font is not available, In-Store Space Collaboration will 
default to a suitable font. 
The Fixture Attributes Report is called by clicking the Print button in the Fixture 
Attributes dialogue box called from the Fixture Attributes icon on the toolbar. 
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IN-STORE_FIX_ATTRIBUTES_PRINT_HEADING_FONT_SIZE 
The IN-STORE_FIX_ATTRIBUTES_PRINT_FONT_SIZE system variable is used to set the 
size of the font used in the for the Heading in the Fixture Attributes report. 

 

The Fixture Attributes Report is called by clicking the Print button in the Fixture 
Attributes dialogue box called from the Fixture Attributes icon on the toolbar. 

 

 

IN-STORE_FIX_ATTRIBUTES_PRINT_HIGHLIGHTS 
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The IN-STORE_FIX_ATRIBUTES_PRINT_HIGHLIGHTS system variable allows users to 
select whether the report output when the print button is clicked on the Fixture attributes 
dialogue box will have highlighted information in it. 

 

Note: this functionality is not currently operating. 

 

ISSC System Variables not in Use 

IN-STORE_GRIP_COLOUR 
The IN-STORE_GRIP_COLOUR system variable is for future functionality and has not 
yet been implemented.  
 

IN-STORE_GRIP_HOTCOLOUR 
The IN-STORE_GRIP_HOTCOLOUR system variable is for future functionality and has 
not yet been implemented.  
 

IN_STORE_GRIP_SIZE 
The IN-STORE_GRIP_SIZE system variable is for future functionality and has not yet 
been implemented.  
 

IN_STORE_PROMOTION_USER_GROUP 
The IN_STORE_PROMOTION_USER_GROUP system variable is not presently in use. 
 

IN-STORE_STORE_SELECTION_LEVEL 
The IN-STORE_STORE_SELECTION_LEVEL system variable is not currently in use. 
 

IN-STORE_SUBMIT_STATUS 
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The IN-STORE_SUBMIT_STATUS system variable used to determines what happened 
when the Accept button in the Save dialogue box is clicked. 

 

Note: there are three versions of this dialogue box. Which a 
user can see is determined by settings in the 
AVTTB_PROCESS table in the database. 

This has now been superseded by entering the required information into the 
AVTTB_STATUS table in the STA_ACCEPT and STA_REJECT columns. This system 
variable is therefore no longer used. 
 

MAX_FIXTURE_SELECTION 
The MAX_FIXTURE_SELECTION system variable was used in In-Store Space 
Collaboration to set the maximum number of fixtures that could be included in a 
selection set. 
It is no longer used and has no effect on the software. 
 

OPTIONS_FONT 
The OPTIONS_FONT system variable is not in use. It relates to an older version of In-
Store Space Collaboration. 
 

OPTIONS_FONTSIZE 
The OPTIONS_FONTSIZE system variable is not in use. It relates to an older version of 
In-Store Space Collaboration. 
 

OPTIONS_PREPOPULATEDPRODUCTS 
The OPTIONS_PREPOPULATEDPRODUCTS system variable is no longer in use. 
 

Macro Space Management 

Adjacency Calculations 

Overview 
Adjacency Calculations are used to establish the relationship of objects to one another. 
There are three forms of Adjacency Calculations: 
1. Fixture Adjacency is the relationship of one fixture to another. 
2. Product Adjacency is the relationship of one product to another. 
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3. Aisle Adjacency identifies which products share an aisle.  
Fixture Adjacency calculations can be initiated from the Planner and Merchandiser 
modules in Macro Space Management and from In-Store Space Collaboration. Product 
and Aisle Adjacency calculations are initiated from the Planner module in Macro Space 
Management  
Fixture Adjacency 

There are a series of System Variables that affect how the Fixture Adjacency calculations 
work. These are: 

  ADJACENCY_FIXTURESIZE 

  ADJACENCY_FRONTBACK 

  ADJACENCY_LATERALGAP 

  ADJACENCY_MAX_ANGLE 

  ADJACENCY_OVERLAP 

  ADJACENCY_SEARCH 

  ADJACENCY_TOLERANCE 

  ADJACENCY_VERTICALGAP 

Note: some of these system variables are not currently in 
use.  

Product Adjacency 
Product Adjacency relies on the relationship of fixtures to one another - determined by 
the Fixture Adjacency calculation. This relationship can then be used to determine what 
products are on the fixtures, and hence which products are adjacent to one another.  
There are no system variables associated with Product Adjacency. 
Aisle Adjacency 
Aisle Adjacency is used to establish which fixtures are adjacent to an aisle (defined as a 
line in a Planner store plan).  This relationship can then be used to determine what 
products are on the fixtures, and hence which products share the aisle. 
There is a single system variable affecting Aisle Adjacency: ADJACENCY_AISLESIZE. 
 

Fixture Adjacency Calculations 
Fixture Adjacency is the relationship of one fixture to another. It is called from three 
places within the software: 

  From the Calculations menu or toolbar in the Planner module 

  From the Calculate menu in the Merchandiser Module 

  From the toolbar in In-Store Space Collaboration 
In each instance, the same functionality is called and the results written back to a 
common table in the database. 

Note: Fixture Adjacency only applies to fixtures. Fittings, 
shelves, etc are excluded from the calculations 

For Fixture Adjacency calculations, fixtures may be: 

  To the right of another fixture 

  To the left of another fixture 
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  Behind another fixture 

  In front of another fixture 

  Sharing an aisle with a fixture 

  Above another fixture 
A specific adjacency for a fixture may be a combination of these options. 

 

In the example above: 
Fixture 1 is adjacent to the left of fixture 2.  
Fixture 3 is adjacent to the right of fixture 2.  
Fixture 6 is adjacent to the left and behind fixture 2.  
Fixture 5 is adjacent behind fixture 2.  
Fixture 4 is adjacent to the right and behind fixture 2.  
Fixture Adjacency is subsequently used in Product Adjacency calculations, where the 
relationship of one fixture to another can be used to establish the relationship between 
the products they have been merchandised with. 
 

ADJACENCY_FIXTURESIZE 
The ADJACENCY_FIXTURESIZE System Variable is used to filter out fixtures below a 
certain size for the purpose of Fixture Adjacency calculations.  

 

In the above example, the central fixture is narrow. If its length (width) is above the value 
of the ADJACENCY_FIXTURESIZE System Variable, the central fixture will be included 
in the fixtures used for Fixture Adjacency calculations. If its length (width) is below the 
value of the ADJACENCY_FIXTURESIZE System Variable, the central fixture will be 
excluded from the Fixture Adjacency calculations.  
 

ADJACENCY_FRONTBACK 
The ADJACENCY_FRONTBACK System Variable is used to specify the maximum 
distance between fixtures that are back to back that allows then to be regarded as 
adjacent behind a specific fixture.  
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In the example above, fixture 2 is separated by a gap from fixture5. If this gap is below 
the value specified in ADJACENCY_FRONTBACK,  fixture 5 will be regarded as 
adjacent (behind) fixture 2. If the gap is above the value specified in 
ADJACENCY_FRONTBACK, fixture 3 will not be regarded as adjacent. 

Note: At present the Front/Back distance used for fixture 
adjacency calculations is taken from the 
ADJACENCY_LATERALGAP System variable. 

 

ADJACENCY_LATERALGAP 
The ADJACENCY_LATERALGAP System Variable is used to specify the maximum 
lateral distance between fixtures that allows them to be regarded as adjacent to left and 
right of a specific fixture.  

 

In the example above, fixture 3 is separated from fixture 2 by a gap. If this gap is below 
the value specified in ADJACENCY_LATERALGAP, fixture 3 will be regarded as 
adjacent (to the right) to fixture 2, if the gap is above the value specified in 
ADJACENCY_LATERALGAP, fixture 3 will not be regarded as adjacent. 
It is possible to set ADJACENCY_LATERALGAP to a value such as 24 inches (610 mm) 
so that fixtures that are either side of a pillar are regarded as adjacent. 
 

ADJACENCY_MAX_ANGLE 
The ADJACENCY_MAX_ANGLE System Variable is used for gondolas. 
If the angle between adjacent fixtures is less than the ADJACENCY_MAX_ANGLE 
System Variable, the fixtures will be regarded as belonging to the same side. If the angle 
between adjacent fixtures is greater than the ADJACENCY_MAX_ANGLE System 
Variable, the fixtures will be regarded as belonging to the different sides. 
In the double sided gondola with endcaps below, the ADJACENCY_MAX_ANGLE 
System Variable was set to 30 degrees. Each time the angle between two successive 
adjacent fixtures have an angle exceeding thirty degrees, a new side is created. The 
fixtures making up the example gondola have been numbered according to the gondola 
numbering convention: Gondola Number/Side/Level/Fixture Number. The gondola 
thus has four sides. 
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In the snake gondola below, the angle between the second and third fixtures is below that 
specified in the ADJACENCY_MAX_ANGLE System Variable, so the first three fixtures 
are treated as belonging to a single gondola side. The angle between the third and fourth 
fixtures is above that specified in the ADJACENCY_MAX_ANGLE System Variable, so 
the last two fixtures are treated as belonging to another gondola side.  

 

ADJACENCY_OVERLAP 
The ADJACENCY_OVERLAP system variable is not presently in use. 
 

ADJACENCY_SEARCH 
The ADJACENCY_SEARCH system variable is not presently in use. 
 

ADJACENCY_TOLERANCE 
The ADJACENCY_TOLERANCE system variable is not presently in use. 
 

ADJACENCY_VERTICALGAP 
The ADJACENCY_VERTICALGAP System Variable is used to specify the maximum 
distance between fixtures that are stacked vertically that allows them to be regarded as 
adjacent above a specific fixture.  
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In the example above, one fixture is above another. If the vertical gap between the 
fixtures is less than the ADJACENCY_VERTICALGAP System Variable, the top fixture 
will be regarded as adjacent above the lower fixture. If the vertical gap between the 
fixtures is more than the ADJACENCY_VERTICALGAP System Variable, the top fixture 
will be regarded as adjacent above the lower fixture. 

Note: the ADJACENCY_VERTICALGAP System Variable is 
not taken into account by the software at present, so any 
fixture above another is regarded as 'adjacent above'. 

 

ADJACENCY_AISLESIZE 
The ADJACENCY_AISLESIZE system variable is used to establish a distance tolerance 
from an Aisle. Fixtures within this distance from an aisle are regarded as adjacent to it, 
fixtures outside this distance are not. 
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Depending on the setting of the ADJACENCY_AISLESIZE system variable, Fixtures 15 
and 16 may or may not be regarded as adjacent to the Aisle. It is then possible to 
determine which products are on the fixtures adjacent to the aisle, and hence which 
products share the aisle. 

Note: Aisle adjacencies are calculated relative to the front 
direction of the fixture. Fixtures 1,8 and 9 - 14 will not be 
shown as adjacent to the drawn aisle because a line drawn 
out perpendicular from the front face of the fixtures will not 
intersect the aisle.  

 

Area Calculations 

Overview of Area Calculations 
Area Calculations are used to establish the amount of floor area apportioned to 
individual fixtures.  The function can only be called in the Planner Module from the 
Calculations menu or the Calculations toolbar. this will bring up the Area Calculation 
dialogue box. 
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This shows the area allocated to specific fixtures - lighter shades of blue indicating that 
areas shared by two or more fixtures.  
The settings in the Area Calculation Directions frame in the Category tab of the Block 
Details dialogue box affect the nature of area calculations - areas will only be calculated 
in the ticked directions. 

 

This can be seen by comparing the two examples of are calculations below. The top 
image shows an area calculation based on fixtures set for West East and South Directions. 
The bottom image shows and area calculation based on South Direction only. 
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Note: the results of the Area Calculations are subsequently 
used in Space Calculations. 

 

Theory of Area Calculations 
Area Calculations are used to apportion areas to all fixtures that are within the Internal 
area zone.  
The first factor affecting area calculations is the Area Calculation Directions specified in 
the Category Tab of the Block Details dialogue box in Fixture Studio.  
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The maximum area available for Area Calculations is based on the Internal Area Zone 
and the AREA_BOUNDARY_DISTANCE System variable. 

  If an Internal Area zone is present, no fixture can be allocated any area that is outside 
of the zone boundary. 

  The maximum distance a fixture can be allocated area within is determined by the 
 AREA_BOUNDARY_DISTANCE System variable. 

 

In the above example, the maximum distance the fixture can be allocated area within is 
determined by the AREA_BOUNDARY_DISTANCE System variable (red box). The 
fixture can therefore only be allocated part of the area within the Internal Area Zone 
(blue box). However, at one point the Internal Area Zone boundary is closer that the 
distance set by the AREA_BOUNDARY_DISTANCE System variable, so part of the 
potential area available to the fixture is excluded from the area calculations because it 
lays outside of the boundary of the Internal Area Zone. 
Each fixture then establishes the distance of other fixtures from it using the 
AREA_LARGE_INCREMENT, AREA_MEDIUM_INCREMENT and 
AREA_SMALL_INCREMENT System Variables. 
The fixture starts out using the Large Increment. It feels out one 'large 
increment' distance from the fixture. If it does not detect anything, it feels out another 
large increment distance from the fixture until it detects something, or reaches an 
Internal Area Zone Boundary or the Area Boundary distance.    
Once another fixture had been detected using large increment, the software starts using 
the Medium Increment distance to get a more precise 'range'. It keeps feeling out using 
'medium increment' using as a starting point the last 'large increment' distance that did 
not find a fixture in that direction. It feels out one 'medium increment' distance. If it does 
not detect anything, it feels out another medium increment distance until it detects 
something, or reaches an Internal Area Zone Boundary or the Area Boundary distance.  
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Once a fixture has been identified by feeling out a 'medium increment distance, the same 
process starts with the 'small increment' distance using as the last 'medium increment' as 
a starting point.  

 

The process can be seen in the above example. Fixture 1 starts feeling out with large 
'increment' (500 inches) and detects that there is a fixture within that distance. It then 
starts feeling out with 'medium increment' (50 inches). it detects there is no fixture within 
50 inches, but there is one within 100 inches. Finally, it starts feeling out using 'small 
increment' (5 inches) using the 50 inch medium increment datum as a starting point. It 
does not detect a fixture within the first small increment distance, but does within the 
second. Fixture 1 has therefore detected another fixture (Fixture 2) within 50 + 5 = 55 
inches of its position. 
Finally, the software takes into account the Area Calculation Directions, the limits within 
which the area calculation will be carried out (Internal Area Zone, etc) and the position of 
the fixtures. It then apportions areas to each fixture. If an area is 'shared'  by multiple 
fixtures, the shared area is subdivided up between the fixtures. 

 

In the example above, both Fixture 1 and Fixture 2 have areas exclusive to them. There is 
a shared area between then. The software will detect this and allocate part of this shared 
area to Fixture 1 and part to Fixture 2. 
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This can be seen in the Allocated Areas dialogue box (below) where the dark areas blue 
areas represent areas that have been exclusively allocated to specific fixtures and the 
lighter blue areas represent areas that will be apportioned pro rata to different fixtures. 

 

 
  

AREA_BOUNDARY_CLIPPING_LEVEL 
The AREA_BOUNDARY_CLIPPING_LEVEL System Variable is allows users to specify 
whether the area calculations for a fixture should be relative to the Internal Area Zone or 
the Department Zone that it is in.  
This functionality has not yet been implemented and area calculations can only be done 
relative to the Internal Area Zone 
 

AREA_BOUNDARY_DISTANCE 
The AREA_BOUNDARY_DISTANCE System Variable is not presently in use. 
 

AREA_LARGE_INCREMENT 
AREA_LARGE_INCREMENT is one of three system variables affecting the logic of how 
the Area calculation is carried out, the other two being AREA_MEDIUM_INCREMENT 
and AREA_SMALL_INCREMENT.  
The three work in conjunction, the software 'feeling out' from the fixture using 
AREA_LARGE_INCREMENT setting until a fixture is encountered. The software 
successively then uses AREA_MEDIUM_INCREMENT and 
AREA_SMALL_INCREMENT to establish a progressively more accurate distance 
between fixtures.  
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AREA_MAX_DISTANCE 
The AREA_MAX_DISTANCE System Variable specifies the maximum distance from a 
fixture the software will take into account when allocating areas. This distance will apply 
unless  the Area Max distance exceeds crosses the boundary of the internal Area Zone. If 
this is the case, any part of the AREA_MAX_DISTANCE outside of the boundary will be 
excluded for calculation purposes.  

 

 

AREA_MEDIUM_INCREMENT 
AREA_MEDIUM_INCREMENT is one of three system variables affecting the logic of 
how the Area calculation is carried out, the other two being 
AREA_LARGE_INCREMENT and AREA_SMALL_INCREMENT.  
The three work in conjunction, the software 'feeling out' from the fixture using 
AREA_LARGE_INCREMENT setting until a fixture is encountered. The software 
successively then uses AREA_MEDIUM_INCREMENT and 
AREA_SMALL_INCREMENT to establish a progressively more accurate distance 
between fixtures.  
 

AREA_SMALL_INCREMENT 
AREA_SMALL_INCREMENT is one of three system variables affecting the logic of how 
the Area calculation is carried out, the other two being AREA_LARGE_INCREMENT 
and AREA_MEDIUM_INCREMENT.  
The three work in conjunction, the software 'feeling out' from the fixture using 
AREA_LARGE_INCREMENT setting until a fixture is encountered. The software 
successively then uses AREA_MEDIUM_INCREMENT and 
AREA_SMALL_INCREMENT to establish a progressively more accurate distance 
between fixtures.  
The setting for AREA_SMALL_INCREMENT will affect the accuracy of the calculation. If 
set to a high value, the Area Calculation exercise will complete quickly, but with a lower 
degree of accuracy. If set to a small value, the result will be more accurate but the 
processing time will be significantly longer. 
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AREA_UNIT_OF_MEASURE 
The AREA_UNIT_OF_MEASURE system variable is used to set the type of unit used for 
the results of Area Calculations. The value of the AREA_UNITS OF_MEASURE System 
Variable refers to the Unit ID in the Units dialogue box. 

 

For example, if the results are wanted in Square Feet, Unit ID 31 would be selected, if the 
results were wanted in Square Metres, Unit ID 32 would be selected. 

Note: This functionality is not yet fully implemented. 

 

LDAP 

Overview 
The Lightweight Directory Access Protocol (LDAP) [and its associated information 
directories] provide a simple, organization wide method of storing information that is 
often read but only infrequently updated. For example, it might hold information on 
personnel employed by an organization. The information held might include: 

  Name 

  Position 

  Address  

  Telephone Number 

  User ID 

  Password 

  Application 1 privileges 

  Application 2 privileges 

  Macro Space Management privileges  
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The information can then be used for multiple purposes; for example Human Resources 
can access details of address and telephone number, while the assigned User ID and 
Password can be used to log into multiple applications, including Macro Space 
Management. 
LDAP is an entirely separate application to Macro Space Management, but Macro Space 
Management has the ability to link to it and exchange information. It does this by means 
of: 

  Code within the software allowing it to link to LDAP and access data. 

  System Variables holding parameters used to connect to LDAP 
The configuration and use of LDAP is outside of the scope of this help file and will not be 
discussed further. 
 

LDAP and Macro Space Management 
The Lightweight Directory Access Protocol (LDAP) provides an alternative method of 
password authentication to that provided by Macro Space Management.  

  If the AUTHENTICATION system variable is set to 0,  Macro Space Management 
(and In-Store Space Collaboration) uses the Functional Security option in the 
Administration Module to determine if a user is a valid user, what user groups the 
user belongs to and what privileges have been assigned. 

  If the AUTHENTICATION system variable is set to 1, when a user logs in to Macro 
Space Management (or In-Store Space Collaboration), the User Group they belong to 
(and the privileges they have) are determined using LDAP. This information is 
passed back to Macro Space Management, allowing three activities to be carried out: 
o Authentication - validating the user's ID and password 
o Authorization - determining which Macro Space Management privileges have 

been assigned 
o Notification - in some circumstances, email messages will be sent reporting 

changes to statuses of objects  

Note: LDAP is an external application to Macro Space 
Management. Configuring LDAP is beyond the scope of this 
help file.  

Authentication using Functional Security in Macro Space Management 
The Administration Module contains a Functional Security option. 
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  User Groups can be created  - each user group specifying a particular set of 
privileges. 

  Users can then be assigned to the User Group and will be able to use the MSM 
privileges associated with that user group. 

Users and User Groups can either be manually created, or can be imported using Data 
Importer.  
When the user logs in to Macro Space Management, the user name and password they 
use are compared to entries in the database to ensure they are a valid user and to 
determine what privileges they have. 
Authentication using LDAP 
When authentication is done using LDAP, a different procedure is followed: 
1. Authentication 
When a user logs into Macro Space Management (or In-Store Space Collaboration), they 
are queried against information held in the LDAP directory. If the user has the correct 
access rights, they will be able to log into the application. If the user has not previously 
accessed MSM or ISSC, an entry for that user will be created in the MSM database. 
2. Authorization 
Once an individual has been authenticated as a valid Macro Space Management or In-
Store Space Collaboration user, their privileges are assigned according to which user 
groups they belong to.   

1. The required User Groups and their associated privileges must previously have 
been created/assigned in the Functional Security module. This cannot be done 
by LDAP. 
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2. If the user has not previously accessed MSM or ISSC, links will automatically be 
created in the database between that user and the pre-configured User Groups. 
(If a user has previously accessed MSM or ISSC, the links will already exist). 

3. The software uses the User Groups to which an individual belongs to determine 
what privileges they have in the software.   

3. Notification 
If LDAP contains email addresses for individuals and Macro Space Management/In-
Store Space Collaboration have been appropriately configured, email notifications can be 
sent when specific objects within MSM/ISSC change their status.   
 

LDAP, User Groups and User Group Types 
Information on User Groups is stored in the AVTTB_USER_GROUP table in the Macro 
Space Management database.  

 

There are two fields that are of interest to the user; USG_CODE and UGT_ID 
USG_CODE 
The USG_CODE (User Group Code) has to be manually added to the 
AVTTB_USER_GROUP by a data base administrator. It provides a field that can be 
mapped to a field in the LDAP directory. Accordingly, it should be unique to a specific 
user group. 

Note: The field has been provided to make it easier for 
LDAP administrators. It is easier to map 'Admin' to an item 
in the LDAP directory that it is to map the USG_ID (for 
example '1').  

UGT_ID 
The UGT_ID (User Group Type) in the  AVTTB_USER_GROUP table is a foreign key for 
the AVTTB_USER_GROUP_TYPE table. This read only table specifies the type (and 
hence access) a user group has.  

 

Macro Space Manager will only allow access to User Group Types 1 (Admin User) and 2 
(Designer User). 
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In-Store Space Collaboration will allow access to User Group types 1 (Admin User), 2 
(Designer User), 6 (District Manager), 7 (MEDS Manager) and 9 (Validation User).  

Note: If a user group is set to type 6 (District Manager), 7 
(MEDS Manager) or 9 (Validation User), the members of the 
user group will only be able to access ISSC and not MSM. 

The User Group Type also determines the type of access: 

  If set to 1 (Admin User), 2 (Designer User) or 9 (Validation User) access to stores, etc 
is set manually, through MSM's Data Security options in the Admin Module. 

  If set to 6 (District Manager) or 7 (MEDS Manager) access to stores is dynamically 
determined by permissions set in LDAP. This allows additional permissions to be set 
using LDAP including emails and dynamic store access. 

Note: care should be taken not to mix the two sorts of 
permissions. If one ISSC User Group has manually 
determined permissions (Functional Security in MSM) and 
another ISSC User Group has dynamically determined 
permissions (LDAP), then confusion could result from 
differences between the permissions set in MSM Functional 
Security and the LDAP permissions. 

Because of the complexity of this topic, further information can be obtained from Oracle's 
Technical Support Department. 
 

AUTHENTICATION 
The AUTHENTICATION system variable is used to control what form of password 
authentication is used.  
0 = Use Macro Space Management's password authentication system. 
1 = Use LDAP to authenticate passwords. 

Note: LDAP is an external application that can be used for 
password authentication (and other tasks). Configuring 
LDAP is beyond the scope of this help file.  

 

LDAP_APPBASEDN 
The LDAP_APPBASEDN system variable holds the base Distinguished Name (DN) 
value for the application within the LDAP directory structure. This is used to uniquely 
identify Macro Space Management and In-Store Space Collaboration.  
The value of the Distinguished Name must be obtained from the LDAP administrator 
and is made up of a series of Relative Distinguished Names separated by commas. This 
information can be entered as a text string.   
 

LDAP_APP_PROPERTY 
The LDAP_APP_PROPERTY system variable specifies the custom property that holds 
authentication information.  
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LDAP_APPID 
The LDAP_APPID system variable references a dummy user in the Macro Space 
Management database that serves as a portal into LDAP. This dummy user must map to 
a parallel valid entry in the LDAP directory.  
When a real user attempts to log into Macro Space Management (or In-Store Space 
Collaboration), MSM uses the dummy user referenced by the LDAP_APPID system 
variable to connect to LDAP. Once connected to LDAP, MSM can then read the required 
information from LDAP, and (if necessary) create entries in the MSM database.  
The LDAP_APPID system variable must reference the USR_ID for the entry in the 
AVTTB_USER table. 

 

As the User Log-in and associated password are not used manually, it does not matter 
that they will eventually 'expire' when the Change Password Period in Security Options 
is exceeded after the user is created. 

 

Note: Manually logging in to this dummy entry after the 
password has been 'expired' will clock out all access to 
LDAP. 

 

LDAP_CORPORATION 
The LDAP_COROPRATION system variable is of four system variables than can be 
used to control dynamic access (i.e. access controlled through LDAP rather than Macro 
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Space Management's Functional Security Module). The other three system variables are 
LDAP_DIVISION, LDAP_DISTRICT and LDAP_STORE.  
Each system variable maps to a level in the hierarchy; the first three to clusters and sub-
clusters, and LDAP_STORE to stores. 

 

The values that the system variables reference are the Cluster or Store Codes. In the 
example below, the Cluster has a Cluster Code of H-2. 

 

These cluster or store codes can then be used within LDAP to specify which specific parts 
of the hierarchy an individual has permissions to modify.  
For these dynamic permissions to work, the information help in LDAP and the hierarchy 
in store manager must be in sync. Modifications to the hierarchy must first be made in 
LDAP, and then the hierarchy in Store Manager changed to match. 
 

LDAP_DIVISION 
The LDAP_DIVISION system variable is of four system variables than can be used to 
control dynamic access (i.e. access controlled through LDAP rather than Macro Space 
Management's Functional Security Module. (The other three system variables are 
LDAP_CORPORATION, LDAP_DISTRICT and LDAP_STORE).  
Each system variable maps to a level in the hierarchy; the first three to clusters and sub-
clusters, and LDAP_STORE to stores. 
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The value that the system variables reference are the Cluster or Store Codes. In the 
example below, the Cluster has a Cluster Code of H-2. 

 

These cluster or store codes can then be used within LDAP to specify which specific parts 
of the hierarchy an individual has permissions to modify.  
For these dynamic permissions to work, the information help in LDAP and the hierarchy 
in store manager must be in sync. Modifications to the hierarchy must first be made in 
LDAP, and then the hierarchy in Store Manager changed to match. 
 

LDAP_DISTRICT 
The LDAP_DISTRICT system variable is of four system variables than can be used to 
control dynamic access (i.e. access controlled through LDAP rather than Macro Space 
Management's Functional Security Module). The other three system variables are 
LDAP_CORPORATION, LDAP_DIVISION and LDAP_STORE.  
Each system variable maps to a level in the hierarchy; the first three to clusters and sub-
clusters, and LDAP_STORE to stores. 
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The value that the system variables reference are the Cluster or Store Codes. In the 
example below, the Cluster has a Cluster Code of H-2. 

 

These cluster or store codes can then be used within LDAP to specify which specific parts 
of the hierarchy an individual has permissions to modify.  
For these dynamic permissions to work, the information help in LDAP and the hierarchy 
in store manager must be in sync. Modifications to the hierarchy must first be made in 
LDAP, and then the hierarchy in Store Manager changed to match. 
 

LDAP_MAIL 
The LDAP_MAIL system variable is used to specify the name of the property in the 
LDAP database used to hold details of email addresses. This enables Macro Space 
Management to initiate sending notification emails to specific individuals.  
 

LDAP_SERVER 
The LDAP_SERVER system variable hold details of the server that hosts the LDAP 
system. The information should be of the form:  
\\Server.CompanyName.com:PortNumber 
 

LDAP_STORE 
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The LDAP_STORE system variable is of four system variables than can be used to 
control dynamic access (i.e. access controlled through LDAP rather than Macro Space 
Management's Functional Security Module). (The other three system variables are 
LDAP_CORPORATION, LDAP_DIVISION  and LDAP_DISTRICT). 
Each system variable maps to a level in the hierarchy; the first three to clusters and sub-
clusters, and LDAP_STORE to stores. 

 

The value that the system variables reference are the Cluster or Store Codes. In the 
example below, the Store has a Store Code of SE-1 

 

These cluster or store codes can then be used within LDAP to specify which specific parts 
of the hierarchy an individual has permissions to modify.  
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For these dynamic permissions to work, the information help in LDAP and the hierarchy 
in store manager must be in sync. Modifications to the hierarchy must first be made in 
LDAP, and then the hierarchy in Store Manager changed to match. 
 

LDAP_USERBASEDN 
The LDAP_USERBASEDN system variable holds the base Distinguished Name (DN) 
value for the users within the LDAP directory structure. This is used to uniquely identify 
Macro Space Management and In-Store Space Collaboration.  
The value of the Distinguished Name must be obtained from the LDAP administrator 
and is made up of a series of Relative Distinguished Names separated by commas. This 
information can be entered as a text string.   
 

LDAP_USER_PREFIX 
The LDAP_USER_PREFIX system variable allows an LDAP prefix to be 'stripped off' if a 
user name is imported into Macro Space Management. 
For example, if the LDAP name is of the form Company_Name_User_Name, the 
LDAP_USER_PREFIX system variable can be used to remove the Company_Name_  part 
of the user name before it is inserted into the MSM database.  
 

Merchandiser 

ADDITIONAL_FIXTURE_HEIGHT 
The ADDITIONAL_FIXTURE_HEIGHT system variable is used to increase the height 
of the merchandisable area for all fixtures in the Merchandiser module beyond that set in 
the Merchandisable Areas Tab of the Block Details dialogue box in Fixture Studio.   
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It has the following effects: 
Fixture Studio 

It is added onto the setting for the upper part of the Merchandisable area. For example, if 
the Z value for offset is set to 0, the merchandisable area will finish at the top of the 
fixture (left hand image above). If the ADDITIONAL_FIXTURE_HEIGHT system 
variable is set to 12 inches, the merchandisable area will extend above the top of the 
fixture despite the offset being set to 0 (right hand image above).  

 

Merchandiser Module 
There will be two effects in the Merchandiser module. 

  The AutoFill command (Standard toolbar) will fill to a volume that includes the 
ADDITIONAL_FIXTURE_HEIGHT setting. 

  All fixtures and shelves will fill to a volume that includes the 
ADDITIONAL_FIXTURE_HEIGHT setting. 

 

FINGER_GAP 
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The FINGER_GAP system variable is used in the Merchandiser module. It specifies the 
minimum gap between the top of a group of products and the shelf above it. 

 

The purpose of the system variable is to ensure that there is always sufficient space for a 
customer to reach in and lift products off of a shelf.  

Note: The 'Vertical Gap' setting on the Size and Shape tab of 
the Display styles dialogue box may also influence the gap 
between the topmost item of merchandise and the shelf 
above.  

 

Planogram Importer 

Overview 
Planogram Importer is a standalone Macro Space Management tool that can be used to 
import planograms from third party planograming tools like Apollo, Galleria and 
ProSpace. 

Note: The Planogram Importer tool can be found in the 
C:\Program Files\Oracle Retail\MSM\APPS directory. 

When planograms are imported, they need to be matched to suitable fixtures and shelves 
in the Macro Space Management database. (This is done by using the planogram 
dimensions and data in the AVTTB_STYLE_IMPORTMAP table. If no suitable fixtures 
are found, then defaults can be assigned using three system variables: 

  DEFAULT_IMPORT_FIXEL_BLK_ID specifies a default shelf. 

  DEFAULT_IMPORT_FIXTURE_BLK_ID specifies a default fixture 

  DEFAULT_IMPORT_BLOCK_ID specifies a default product block. 
 

DEFAULT_IMPORT_FIXEL_BLK_ID 
The DEFAULT_IMPORT_FIXEL_BLK_ID system variable is used for Planogram 
import. The value should correspond to the ID of a suitable default shelf in the table of 
Block Details. This default shelf will be associated with the imported planogram if no 
more suitable match exists in the Macro Space Management database.  
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Note: it would be usual for the default shelf to be 
'stretchable', allowing it to suit any size of planogram. 

 

DEFAULT_IMPORT_FIXTURE_BLK_ID 
The DEFAULT_IMPORT_FIXURE_BLK_ID system variable is used for Planogram 
import. The value should correspond to the ID of a suitable default fixture in the table of 
Block Details. This default shelf will be associated with the imported planogram if no 
more suitable match exists in the Macro Space Management database.  

 

Note: it would be usual for the default fixture to be 
'stretchable', allowing it to suit any size of planogram. 

 

DEFAULT_IMPORT_BLOCK_ID 
he DEFAULT_IMPORT_BLOCK_ID system variable is used for Planogram import. The 
value should correspond to the ID of a suitable default product block in the table of Block 
Details. This default product block will be associated with the imported planogram if no 
more suitable match exists in the Macro Space Management database.  



System Variables 

General Options 109 

 

 

Planner 

CMDECHO 
The CMDECHO system variable can be used to turn on or off echoing commands to the 
AutoCAD command line in the Planner Module. 

 

0 = suppress showing some AutoCAD commands in the command line 
1 = show all AutoCAD commands in the command line. 

Note: Setting CMDECHO to 1 increases the number of 
prompts that appear in the command line - this may be 
useful to new users of the software. 

 

MENUECHO 
The MENUECHO system variable can be used to turn on or off echoing which toolbar or 
menu items were selected to the AutoCAD command line in the Planner Module. 

 

0 = suppress showing menu items selected. 
1 = show menu items or toolbar items selected in the command line. 
 

LAYER_STANDARD 
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The LAYER_STANDARD system variable is used to specify the AutoCAD Layer 
Standard used in the Planner module. The value of the system variable refers LAS_ID in 
the AVTTB_LAYER_STANDARD table. 

 

There are two default standards: 

  Retail Focus (Macro Space Management) which contains information on layers 
specific for Retail Focus 

  BS1192/ISO13567 which contains information on the ISO13567 International 
standard 

Note: It is possible to add additional standards to the 
database, but this should be done in conjunction with 
Oracle's Technical Support department as additions need to 
be made to a number of different tables. 

 
   

Report Designer 

About Report Designer 
Report Designer is a module within Macro Space Management. It allows customized 
reports to be produced for planograms. Report Designer can be invoked in one of two 
ways: 

  From the File > Print > Planogram menu. This allows printing of planogram reports, 
but does not allow editing 

  From the C:\Program Files\Oracle Retail\MSM\APPS\AVT5PogReporter 
directory. This allows both editing of the report layout and printing of planogram 
reports. 
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RPTDSG_HELPFILE 
The RPTDEG_HELPFILE system variable contains the URL (Uniform Resource Location) 
for the help files for Report Designer. It should detail both the path to the directory and 
the name of the file used to open the help. 

Note: Report Designer Help is in Webhelp format. This 
differs from the CHM files used for Macro Space 
Management.  

 

RPTDSG_TESTPOGID 
The RPTDSG_TSTPOGID  system variable specifies the planogram that will be 
displayed for testing the Planogram Report.  The planogram is identified by its POG_ID 
in the AVTTB_PLANO table. 

 

 

Space Calculations 
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Overview 
Space Calculations are used to calculate a set of parameters for fixtures and the products 
occupying them. These parameters can then be used in reports specifying the efficiency 
with which a store has been merchandised. These Space Calculations are: 
Base Linear 
Base Linear is the greater value of: 

  The merchandisable length of the fixture as defined in the Merchandisable Areas tab 
of the Block Details dialogue box.  

  The nominal length of the fixture as defined in the Sizes tab of the Block Details 
dialogue box.  

Shelf Linear 

Shelf Linear is the total merchandisable length of the shelves on a fixture. Shelf Linear 
may also include the length of the fixture itself, if that fixture is populatable. 
Footprint 
Footprint is the greater value of: 

  The merchandisable area of the fixture as defined in the Merchandisable Areas tab of 
the Block Details dialogue box.  

  The nominal area of the fixture as defined in the Sizes tab of the Block Details 
dialogue box.  

Allocated Area 

Allocated Area is calculated using the Calculate Areas option on the Calculate Menu and 
toolbar in Planner. It will not be discussed further here. 
Display Volume 
The display volume is the actual volume occupied by a specific product and is calculated 
from the length, depth and height assigned to it, multiplied by the number of instances 
placed on a specific fixture. 
Nominal Volume 

The nominal volume is the base linear of a fixture multiplied by the depth specified in 
the CALC_STND_DEPTH system variable and the height defined in the 
CALC_STND_HEIGHT system variable. 
Allocated Volume 
The allocated volume is the Allocated Area multiplied by the height defined in the 
CALC_STND_HEIGHT system variable.  
 

CALC_STND_DEPTH 
The CALC_STND_HEIGHT system variable is used by Space Calculations in the 
Planner Module. It is used in conjunction with the CALC_STND_DEPTH system variable 
and the Base Liner of a fixture to calculate the nominal volume. 
 

CALC_STND_HEIGHT 
The CALC_STANDARD_HEIGHT system variable is used by Space Calculations in the 
Planner Module. It has two purposes: 

  It is used in the calculation of Nominal Volume 

  It is used in the calculation of Allocated Volume. 
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Nominal Volume 
The nominal volume is the base linear of a fixture multiplied by the depth specified in 
the CALC_STND_DEPTH system variable and the height defined in the 
CALC_STND_HEIGHT system variable. 
Allocated Volume 

The allocated volume is the Allocated Area multiplied by the height defined in the 
CALC_STND_HEIGHT system variable.  
 

Store Manager 

PUBLISH_DATE_LEAD_PERIOD 
The PUBLISH_DATE_LEAD_PERIOD system variable is used in Store Manager. It 
affects the file Properties dialogue box 

 

When a user sets a file to Authorised status, the previously grayed out Publish and 
Effective dates become active. The value of the PUBLISH_DATE_LEAD_PERIOD system 
variable is added onto the current date to set a default Publish Date - for example if the 
current date is the 7th January and the  PUBLISH_DATE_LEAD_PERIOD system 
variable is set to 7, then the default Publish Date will be set to 14th January. 
 

EFFECTIVE_DATE_LEAD_PERIOD 
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The EFFECTIVE_DATE_LEAD_PERIOD system variable is used in Store Manager. It 
affects the file Properties dialogue box 

 

When a user sets a file to Authorised status, the previously grayed out Publish and 
Effective dates become active. The value of both the PUBLISH_DATE_LEAD_PERIOD 
and EFFECTIVE_DATE_LEAD_PERIOD system variables are added onto the current 
date to set a default publish date - for example if the current date is the 7th January, the 
 PUBLISH_DATE_LEAD_PERIOD system variable is set to 7 and the 
EFFECTIVE_DATE_LEAD_PERIOD system variable is set also to 7, then the default 
publish date will be set to 21st January. 
 

ENABLE_FILE_TRIGGER_DATE 
The ENABLE_FILE_TRIGGER_DATE system variable determines the behavior of both 
the File Properties dialogue box and UpdateStatus.exe. 
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Value Result Other Actions 

0 or 1 UpdateStatus.exe is disabled and has no 
effect on File or Revision statuses. Publish 
and Effective dates are disabled and cannot 
be set. 

Publish and Current statuses need to be 
selectable so that files can manually be 
taken through the software cycle. 

2 Effective date is enabled. UpdateStatus.exe 
will change file status if the Effective date 
is exceeded. 

Publish needs to be manually selectable. 

3 Publish and Effective dates are enabled.  Publish and Current status should not be 
selectable by the user so that update status 
is the required method to change them. 

 

Tax Codes 

About Tax Codes 
The Tax Codes Option in the Admin Module allows users to enter rates for varying 
types of tax. These rates can then be assigned to products at SKU Level in Product 
Studio. 
The Tax Code Window has three main parts. 

 

Pull down menus give access to various Tax Code options. 
The Toolbar gives access to other Tax Code options. 
The Tax Codes are displayed in the Tax Code Grid. 
 

Menus and Toolbars 
The File Menu allows users to exit the option. 
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The Edit Menu allows users to Add, Edit or Delete Tax Codes 

 

The View Menu allows users to switch On and Off display of the Toolbar and Status 
Bars. It also allows them to Refresh the Tax Code grid. 

 

More Info on Refreshing 
The Help Pull Down Menu 
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Clicking on About displays the current version number of the software. 
The Toolbar gives access to varying Tax Code options 

 

 

 
Exit 

 
Add Tax Code 

 
Exit Tax Code 

 
Delete Tax Code 

 
Refresh 
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Adding, Editing, and deleting Tax Codes 
To Add a Tax Code click on the Add Tax Code icon or select Add from the edit pull 
down Menu.  

 

Type a description into the Description text box then click in the Rate text box and enter 
the required Tax Rate.  
Press <Return> to send the values to the central Macro Space Management database. 

Note: The values will not be stored in the central database 
until return has been pressed.  

Editing the Tax Codes can be done by clicking in the relevant box in the Tax Code grid, 
then typing in the amended values. Alternatively, highlight the relevant tax code and use 
the edit options in the edit menu or in the toolbar. 

 

Press <Return> to store the changed values in the central Macro Space Management 
database. 

Note: The values will not be stored in the central database 
until return has been pressed.  
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To Delete a Tax Code highlight the required Tax Code then click on the Delete icon or 
select the Delete option from the Edit pull down menu. 

 

Note: The tax code will be deleted without confirmation 
being requested. 

 

Refreshing and Exiting 
Refreshing is of use when multiple people are using the same option in Admin.  

 

Clicking on the Refresh Icon will cause the list of Tax Codes to be updated based on 
current information from the central Macro Space Management database.   
This allows users to see changes being made by other users. 
The Exit option will cause users to exit this part of the Admin Module. 
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Note: If data has been entered in the Tax Code Grid, ensure 
that <Return> has been pressed before exiting or data will be 
lost. 

 
   

Assigning Tax Codes 
Tax Codes are assigned in the SKU dialogue box in Product Studio 
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Importing Tax Codes 
Tax Codes are stored in the AVTTB_SEASON table in the database. 

 

This table can be populated by using the Data Importer module as an alternative to 
entering data manually via the Admin Module.  
The AVTTB_TAX_CODES table must be populated before Tax Codes can be assigned to 
Products (AVTTB_PRODUCT_ITEM table) 
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Units 

Overview 
The Units Option within the Admin Module allows the user to specify the units that will 
be available within Macro Space Management. They are specified relative to fundamental 
SI units and can be specified according to the users needs.  
The Units Window contains three main parts. 

 

The Menus and the Toolbar allow the user to access varying options concerning units. 
The Unit Details section allows the user to see the values assigned to specific units.  
 

About SI Units 
The International System of Units (abbreviated SI from the French le Système 
International d'unités) is the modern form of the metric system.  
It contains seven basic units; 
 

Name Symbol Measurement 

Metre (Meter) m Length 

Kilogram Kg Weight 

Second s Time 

Ampere A Electric current 

Kelvin K Temperature 

Mole mol Quantity of matter 

Candela cd Light intensity 
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All units used in Macro Space Management are relative to these basic units. 
For example grammes are 1/1000th of a kilogram. 

Note: For convenience Macro Space Management uses the 
degree Centigrade rather than degrees Kelvin as the 
measurement of temperature. 

 
   

About Scientific Notation 
Scientific Notation is just a shorthand for writing large or small numbers.  
It is sometimes used in Macro Space Management. Some examples of scientific notation 
are: 
 

Scientific 
Notation 

Decimal 
Equivalent 

1 x 106 1,000,000 

1 x 103 1,000 

1 x 102 100 

1 x 101 10 

1 x 10-1 0.1 

2 x 10-2 0.01 

2 x 10-3 0.001 

 
   

The File Pull Down Menu 
The File pull down menu allows users three options. 

 

Reload Units 
This option allows users to reload the display grid with the values for the units when 
they were last saved. This will overwrite any alterations made to the values of the units 
but not saved. 
Save Units 
This option allows users to save any changes made to the values for units. 
Exit 
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This allows users to exit the unit option. If changes have not been saved, then a warning 
dialogue will appear. 

 

 
  

The Units Pull Down Menu 
The Units pull down menu allows users to Add a new unit or Delete an exiting one.  

 

To Add a Unit click on the Add option. This will add a new line in the table of units.  
To Delete a Unit highlight a line and click on the Delete option. The Unit will then be 
deleted from the table of units. 
Additions or deletions will not be permanent until the Save option has been used in the 
File pull down menu. More Info 
 
   

The Dimensions Pull Down Menu 
The Dimensions pull down menu allows users to bring up the Dimensions dialogue 
box. 
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When entering a new dimension, it has to be related to the basic dimensions of Number, 
Length, Mass, time, Charge, Intensity, Money, or Angle. 
The power is that which the original basic dimension has to be changed to describe the 
new one. This will normally only affect the length basic dimension.    
 

Basic 
Dimension 

Power Result 

Length 1 Length 

 2 Area 

 3 Volume 
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The Help Pull Down Menu 
The Help pull down menu allows users to call this Help File. Clicking on About will 
bring up a small dialogue box showing the current version of the software.   

 

 
   

The Toolbar 
The Toolbar allows users to access varying options affecting the addition, editing, 
deletion and saving of units. 

 

 

 
Exit 

 
Save 

 
Add Unit 

 
Delete unit 

 
Refresh 

 
Edit Unit 

 
   

Unit Details 
The Unit ID is used internally within the central Macro Space Management database. 
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It is not editable by the user. 
The Symbol is used in Reports, etc. 

 

The Description is used to prompt users as to the purpose of the dimension.  

 

Prefixes are used before units.  

 

An example would be where a £ or $ sign was wanted before a monetary value. 
The Suffix is the symbol that will be displayed after the unit if it appears in a drawing 
etc.  

 

The suffix for Kilograms is Kg so weights will be displayed as follows: 
5 Kg, 10.7 Kg, 0.3 Kg 
Similarly the suffix for meters is m so lengths will be displayed as follows: 
5 m, 10.7m, 0.3 m 
The Order is used to specify the order units appear in a drop down list. 
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The Offset Option is used where the unit is related to a base dimension by a y = mx + c 
relationship. It represents the constant c in the equation.  

 

For example the offset for degrees Kelvin is -273.16. The relationship between degrees 
Centigrade and Kelvin is Degrees Kelvin = Degrees Centigrade - 273.13. 
Offsets are sometimes used in conjunction with SI Factors. For example the offset 
between degrees Centigrade and Fahrenheit is -32 and the SI Offset is 0.555. Degrees 
Fahrenheit = (Degrees Centigrade x 0.555) -32 
The SI Factor is used where the unit is related to a base dimension by a y = mx + c 
relationship. It represents the co-efficient m in the equation.  

 

The SI factor is the factor by which the basic dimension has to be scaled by to give the 
correct value for the unit. For example there are 2.204 pounds to the kilogram, so the SI 
Factor is 0.454: 1 lb = 0.454 Kg 
As another example, there are 39.37 inches to the meter, so the SI factor is 0.0254: 1 in = 
0.0254 meters. 
The Display Option allows the user to select whether a unit will be displayed in the 
appropriate drop list when used in Macro Space Management. 

 

Units with a tick will be displayed. Units without a tick will not.  
Precision determines the number of decimal places that will display when the value of a 
unit is shown. 
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Number of 
decimal 
places 

Result 

0 10 

1 10.1 

2 10.25 

3 10.375 

 

Note: This functionality is being implemented, and not all 
variables may display to the set number of decimal places. 

Mandatory Units are units that cannot be deleted.  

 

These are units that are fundamental to Macro Space Management and correspond to the 
fundamental SI units, plus the Number, Money and Angle options. More on SI Units. 

Note: In current releases of Macro Space Management it is 
possible that the Mandatory and Default column headings 
have been swapped.  

Default Units are the units that will be preferentially displayed when the selected 
measurement system is in use. 

 

For example, if the imperial system is used, the default units might be selected as inches, 
pounds and degrees Fahrenheit. For the metric system, the default units selected might 
be centimetres, kilograms and degrees centigrade. 

Note: In current releases of Macro Space Management it is 
possible that the Mandatory and Default column headings 
have been swapped.  
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User Defined Attributes 

Overview of User Defined Attributes 

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management.  

User Defined Attributes (UDA's) allow a Macro Space Management Administrator to 
designate customizable fields for Users, Stores, Files, Fixtures, Products and Planograms. 
Each object with UDA's designated can then have object specific data assigned to them. 
Once assigned, the attributes can be used in two main ways:  

1. All MSM users can see customized, organization specific information for those 
objects with UDA data assigned.  

2. Reports can be produced based on the information in the User Defined 
Attributes.   

User  Defined Attributes require two stages: 

 

1. Configuring UDA's in Admin 
The required UDA's are configured in the Admin Module.  

 

Individual UDA's can be assigned specific names, date types, default values, etc. In the 
above example, UDA fields have been designated for stores. 
User Designed Attributes are used in: 

UDA Where Used Module 

Block Fixture (Block) definitions Block (Fixture) Definition/Fixture Studio 
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UDA Where Used Module 

File File Properties 
Information 

File Properties dialogue box/Store Manager 

Planogram Planogram Definitions Planogram Definition/Merchandiser 

Product Product Definitions Product Dialogue/Product Studio 

Store Store Definition Store Dialogue/Store Manager 

User User Definition Functional Security/Admin Module 

 
2. Assigning UDA's in Modules 
Once UDA's have been configured in the Admin Module, individual values can be 
assigned to instances of Blocks, Files, Planograms, Products, Stores and Users. In the 
example below, UDA's are being assigned to a store - each field being populated having 
previously been designated in the Administration Module. 

 

Values can be entered or selected from drop down lists (depending on how the UDA has 
been configured in the Admin Module). 
 

Dialogue Boxes where UDA's are Set 
UDA's can be assigned to specific Users, Stores, Files, Fixtures, Products and 
Planograms. The dialogue boxes where this can be done are as follows: 
Users 
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UDA's for Users are set in the Attributes tab of the User dialogue box accessible from the 
Functional Security Option in the Administration Module.  

 

Stores 

UDA's for Stores are set in the Attributes tab of the Add or Edit Store dialogue box in 
Store Manager.  
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Files 
UDA's will be visible for files in the File Properties dialogue box in Store Manager. This, 
as yet, does not contain an Attributes tab. 
Fixtures  

Fixture UDA's are visible in the Block Details dialogue box. 
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There are two forms of attributes in this dialogue box; Fixed Attributes and Variable 
Attributes. 
1. Fixed Attributes are set in the User Defined Attributes section of the Administration 

module. These attributes are common to all fixtures of that type.  
2. Variable Attributes are configured using the Edit Menu > Edit Attribute Definitions 

option in Fixture Studio. They can then be set for individual instances of fixtures in 
Planner, Merchandiser and In-Store Space Collaboration by selecting a fixture in the 
drawing and clicking the Attributes option in the respective toolbars. 

Note: Variable Attributes can be assigned to each instance of 
a fixture when an instance of that fixture is placed in a 
Planner. Those attributes can also be edited by selecting the 
fixture in In-Store Space Collaboration and selecting the 
Fixture Attributes option from the Fixtures toolbar.  

Products 

UDA's for Products are set at SKU level in Product Studio using the Custom Tab of the 
SKU dialogue box. 
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Planograms 

UDA's for Planograms are set in the UDA tab of the Planogram Design dialogue box in 
the Merchandiser module.  
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Overview of Configuring User Defined Attributes 
Configuring User Defined Attributes is done using the User Defined Attribute Option 
from the General menu of the Administration Module. This will bring up the User 
Defined Attributes dialogue box. 
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Close Option 
The close option (available from the toolbar or File pull down menu) closes the User 
Defined Attributes dialogue. 
Refresh Option 

The refresh option refreshes the UDA dialogue box with the latest information from the 
database. This is useful when other users are simultaneously working on UDA's as it 
allows the effects of their changes to be seen.  
UDA Options 
Users can see the varying UDA options as gray bars. They can be expanded or contracted 
by using the '+' or '-' signs. There are a fixed number of options for each UDA type. These 
are: 

UDA Number of 
Fields 

Block 10 

Planogram 25 

Product 15 

File 10 

Store 10 

User 10 

 
For each UDA, the user can configure the following options:  

Option Description 

Name The name describing the UDA 

Data Type The type of data for the UDA (set from a drop 
down list) 
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Option Description 

Mandatory Whether the UDA is mandatory to complete 

Sequence The order the UDA will appear in the list of 
UDA's seen by the user. 

Default The default value for the UDA 

Lookups Values for a drop down list that users can select 
from 

 
   

Configuring User Defined Attributes 
Configuring User Defined Attributes is done by setting the Name, Data Type, 
Mandatory, Sequence, Default and Lookup options. 

 

Note: when entering data, it will not be added to the 
database until <Return> has been pressed. 

Type 
There are currently six options as to where the UDA will be configured. 

UDA Type Where Used Dialogue Box and Module 

Block Fixture (Block) definitions Block (Fixture) Definition/Fixture Studio 

Planogram Planogram Definitions Planogram Definition/RF Merchandiser 

Product Product Definitions Product SKU Dialogue/Product Studio 

File file Properties File Properties/Store Manager 

Store Store Definition Store Dialogue/Store Manager 

User User Definition Functional Security/Admin Module 
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Name 
Name is entered by the user. It is the description that will appear in the dialogue box that 
uses that particular UDA. The description can be a maximum of 50 characters. 
Data Type 
This is selected from a drop down list. Data will be validated against the data type 
selected. 

Data Type Example 

String Any alphanumeric input (ABC123) 

Integer Any Integer (1,2,3) in the range -2 billion to +2 billion 

Long Any Integer (1,2,3) in the range -9 x 1018 to 9 x 1018. 

Single Any number (1.23, 2.2345) in the range -3 x 1038 to 3 x 1038. 

Double Any number (1.23, 2.2345) in the range -2 x 10308 to 2 x 10308. 

Date Date (01/01/2009) 

Boolean True or False values (0,1). Boolean fields will appear as a check box for users. 

Image Bit Maps, GIF and JPG images 

Currency Financial data (£1234.00) 

 
1. Data type date will accept dates in any format. Note that format may vary from 

country to country - the US displays dates in a different format (MM/DD/YYYY)  to 
the UK (DD/MM/YYYY). 

2. If data type Boolean is selected, the only permissible values for the default are 0 and 
1. No look up values should be entered. In the example below, a user can be 
designated as a permanent employee by clicking the checkbox.  

 

3. Data type Image is currently not enabled and has no effect. 
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Mandatory 
This specifies whether the data is mandatory (must be entered) or not. If this check box is 
ticked, the user will not be allowed to close the associated dialogue box (for example the 
Planogram Definition) until the data has been entered. 
Sequence 

This is the sequence the UDA's will be display in the dialogue box they are associated 
with. For example, assigning a UDA the sequence number of 3 means it will display 3rd 
in the list of UDA's.  
Default 
This specifies the default value that will appear when the dialogue box is first opened to 
enter UDA's. This can be left blank if no default is required. 
Lookups 

This field specifies values that may be selected from a drip down list. Values must be 
entered using a pipe (vertical bar) to separate them. An example would be A|B|C.  
If a look up is entered in this column, users can only select values from the look ups. If no 
value is entered, the user will have to manually enter data. In the example below 
Building Orientation, Ethnicity, Climate and Size are selected from look ups via drop 
down lists.  

 

 
   

Modifying User Defined Attributes 
Modifying UDA's in the Administration Module should be done with caution. They are 
normally configured on implementation and subsequent changes may cause problems. 
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1. Additional UDA's may be added in the Admin Module. Items in the database before 
the UDA was added will not have information associated with that UDA. 

2. If UDA's are edited or deleted this may cause problems within the database. 
Accordingly, UDA's should not be edited or deleted without advice as to the 
consequences. If it is necessary to edit or delete a UDA, it may be necessary to 
modify the database with SQL upgrade scripts. 

3. Modifying UDA's may also require changes to the Import Definitions in Data 
Importer.  

 
   

Data Importer 
Once UDA's have been set up in the Administration module, it is possible to populate 
them in one of two ways: 
1. Manually 
2. Via Data Importer. (See the Data Importer help file for more information). 

 

If it is decided to populate UDA's via Data Importer, it will be necessary to create a new 
import routine as UDA's are not included within the Standard Import. Each UDA has its 
own table within the database. These are: 

UDA Table Primary 
Key 

File AVTTB_FILE_UDA FIL_ID 

Fixture AVTTB_BLOCK_UDA BLK_ID 

Product AVTTB_PRODUCT_UDA PRD_ID 

Planogram AVTTB_PLANO_UDA POG_ID

Store AVTTB_STORE_UDA STR_ID 

User AVTTB_USER_UDA USR_ID 
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3 
Admin Planning 

Hatch Styles 

About Hatch styles 
The Hatch Styles Option allows users to set up Hatch Styles to indicate the dimensions 
of Zones, etc.  
These hatch styles can be customized in the Admin Module and are used in both the 
MSM Merchandiser Module and In-Store Space Collaboration. 
In Macro Space Management the hatch styles are predefined for the Planner Module, 
only the rotation and scale being variable. 
Hatch Styles can defined for use in In-Store Space Collaboration - and can only be 
configured for that application using the Macro Space Management Admin module.  
Hatch Styles in the Planner Module are based on the pre-configured hatch styles in 
AutoCAD. Changing Hatch Styles in Admin thus has no effect on this module. 
 

Hatch Styles Dialogue Box 
The Hatch Styles dialogue box gives brief details of the available styles. 
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The Menu Bar gives access to the drop down menus. 
The Toolbar gives access to many of the options available from the menus. 
The Style List lists the styles that have been defined. 
The Status Bar gives the total number of styles. 
Selecting the Add or Edit option from the toolbar will bring up the Add/Edit Hatch Style 
dialogue box.  
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This allows users to specify the pattern details to be used in Merchandiser and In-Store 
Space Collaboration. 
 
   

Overview of Configuring Hatch Styles for Merchandiser/In-Store Space Collaboration 
The data structure for a hatch pattern is very similar to an AutoCAD hatch pattern file 
(*.PAT): 
The hatch pattern is made up of one or more pattern lines. These pattern lines are 
repeated until they fill the area defined for hatching.  

 

 
Pattern lines can be specified to have a specific start point, length, gap between segments, 
and angle.  
Hatch patterns can be made up of multiple pattern lines. In the example below (coded 
red and blue for ease of understanding) two separate pattern lines have been combined 
to make a zigzag pattern. 
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Configuring Hatch Styles for Merchandiser and In-Store Space Collaboration 
To Add or Edit a Hatch style for Merchandiser, respectively click on the Add Hatch Style 
icon [outlined in red/left] , or highlight a hatch style and click on the Edit hatch style 
icon [outlined in red/right].  

 

This will bring up the Add (or Edit) Hatch Styles dialogue box. The settings to be 
configured are in the Merchandiser/In-Store Space Collaboration Representation frame. 
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Angle should be a numeric value between 0 and 360o. 
X Origin and Y Origin values can be positive or negative decimal numbers. They specify 
the offset relative to the 0,0 datum the Zone is drawn from. 
X Delta and Y Delta specify the spacings between the lines in the X and Y planes. Delta 
spacings are specified in the drawing units (normally inches or mm).  
X Delta is only meaningful for dashed lines and gives the offset for each successive line. 
In the example below, the left hand example has X Delta offset = 0, while the right hand 
example has X Delta offset = 1. (One line in each family of dashes has been highlighted in 
red to show the effect).  

 

Y Delta effects the vertical gap between the lines. The example on the left has a Y Delta 
offset = 1, while the example on the right has Y Delta offset = 2. 

 

Dash and Gap determine the length of each dash in a line, and the gap between them. Up 
to three dash lengths and gaps can be specified for each line.  
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In the example below the first unit has been coloured in blue, and the second in red.  

 

The dash and gap lengths are as follows: 
 

Dash 1 Gap 1 Dash 2 Gap 2 Dash 3 Gap 3 

1 1 2 0.5 1.5 0.5 

 
If the first dash and gap are not defined, then a continuous line will be drawn.  
Dash 2 and Gap 2 cannot be defined until Dash 1 and Gap 1 have been entered. 
Dash 3 and Gap 3 cannot be defined until Dash 2 and Gap 2 have been entered. 
 
   

Hatch Style Parameters for Merchandiser/In-Store Space Collaboration 

 

The Angle of the line is the angle measured anticlockwise from horizontal. Angles can 
take up any value between 0 and 360 degrees. 
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The X and Y origins are specified in terms of Cartesian coordinates. 
1. The Red dot has an X origin of 0 and a Y origin of 0. 
2. The Green dot has an X origin of 1 and a Y origin of 2. 
3. The Blue dot has an X origin of 3 and a Y origin of 1. 

 

The X and Y offsets are the distances between lines.  
1. The Green lines have a Y offset of 1.  
2. The Red lines have a Y offset of 2. 
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The Dash and Gap give respectively the length of a section of the line and the gap 
between the next part of the line. 
1. The Green Line has a Dash of 2 and a gap of 1. 
2. The Red Line has a Dash of 1 and a Gap of 1. 
 
   

Scales 

Overview of MSM Scales 
Scales potentially affect Text Styles and Symbols as they are inserted into a drawing in 
the Planner Module.  
There are two drawing environments in the Planner Module, Model Space and Paper 
Space. Users can toggle between the two using tabs at the bottom of the drawing. 

 

Model Space  
Model Space is where an object is designed in Planner. Objects can be drawn in 3 
dimensions in model space, and can be viewed at any degree of magnification.  



Scales 

Admin Planning 151 

Objects drawn in model space are always drawn at a 1:1 ratio; 1 unit in model space = 1 
unit of the chosen setting. For example, if the units in model space are inches, 1 unit = 1 
inch. Similarly, if the units in model space are centimeters, 1 unit = 1 cm. Users can zoom 
in or out to see the drawing at any scale. 
Paper Space  
Paper Space is where the drawing produced in model space is prepared for printing. 
Because a drawing in model space is always drawn at a 1:1 ratio, it will generally have to 
be scaled to get it to print within the limits of A2, A3 or A4 paper. For example 1 inch 
may represent 8 feet  (1:96) in the printed output. This enables an 11" x 7" section of paper 
to represent an 88 ft x 56 foot section of floor - adequate to represent an entire 
department. Using a yet smaller scale would enable an entire store to be represented. 
Scales 
Because of the scaling applied to get an object to print in paper space, some objects that 
may have been easily readable at a 1:1 ratio in model space may become very difficult to 
see when the drawing has been scaled for printing purposes in paper space. The Scales 
functionality allows users to automatically scale up the size of specific items when 
inserted into model space, so that when they are scaled back in paper space, they remain 
readable. 
For example, if it is known that the drawing will be plotted at 1" = 8ft (1:96) scale in paper 
space, it is possible to set the drawing scale to 1" = 8ft in model space. Text Styles (if the 
Scale option has been selected in the text style rules) and Symbols will then be scaled up 
by this factor. This means they will appear very large in model space. When scaled in 
paper space, they will effectively be drawn at a 1:1 size because the scaling up in model 
space will exactly counteract the scaling down in paper space. 
Overview of MSM Scales 

Scales are used for setting the scales used for annotative objects (Text styles, etc), so that 
they are readable when set up in viewports in Paper Space in Planner for printing out.  
 

Configuring Scales in Admin 
Scales can be configured using the Scales option on the Planning menu in the 
Administration module. this brings up the Scales dialogue box. 
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Scales can be added, edited or deleted using the option on the menu bar or toolbar. 
Refresh will update the Scales dialogue box with the latest information from the 
database: 
Imperial Units  

For imperial units the scales will depend on the base units of the drawing in 
Model Space. In the  table below, the results are based on inches.  
  
 

Units Scale Result in Model Space 

Inches 48 1 inch  is scaled to 4 feet. 

Inches 120 1 inch is scaled to10 feet 

Inches 240 1 inch  is scaled to 20 
feet. 

   
Metric Units  
Similarly, for metric units the scales will depend on the base units of the drawing 
in Model Space. In the  table below, the results are based on millimeters  
  
 

Units Scale Result in Model Space 

mm 100 1 mm is scaled to 10 cm. 

mm 500 1 mm is scaled to 50 cm 

mm 1000 1 mm is scaled to 1 
meter 
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Configuring Objects to be Scaled 
Scaling is applied to two types of objects: 
1. Symbols 
2. Text Styles 
In order for them to be scaled in the Planner environment, they must first be configured 
accordingly. 
Symbols 
Symbols are shapes like arrows, etc, that are used to indicate points of interest in a store 
plan.  

 

In order to designate an AutoCAD block as a symbol, the Symbol radio button must be 
selected in the Categories Tab of the Block Details dialogue box in Fixture Studio. Once 
an object has been designated as a Symbol, the Drawn 1:1 checkbox also has an effect: 
1. If left unchecked, the symbol will be drawn at 1:50 scale 
2. If checked, the symbol will be drawn at 1:1 scale - i.e. at the nominal size of the block. 

Note: Symbols are currently not scaling properly in the 
Planner module. 

Text Styles 
In order for a text style to scale when added into a Planner store plan, the Scale options 
must be checked in the Text Style rules dialogue box of Text Styles in the Admin Module. 
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1. If Scale (and Scale Offset) are left unchecked, the Text Style will be drawn at a 1:1 
scale 

2. If Scale (and Scale Offset) are checked, the Text Style will be drawn at the scale set in 
the Set Up dialogue box in the Planner module. More Information 

 

Using Scales in the Planner Module 
The Scales setting in the Admin Module is picked up in Planner via the Drawing Setup 
option in the Format pull down menu. 

 

This calls the Setup dialogue which allows the user to set the required scale for the 
drawing. The required scale must correspond to the scale it is intended to use in paper 
space. For example, if it is decided to plot at 1 in: 16 feet in paper space, the same scale 
should be selected in set up.  
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Symbols and specified Text Styles will then be scaled up by a factor of 192:1 when placed 
in model space, and scaled down by 1:192 when plotted at 1 in: 16ft in paper space. This 
enables the specified objects to be visible in the printed store plan. 
 

Text Styles 

Overview of Text Styles 

Overview 
Text Styles are used to annotate objects in the Planner environment. Different Text Styles 
can be defined and assigned to the varying classes of objects.  

 

In the above example, text styles have been defined so fixtures are annotated in black, 
planograms in red with the profiles (bays) numbered in blue. Products have been 
annotated in purple. The annotation has been defined so it does not overwrite itself. 
Text Styles can be assigned to all three types of Zone: 

  Department Zone 

  Internal Zone 

  Zone 
Text styles can also be assigned to: 

  Fixtures 

  Products 

  Planograms  
Both products and planograms can have different types of annotation associated with 
them. Products are often configured with one form of annotation for placeholders and 
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another form of annotation for products at SKU level. Multi bay planograms are often 
configured with both planogram details and the numbers of the profiles (bays). 
Text styles can be set to draw automatically when an object is placed in the drawing. 
Alternatively, text styles can be set so that they will only annotate specific objects in the 
drawing that have been selected by a user.  

Note: Manual annotation is controlled using the 'Annotate' 
option on the Retail toolbar in Planner. 

It is also possible to make text styles conditional so that they only apply in specific cases. 
This is done through changes in the custom SQL used to extract information used in the 
text styles.  
 
  

The Text Styles Admin Tool 
The Text Styles Admin Tool is used to display details of all available text styles. 

 

Options can be selected from the menu bar or from the toolbar. These include: 
Exiting from the Text Styles Admin Tool dialogue box 
Exiting from the Text Styles Admin Tool will not save any changes made since the last 
time the Save option was used.  
Saving changes to Text Styles back to the Database 

Note: changes to text styles will not be saved back to the 
database until the Save option has been used (toolbar icon or 
from the File menu). 

If there are no outstanding changes to be saved back to the database, the save icon will be 
grayed out. 
Adding a new Text Style 
Text styles can be added by selecting the 'Add Text Style' option from either the Edit 
menu or the toolbar. This will bring up the Text Styles dialogue box.  
Editing an Existing Text Style 

Existing text styles can be edited by highlighting the required style in the list of available 
styles and selecting the 'Edit Text Style' option from either the Edit menu or the toolbar. 
This will bring up the Text Styles dialogue box.  
Deleting an Existing Text Style 
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Text styles can be deleted by selecting the delete Text Style' option from either the Edit 
menu or the toolbar. System text styles cannot be deleted. (The 'System' attribute can only 
be set within the database). 
Before the text style can be deleted, confirmation will be required. 

 

Copying a Text Style 
Existing text styles can be copied by highlighting the required style in the list of available 
styles and selecting the 'Copy Text Style' option from either the Edit menu or the toolbar. 
This will bring up a Text Styles dialogue box containing a duplicate of the selected style. 
This duplicate can then be edited to produce a text style that is slightly different from the 
original. 
Refreshing from the Database 

The Refresh option (available from the toolbar or from the View Menu) updates the Text 
Styles Admin Tools dialogue box (and its associated dialogue boxes) with the 
information currently held in the database. Using the Refresh option will overwrite any 
changes made in Text Styles that have not yet been saved back to the database.  
If changes have been made to the Text Styles a warning message will be displayed. 

 

Text Style Wizard 
The Text Style Wizard provides an alternative to manually configuring a text style. Four 
screens take users through creating a text style and automatically create the SQL required 
to extract information from the database. 
 
   

Overview of Configuring Text Styles 
Text Styles are specific to Planner and are integrated with AutoCAD functionality. (A 
different form of annotation is used in the Merchandiser Module). 
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The Text Styles Admin Tool contains a list of the available text styles. Some of these text 
styles will be in use, others may be temporarily inactive. 

 

The list of text styles can be added to, selected for editing or deleted.  In addition, a Text 
Style Wizard can be used to simplify creating text styles.  
The Text Styles dialogue box allows the broad details of a text style to be configured.  

 

This includes the font type and color, AutoCAD layer, type of object the text is to be 
associated with, etc. Using Ctrl + A toggles the Text Styles dialogue box to show the 
custom SQL that extracts the information from the database used for the annotation. 
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The Text Style Rules dialogue box is used to configure the details of a text style. 
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It is possible to have multiple text style rules for a specific text style. When the annotation 
is drawn, each text style is 'tested' in sequence. The first text style that meets the 
requirements is used. For example text styles might be configured with text sizes of 6 
inches, 4 inches and 3 inches. Each text style will be tested in turn, until the largest text 
size that will allow all the text to be displayed is identified.  
 
    

Types of Text Styles 
It is possible to set up a variety of generic types of text styles. They can be selected from 
the Auto Placement options in the text styles dialogue box,  
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Alternatively, they can be selected from the third page of the Text Style wizard.  

 

Department Zone 
The Department Zone is one form of zone: specifically the Zone - Fixture Links ensure 
that Fixtures in the AVTTB_FIXTURE Table are only associated with a single department 
Internal Zone 

The Internal Zone is one of three types of zones. It denotes the maximum area of the store 
used for sales purposes.  
Zone 
The 'Zone' zone is a third type of Zone that gives an alternative to zones of type 'Internal 
Area' or 'Department'. 
Fixture 
This text style is used for fixtures. 
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Note: for fixtures to annotate, the 'Include Fixture 
Annotation' option must be checked in the Categories Tab of 
the Block Definitions dialogue box in Fixture studio. More 
Information 

Product SKU 
This text style is used for products that have been placed at SKU (Stock Keeping Unit) 
level from the product hierarchy 
Product Placeholder 
This text style is used for products that have been placed at Placeholder level (i.e. above 
SKU level) from the product hierarchy 
Planogram 

This text style is used to annotate planograms. Planogram information can sometimes 
include profile annotation - information on specific bays within a multi-bay planogram. 
General 
This text style is not yet implemented. 
 
    

Turning on Fixture Annotation 
Whether Fixture Annotation for a specific fixture (or fitting) displays in Planner depends 
on settings in Fixture Studio. 
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For a specific fixture to annotate in Planner, the Include in Fixture Annotation option 
must be checked. 
This allows flexibility in what gets annotated. One option is to specify all fixtures will 
annotate, but that fitting will not. This simplifies the annotation for gondola runs contain 
a mixture of fixtures and fittings.  

Note: the Auto Placement option (set in the Text Styles 
dialogue box) determines whether fixture annotation for 
fixtures that have had the 'Include in Fixture Annotation' 
check box ticked is placed automatically, or has to be drawn 
as a result of a command from a user. 

 
   

Annotation in Planner 
Annotation in Planner is first determined by the Auto Placement settings in the Text 
Styles dialogue box in the Admin Module. 
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1. If a Text Style has an Auto Placement option selected,  (for example Planogram), then 
when that type of object is placed, the annotation will automatically be added.  

2. If a Text Style has Auto Placement option set to 'None', then when that type of object 
is placed, no annotation will automatically be added. (It can subsequently be 
manually added by a user). 

The Retail Toolbar within Planner is used gives three options to annotate objects in the 
drawing   

 

1. Annotate Fixtures will cause fixture annotation to be drawn according to the text 
style rules currently active in Planner 

2. Annotate Products will cause product and planogram annotation to be drawn 
according to the text style rules currently active in Planner 

3. Annotate allows the text style rules currently active in Planner to be updated from 
the database. It also allows objects to be manually annotated when Auto Placement 
has been set to None in Text styles in the Admin Module. 

Note: the text style rules active in planner are those present 
when the application was opened, or when text style rules 
were last refreshed using the Annotate dialogue box. 

Annotate Fixtures 
If the Auto Placement option is set to 'Fixtures', fixtures will be re-annotated with the 
currently active text style(s). 
Annotate Products 
If the Auto Placement options are set to 'Products' or 'Planograms', merchandise will be 
re-annotated with the currently active text style(s). 
Annotate 
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The Annotation dialogue box gives more control over what annotation is displayed in the 
drawing. 

 

The Refresh Button will update all text styles currently held in Planner with the latest 
version held in the database.  

Note: this would be applicable if an Administrator is 
updating text styles in the Administration Module and 
simultaneously testing the effects of the changes in the 
Planner Module. 

The Annotation dialogue box contains a list of text styles. Any individual text style can 
be selected by highlighting it.  
1. If the OK button is clicked, all instances of annotation associated with that text style 

in the drawing will be updated. 
2. If the Select button is clicked, the user will be taken to the drawing. Objects can then 

be selected using standard AutoCAD selection methods On completing the selection 
sequence with a tight click, all selected objects will have their annotation updated. 

Using Multiple Text Styles for a Specific Object 
It is possible to use multiple text styles to annotate a specific type of object. 
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In the above example of the Annotation dialogue box there are four text styles for 
planograms: 
1. Basic Planogram Details 
2. Clothing Planogram Details 
3. Electrical Planogram Details 
4. Food and Drink Planogram Details 
If the Auto Placement option in the Text Styles dialogue box is set to 'None', then 
planograms will not be annotated on insertion. It is then possible to highlight a text rule 
and select the planograms to be annotated. Working in this way, it is possible to annotate 
Food and drink planograms in a completely different style to clothing planograms. 
 
   

Text Style Placement Logic 
The Logic of Text Style placement is as follows: 
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1. When a text style is placed, the software checks to see whether Auto Placement is on. 
2. If Auto Placement is On, the annotation will be added when the object is inserted. 
3. If Auto Placement is set to 'None', the object will be placed in the drawing but 

annotation will not be drawn during insertion. 
4. Annotation can be added or updated manually by the user by means of the 

Annotation option in the Retail toolbar in Planner. 
5. When annotation is added, the software checks to see if there are multiple text style 

rules.  
6. If there is only a single text style rule the annotation is placed immediately. 
7. If there are multiple text styles rules, the text styles rules are tested in sequence. As 

soon as a text style rule passes, the annotation is placed.  
 
   

Text Styles and Custom SQL 
The Text Style Wizard can be used to generate the Custom SQL statement used to 
retrieve the information used in annotation. This Custom SQL can then be seen in the 
Text Style dialogue box. (Use Ctrl + A top reveal it). 
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It is possible to modify this Custom SQL statement to customize the annotation for each 
type of object being annotated. For example fixtures that are children of the 'Racking' 
node in the Fixture Hierarchy could have different annotation from fixtures that are 
children of the 'Fittings' node in the Fixture Hierarchy. 
When fixtures are annotated, all text styles of type 'Fixture' will be applied, but specific 
fixtures will only be annotated if they meet the conditions set out in the Custom SQL - 
one type of annotation will be applied if the item of equipment is determined to be 
'Racking' and another if it is determined to be a 'Fitting'.     
 
   

The Text Style Wizard 

Overview 
The Text Style Wizard provides an alternative way to manually configuring a text style. 
It consists of a series of four screens that the user moves through in sequence.  
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Once the screens have been completed, a Text Style will have been configured.  
 
   

Text Style Wizard - First Page 
The First Page of the Text Style Wizard is used to select whether the user wished to 
create a new Text Style or overwrite (edit) an existing one. 

 

To overwrite an existing rule it must be highlighted in the main Text Styles Admin Tool 
Window before the Wizard is invoked. 
Click on Next > to move to the next stage. 
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Text Style Wizard - Second Page 
The Second Page of the Text Style Wizard is used to input the name and description 
(type) of the Text Style. 

 

Enter the Text Style Name and Description as required.  
Click on Next > to move to the next stage. 
 
    

Text Style Wizard - Third Page 
The Third Page of the Text Style Wizard is used to specify the type of Macro Space 
Management feature the Text Style is to be associated with.  
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Select the required type of Text style. This is done by means of a radio button, so only 
one type of Text Style can be selected at one time. If a Text Style already exists a warning 
dialogue will appear.  

 

It is not possible to have a second version of the same Text Style, so if it is desired to 
change this Text style it must be edited. 
Click on Next > to move to the next stage. 
 
   

Text Style Wizard - Final Page 
The Fourth (and last) Page of the Text Style Wizard is used to set the characteristics of 
the Text style. 
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The Font can be set from a drop down list of available fonts. 
The Font Color can be set by clicking on the color button and selecting the required color 
from the pallet. 
The Font Size can be set using the spin controls.  
Bold or Italic fonts can be selected by ticking the relevant check boxes. 
The Layer determines what AutoCAD layer the annotation is to be placed on. 
The Text that will be displayed can be selected by ticking the appropriate check boxes. 
The items of text that can be displayed will vary with the type of text style selected in the 
previous screen. For example, the Zone Text Style will have a different set of options to 
the Planogram Text style.  

Note: Checking the list of items in the Text Box causes a 
custom SQL statement to be generated. This extracts 
information from the central Macro Space Management 
database and annotates Zones, Fixtures or Merchandise 
accordingly.   

Click on Finish to add the Text style to those available.  
 
   

The Text Styles Dialogue Box 

Overview 
The Text Styles dialogue box allows the basic rules of Text Styles to be configured. Using 
Ctrl + A toggles between two different views in the right hand pane. One view gives a 
list of the available Text Style rules for that Text Style. The other view shows the custom 
SQL used to extract information from the database to be used in the text styles. 
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The Style Options Frame 
The Style Options frame allows  
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Style Name is the name assigned to a text style. 
Style Description allows a longer, more comprehensive description to be associated with 
the Style Name  
Layer Alias specifies which AutoCAD layer the annotation is placed on. It is selected 
from a drop down list of the layers that make up the AutoCAD store plan on the Planner 
module. (The store plan can be regards as being made up of all the objects on all the 
layers in the drawing. AutoCAD provides ways to control objects on the individual 
layers, for example by turning their visibility on or off). 

 

In the above example, when fixtures are placed, they would be placed on the Fixtures 
layer. If the fixtures are annotated, the text would go on the Fixture Text Layer - 
similarly, if bay numbering is added, it would go on the Bay Numbering layer. 
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So, although the above example looks like a single entity, it is made up of three separate 
layers. 
Auto Placement allows the user to specify whether annotation will be added 
automatically on inserting an object into the Planner environment, or whether the user 
will have to manually initiate annotation. There are a series of options: 

Option Description 

None Setting a text style to 'None' disables automatic annotation of objects when 
they are added in the planner environment. Annotation can be added 
manually via the Annotation dialogue box at user discretion. More 
Information  

Department Zone Associates the text style with zones of type 'Department Zone' - see Zone 
Types option from Planning menu. 

Internal Zone Associates the text style with zones of type 'Internal Area' - see Zone Types 
option from Planning menu. 

Zone Associates the text style with zones of type  'Zone' - see Zone Types option 
from Planning menu. 

Fixture Associates the text style with fixtures 

Product SKU Associates the text style with products placed as SKU level 

Produce 
Placeholder 

Associates the text style with products placed as placeholders (above SKU 
level)  

Planogram Associates the text style with planograms 

 
Multi-Profile Offset is used when two or more instances of the same annotation are 
associated with an object. An example would be if two products were placed onto a 
fixture. Each product would have separate annotation.  

 

In the above example, bacon and fresh milk have been placed on a fixture. In the left 
hand image, no offset has been used and the text has overwritten itself. In the right hand 
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image, an multi profile offset has been applied and the text appears without overwriting 
itself. 

Note: this will not work if Word Wrap has been selected in 
the Fit Within frame of the Text Style Rules dialogue box. 
Because the word wrap fixture puts text onto multiple lines, 
the second line of the first product to be placed will be 
overwritten by the first line of the second line to be placed. 

Scale Offset 
The Scale Offset checkbox is used in conjunction with Multi Profile Offsets. It is 
applicable when a scale has been applied to the drawing (Format > Drawing set up in the 
Planner module. 
Font can be selected from a drop down list. 
Color refers to the color of any text. It can be selected from a standard color pallet. 
Dimension Color refers to the color of any dimension and extension lines. These can be 
set to be different from the text. Dimension color can be selected from a standard color 
pallet. 
The Bold and Italic check boxes result in the text font being changed to bold or italic as 
required. 
Bring Text to Front results in the text overwriting any objects that are present in the 
drawing. For example, it there is a fixture present where the text is to be written, the 
annotation will be placed on top of the fixture. (If Bring Text to Font is not selected, the 
text might be obscured by the fixture).  
Keep Parallel is used when fixtures are not in a straight line. It will only apply if the 
Keep Separate Text check box is not checked. It will draw the annotation parallel to the 
average direction of the fixtures. 

 

Note: this functionality is not fully implemented. 

Keep Separate Text is used when a run of adjacent objects are similar. An example 
would be if three adjacent fixtures contain identical products. 
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In the above examples, if Keep Separate Text is not checked, objects that are similar and 
adjacent will be annotated as a single item. If Keep Separate Text is checked, then each 
item will be annotated separately, even if they are adjacent. 
 
   

The Text Style Rules Frame 
The Text Style Rules frame allows users to configure a number of text style rules for a 
given text style. When adding annotation based on that text style, each rule will be tested 
in turn and the first rule that complies will be applied. (Using Ctrl + A will toggle to the 
SQL frame). 

 

In the example above, the two test style rules are based on text size. The annotation first 
tries to use text of 6 inch size. If that will not fit into the existing space, the text size is 
reduced to three inches. 
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In the above example, the annotation for the product placed on the left (Tea) will fit into 
the available space using 6" high letters. The annotation for the product placed on the 
right (Juice) is too long to fit into the available space using 6" high letters, so the software 
applies the next rule - which is to apply 3" letters. 
(For information on how to configure Text style rules, see the section on the Text Style 
Rules dialogue box). 
The toolbar options are as follows: 
 
 

Option Description 

 

Add Text Style Rule 

 

Edit Text style Rule 

 

Delete Text Style Rule 

 

Copy Text Style Rule 

 
Move selected item up 
in list 

 
Move selected item 
down in list 

 
   

The SQL Frame 
The SQL frame is toggled into view by means of Ctrl + A. 
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The SQL can be derived from one of two sources: 
1. It can be produced using the Wizard. 
2. It can be input directly. 

Note: Direct Input of SQL is not recommended unless the 
user has good SQL skills and is familiar with the Macro 
Space Management database. also note that the SQL contains 
custom additions such as {FIL_ID} and {IDS}. (More Info)  

The SQL is used to select information from the database. Which information is displayed 
in the annotation is determined by settings in the Options frame of the Text Style Rules 
dialogue box. (The required options have to be toggled into view using Ctrl + A). 

 

The Field Index specifies the items of data required. 
The Field Separator determines the character use to separate items of data. 

Note: the Fix ID and AutoCAD are used to identify specific 
objects. The selectable items of data start after these items. In 
the above example, the first item that can be selected is 
BLK_NAME (Block Name). 
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The Text Style Rules Dialogue Box 

Overview 
The Text Style Rules dialogue box is used to configure the details of specific Text Style 
rules. 

 

The Options frame allows users to specify the appearance of the text that appears. 
The Fit Within frame allows users to specify what happens if the text is too long relative 
to the length of the fixture. 
The Use Dimensions frame allows users to specify whether dimension and extension 
lines are used when annotating the object. 
The Position frame details with how text is justified. 
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The Options Frame 
The Options frame  

 

Size is the size used for the text that annotates objects. If an imperial size, the value is in 
inches, if a metric size, the value is in millimeters. 
Width Factor determines the ratio of width to height of the text. Values of less than 1 
result in the width being reduced relative to the height. Values of greater than one result 
in the width being increased relative to the height. Width Factors may be set within a 
range of 0.5 - 1.5. 

 

In the example on the left, the width factor has been set to 0.5. In the example on the 
right, the width factor has been set to 1.5.  
Line Spacing determines the spacing between successive lines of text if word wrap (Fit 
Within options) is on. 
Scale and Scale Offset are used when an AutoCAD drawing has been given a scale via 
the Format > Drawing Set Up option in the Planner module. 
If Scale and Scale Offset are selected and the drawing has been assigned a scale, the text 
and dimension arrows will be scaled up relative to the scale of the drawing, so they stay 
at a standard size. For example, if the drawing is at a 1:100 scale, text will be scaled up 
100 times, so it draws at an absolute size. 
If Scale and Scale Offset are not selected, the text and dimension arrows will draw at the 
scale of the drawing. For example, if the drawing is at a 1:100 scale, text will be drawn at 
a hundredth of its absolute size. 

Note: scaling does not fully work at present. 

Field Index can be accessed by means of Ctrl + A. It allows the user to select the items 
that will be displayed from the SQL statement for a specific text style in the Text Style 
GUI. 
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The SQL is revealed by highlighting a text style, and selecting CTRL + A. The SQL 
statement is in the form of a 'Select' statement that identifies specific items of data from 
the database. The first two items in the statement are the ID of the object in the MSM 
database and the AutoCAD handle (ID). Any further items can be selected by entering a 
number giving its position in the SQL statement (after the Block and AutoCAD ID's). 
Successive values can be separated by a comma. In the example below, the description, 
length and with have been selected. 

 

The Field Separator is also accessed by means of Ctrl + A. It can be selected by means of 
a drop down list. 
In the example below, the block description, length and depth have been selected and a 
separated by a '/'.  
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The Fit Within Frame 
The Fit Within options control how text appears if the selected text is too long to fit on a 
single line. Rotate Vertically (accessed by Ctrl + A) can be selected by means of a check 
box, the other four options are selected by mans of a radio button. 

 

Rotate Vertically is normally hidden, but can be accessed by use of Ctrl + A. If text is too 
long to be written horizontally relative to the fixture, it will be rotated through 90 o so 
that it can be written vertically relative to the fixture. 

Note: Rotate Vertically is not functioning correctly at 
present. 

Selecting None results in no text being displayed if the text is too long for the available 
space. 

Note: None is not functioning correctly at present. 

Selecting Abbreviate results in a shortened version of the text string being displayed. 

 

Selecting Truncate results in the text string being truncated to fit 
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Selecting Word Wrap results in the description being wrapped onto several lines. 

 

 
   

The Dimensions Frame 
The Dimensions frame is used to specify how dimension and extension lines appear.  

Note: Dimension and extension lines are not available for all 
three types of zone annotation. 

 

The Use Dimensions check box can be used to toggle dimension lines On or Off in their 
entirety. 
The Dimension Lines checkbox will toggle dimension lines on or off. 
The Extension Lines checkbox will toggle extension lines on or off. 
The Arrows checkbox will toggle the arrow head display on or off. 
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The Arrow Size can be set by means of the spin control. 
The Arrow Type can be selected from the drop down list. 
 
   

The Position Frame 
Relative Position, Justification and Offsets determine  how text places relative to the 
fixture.  
Relative Position determines where the text starts within the fixture - each button in the 
position frame corresponds to a specific point within a fixture.  

 

Justification determines how the text positions in relation to the Relative Position. It is 
designed to operate in a similar way to the equivalent AutoCAD functionality. In the 
example below, the text is top justified in relation to the Relative Position.  
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In the example below, the text is left justified in relation to the Relative Position.  

 

The advantage of this means of operation is that it is possible to position text outside of 
the parent object. 
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Finally, it is possible to use the X Offset and Y Offset to fine tune the position of the text.  
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For example if different offsets are specified for fixture and product information, it will 
be possible to avoid these two types of annotation overwriting each other. 
 

Title Blocks 

Overview 
Title Blocks are used to put a frame round a drawing in preparation for printing it. Title 
Blocks can also contain information on the drawing.  
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The Title Block is an AutoCAD DWG file that overlays the store plan on model space. It 
contains information on the drawing and one or more viewports to display the drawing.  
The Viewport is a specified area within the Title block where the drawing appears. 
Viewports can be set to precise scales. 
The Title Block Information is a specific part of the Title Block. It contains fields that 
populate with data about the drawing. In the above example the fields include the store 
name and store code. The data to populate these fields is read from two sources: 
1. From information imbedded into the drawing by the software 
2. From the database by using custom SQL   
Each Title Block is designed for a specific size of paper, so if drawings are to be printed 
off in a range of sizes, title blocks should be created for each size. A metric 
implementation of Macro Space Management may contain title blocks for A0, A1, A2, A3 
and A4 size paper, while and imperial one may contain title blocks for ANSI A, ANSI B, 
ANSI C, ANSI D  and ANSI E size paper. 
 

Overview of Creating Title Blocks 
Title Blocks are created using the following sequence of actions. 
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Preparation 
There are two actions required to prepare for the use of Title Blocks: 
1. Ensure Canonical Media is Correct 
Canonical Media are the range of paper sizes recognized by AutoCAD for printing 
purposes. They typically need to be installed once immediately after installing the 
software. 
2. Create Custom SQL to Extract Information 

It is possible to populate the fields in the title block with information extracted from the 
database. The information must be extracted from the database with a Custom SQL 
statement that is stored in the AVTTB_CUSTOM_SQL database. 
Implementation 
1. Creating Title Block in Planner Module 
The initial stage to creating a Title Block is to draw it in the Planner Module. All 
information that will automatically added must have an Attribute Definition assigned. 
When the Title Block has been drawn, it is turned into a block with the 'block' command, 
and then written to an appropriate directory in the MSM directory structure with the 
'WBlock' command.   
2. Registering the Title Block in Fixture Studio 
Once a Title block has been created in the Planner Module, the next stage is to create the 
appropriate entry (registering) in Fixture Studio. This ensures that the title block will be 
available for the functionality that references it, be drawn on the right layer, be drawn at 
the correct size, etc. 
3. Adding Title Block Information in the Admin Module 
Once the Title Block has been registered in Fixture studio, the final stage is to enter 
details of the title block in the Admin Module. This enables users to specify the 
description of the Title Block, size of view ports, etc. 
Use 
Once the Title block has been implemented, it can be used in the Planner Module by the 
Add Title Block command on the Insert Menu. It can be updated using the Insert Title 
Block command on the Insert Menu. 
 

Canonical Media 
Canonical Media are the range of paper sizes recognized by AutoCAD for printing 
purposes. They typically need to be installed once immediately after installing the 
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software. To add (or update) the list, open the Planner module and type vbarun into the 
command line. 

 

This will bring up the Macros dialogue box.  

 

Select C:\Program Files\Oracle 
Retail\MSM\2007\acad.dvb!ThisDrawing.RFV5CanonicalMedia and click Run. The 
software will detect all printers the user's computer is connected to (including network 
printers) and generate a list of all paper sizes recognized by those printers.  
This command only needs to be run once, and then the user's computer will be set up to 
print drawings and their associated title blocks on those printers. 
 

Custom SQL 
Custom SQL is used to populate anything other than the default Attribute Names. The 
Custom SQL for Title Blocks is stored in the AVTTB_CUSTOM_SQL table with a CSQ_ID 
of 69. Only one set of Custom SQL can be used for title blocks. There are three points of 
interest in the simple example below: 
1. Qualifying the Select Statement 
2. Use of Column Alias 
3. Marker 
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Qualifying the Select Statement 
Sometime the select statement has to be qualified to get the data to display in the most 
appropriate format. Here, the Truncate command has been used to remove the hours and 
minutes from the date before it is displayed. 
Use of Column Alias 

The Column Alias matches the Attribute Definition it is wished to populate in the Title 
Block. In the above example, the Publish Date for the file will be displayed using the 
attribute definition PUB_DATE. The Column Alias has been set to be the same. When the 
Title block is Added or Updated the code will match up the Attribute Definition and the 
Column Alias and populate the Title Block with the specified information.  

Note: the Attribute Definition and the Column Alias must be 
an exact match. Misspelling of one or the other will result in 
the Title Block not populating. 

Markers 

Markers are column names from MSM database tables enclosed in curly brackets: 
{FIL_ID}. This part of the Custom SQL is specific to Macro Space Management. In a 
normal SQL statement the 'where' clause might be something like FIL_ID = 1234. Here, 
the Title Block is going to populate with information relative to the active drawing in 
Planner. The FIL_ID (File ID) is one of the items of information 'stamped' into the active 
drawing. The where FIL_ID = {FIL_ID} clause allows the code to identify the FIL_ID of 
the currently active drawing and filter the information derived from the SQL statement 
accordingly.  

Note: without using the Marker {FIL_ID} as a filter, the SQL 
statement would have returned all Publish Dates for all files 
recorded in the AVTTB_FILE directory.  

 

Creating the Title Block in Planner 
Creating the Title Block in the Planner Module requires a series of actions to be carried 
out. 

 

1. Establishing Required Dimensions 

Title Block Size has to take into account the printable area on the selected paper size. For 
example, A3 paper is 297 x 420 mm. However, printers (and plotters) cannot make use of 
all that area and a border (called the non-printable area) that cannot contain any lines or 
text exists around the edges of the paper.  
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The size of the title block needs to take into account the non-printable area. For example, 
if A3 paper is used, and the non-printable area is 6 mm wide, then the title block needs to 
be drawn at 285 x 408 mm to fit exactly into the printable area of the paper. The insertion 
point of the title block is normally set at 0,0 as 0,0 in the paper space layout is defined as 
the lower left corner of the printable area. 

Note: the size of the printable area is printer/plotter specific. 
It is helpful to allow a small margin for these differences. 

2. Draw Frame and Text Boxes 
After the size has been established a frame can be drawn in planner, and text boxes 
added.  

 

The Title block is usually drawn with the origin at 0,0.  
3. Add Attribute Definitions 
Attribute Definitions are used to set up the 'template' Attributes for the text boxes. They 
are invoked by typing the ATTDEF command into the AutoCAD command line in 
Planner. 

 

This will bring up the Attribute Definition dialogue box. 
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The Attribute Definitions can then be put into the drawing. 

 

Attribute Tags should always be continuous text. If necessary, join two words with an 
underscore: WORD1_WORD2. 
The Attribute Tags should either match the names of the data 'stamped' into the drawing 
(More Info) or the Column Aliases in the Custom SQL (More Info). 
4. Turn into Block 

The Title Block can then be turned into a block with the 'block' command. This can either 
be initiated from the Draw toolbar, or from the command line.  
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The individual components of the Title Block will then be combined to make a single 
object. This block definition is stored in the current drawing and is not yet globally 
available.  
5. Write Block (Wblock) to Make Externally Available 
The Write Block (WBlock) command is used to write the block definition to an external 
directory where it can be used in any Macro Space Management drawing. The command 
is invoked by typing WBLOCK into the command line. 
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The destination should be a directory specified in the Directories Tab of the 
Configuration Module.   
 

Data Taken From The Drawing 
Data is imbedded into a drawing when a drawing is created. This data is used for a 
number of purposes by Macro Space Management. One of these purposes is to populate 
the Attribute Definitions in Title Blocks. The data 'stamped' into a drawing has specific 
names assigned. If these match the name of an Attribute Definition in a Title Block, the 
information will be written into the Title Block on insertion into the drawing.   
STORECODE 
Store Code brings in the Store Code specified in the Add/Edit Store dialogue box in 
Store Manager. 
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STORE 
Store brings in the Store Name specified in the Add/Edit Store dialogue box in Store 
Manager.  

      

REVISION 

Revision brings in the Revision Description specified in the Add/Edit Revision dialogue 
box in Store Manager.    
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FLOORCODE 

Floor Code brings in the FLT_NAME (a numerical value) from the AVTTB_FLOORTYPE 
table that is associated with the corresponding Floor Type   specified in the Add/Edit 
Floor dialogue box in Store Manager.  

   

Note: FLOORCODE is currently not working correctly. If it 
is desired to add this information to a Title Block, it should 
be done using custom SQL and a slightly modified attribute 
name. 

FLOOR 

Floor brings in the Revision Description specified in the Add/Edit Floor dialogue box in 
Store Manager.    
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Note: FLOOR is currently not working correctly. If it is 
desired to add this information to a Title Block, it should be 
done using custom SQL and a slightly modified attribute 
name. 

SCALE 
Scale brings in the scale set in the Drawing Setup option of the Format menu in Planner.  

 

DATE 

Date brings in the date that the title block was generated or updated on.  
DWGNAME 

Drawing name brings in the name of the AutoCAD DWG file as specified on the Details 
Tab of the File Properties dialogue box in Store Manager. 
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FULLFILENAME 
File Full Name brings in the name and path to the file specified in the Location text box 
of the Details Tab of the File Properties dialogue box in Store Manager. 

 

The full file name can be long; for example:  
\\qa2k10g\clientdata\Standard\RF_Data\Stores_Root\Example Store\Level 
2\Revision 1\Example Drawing.dwg  
If the FULLFILENAME attribute definition is used, this length should be taken into 
account when defining the attribute. 
 

Registering the Title Block in Fixture Studio 
Registering the Title Block in Fixture Studio requires the following steps. 
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1. Selecting the Parent Fixture Group 

All blocks within Fixture Studio are arranged within a hierarchy. The default hierarchy 
contains a Fixture Group called Title Blocks. This is the usual location for title blocks.  

 

2. Create a Block and Enter the Block Name 
Create a block by invoking the Add Block option from the Edit menu or the toolbar. This 
will bring up the New block name dialogue box.   

 

Ensure that the block name entered exactly matches the block name specified in the 
WBlock command used in planner. On clicking OK, the Block Details dialogue box will 
appear for editing. 
3. Enter Settings in the Block Details Dialogue Box 

The Block Details dialogue box allows custom properties to be assigned to the title block. 
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Full details of how to use this dialogue box can be found in the Fixture Studio help file. 
The principal settings pertinent to title blocks are: 
Category Tab 

1. Set the Retail Type to Title Block. 
2. Set the Directory to match that specified in the WBlock command when the block 

was saved in Planner. 
3. Set the Units as appropriate. 
4. Set the Icon to Title Block.  
Insertion Tab 
1. Set the Layer to Other > TITLEBLOCK. 
2. Level can be left as 'Undefined'. 
Size Tab 
1. The Sizes should be set as appropriate. 
2. Height can be left as 0.00001 - this nominal value is to avoid 'divide by zero' errors in 

the code. 
 

Adding Title Block Information in the Admin Module 
Adding Title Block Information in the Admin Module is in two stages: 
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1. Specifying Title Block Details 

Title Blocks are Added, Edited or Deleted using the Title Blocks option from the Planning 
menu. This will bring up the Title Blocks dialogue box.   

 

Name is the nominal name of the title block.  
Blockname is the name of the block for the title. It can be selected from a drop down list. 
this list contains the name of all blocks of type 'Title Block' is Fixture Studio. 
Width is the nominal with of the paper the title block is designed for. It is for display 
purposes only 
Height is the nominal height of the paper the title block is designed for. It is for display 
purposes only. 
Width Offset is the offset of the insertion point of the title block in the 'X' plane relative 
to the lower left corner of the printable area on the paper the title block is designed for. 
Height Offset is the offset of the insertion point of the title block in the 'Y' plane relative 
to the lower left corner of the printable area on the paper the title block is designed for. 
Default Scale is the default scale that will be applied to the viewports when they are first 
defined in the Title Block dialogue box. 
Note: this option is currently not setting the default in the Title Block dialogue box. 
Canonical Media is selected from a drop down list. It should be set to the size of paper 
the title block is designed for. 

Note: Any entries will only be added when the [Return] key 
is pressed. 

Title Blocks can be added or deleted using the appropriate options on the Edit menu or 
the toolbar. Selecting the edit option on the edit menu or the toolbar will bring up the 
Title Block dialogue box. 
2. Specifying Viewport Details 
The Title Block dialogue box is used to specify the details of the viewports in the Title 
Block. It is invoked by the edit option in the Title Blocks dialogue box.  
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The information to the left of the dialogue box mirrors that of the Title Blocks dialogue 
box. The information on the right of the dialogue box is used to set up viewports. Title 
blocks may have multiple viewports. 
Width is the dimension of the viewport in the 'X' plane. 
Height is the dimension of the viewport in the 'Y' plane. 
Width Offset is the offset of the viewport in the 'X' plane relative to the insertion point of 
the title block. 
Height Offset is the offset of the viewport in the 'Y' plane relative to the insertion point 
of the title block. 
Scale is the scaling factor applied to the viewport. 

Note: Scaling is not working correctly at present. 

View is the direction the drawing will be presented in the viewport. Options include 
Plan and a number of isometric projection directions. 

Note: View is not working correctly at present. 

Note: Any entries will only be added when the [Return] key 
is pressed. 

 

Deleting Title Blocks from Macro Space Management 
Deleting Title Blocks from Macro Space Management takes place in three stages: 

 

1. Delete Title Block Definition from Admin Module 
To delete the Title Block definition from the Admin Module: 

a. Select the Title Block in the Title Blocks dialogue box. 
b. Highlight the required Title Block and select Edit. This will open the Title Block 

dialogue box. 
c. Delete any viewports associated with the Title Block. 
d. Close the Title Block dialogue box. 
e. Delete the Title block from the Title Blocks dialogue box.  
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2. Delete Title Block from Fixture Studio 
To mark the Title Block for deletion from Fixture Studio: 

a. Highlight the Title Block in the Fixture Hierarchy. 
b. Select Delete Block from the right click menu - the block name will change from 

black text to grey. 
c. Save the changes (Save Option) so that the 'delete' flag is set in the database. 

Note: the Title Block has not been deleted at this stage - it 
has merely been marked for deletion. 

3. Purge Title Block in the Admin Module 

To permanently delete the Title block from the MSM database: 
Select the Purge option from the Tools menu. 
Select the Fixtures checkbox and click OK. 

Note: this will delete the information from the database. 
However, the block will not be deleted from the directory it 
is stored in. This is because the block might be referenced by 
other software.  

 

Placing Title Blocks in Planner 
To place Title Blocks in Planner, select the Add Title Blocks option from the Insert menu. 

 

This will bring up the Title Blocks dialogue box. 
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The list of available Title Blocks is that specified in the Administration Module. 
To place a Title Block, highlight it in the list then click OK. 

 

 

Modifying Title Blocks in Planner 
When designing a Title Block, it is sometimes necessary to place the Title Block in a 
Planner drawing and subsequently modify it so correct minor flaws in the design. Once 
the modified Title Block DWG file has been saved, actions are necessary in Planner to 
ensure that the modified Title Block displays - and not the original version. The two 
options are:  
1. Removing Title Blocks, Purging and Reinserting Title Blocks 
2. Restructuring the Drawing and Updating the Title Blocks 
1. Removing Title Blocks, Purging and Reinserting Title Blocks 
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Where there are only a few instances of a title block present in a drawing, it is possible to 
manually delete them, purge instances from the drawing and reinsert the updated title 
block.  
Purging is necessary if a title block that has previously been used in a specific drawing in 
the Planner Module. AutoCAD stores a copy of the block definition in the drawing when 
the block definition is first used. All subsequent insertions of that block will be copies of 
the stored block definition. In order for the modified Title block to take effect, the old 
definition must first be removed from the drawing. This can be done by using the Purge 
option from the  File > Drawing Utilities menu. Alternatively, it can be invoked by typing 
PURGE into the command line. 

 

If all active instances of the Title Block has been removed from the drawing, it will be 
possible to select the definition and purge it. The modified title block can then be added 
as required using the Add Title Block option from the Insert menu in Planner. 
2. Restructuring the Drawing and Updating the Title Blocks 

Restructuring the Drawing updates blocks in the drawing with any later versions held in 
the database. Restructure Drawing is invoked from the Restructure > Blocks menu in 
Planner. 
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Selecting Redefine blocks from Disc will result in the DWG file specifying the title block 
being update (providing it has first been selected). Using the Select by Block option and 
selecting the title block will ensure that only the title block is updated. 
Once the Title block has been redefined, the attributes it contains should be updated by 
the Update Title Block option on the Insert Menu in Planner. 
 

Editing Attributes 
Editing Attributes once the title block has been placed in a drawing can be achieved by 
double clicking on the frame of the Title Block. This will bring up the Enhanced Attribute 
Editor. 
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This allows any of the Attribute values to be edited. 
 

Zone Types & Definitions 

Purposes of Zones 
Zones are ways of dividing up a store into areas of specific purpose.  

Note: Zones are sometimes called Departments. This should 
not be confused with Zone Types of Type 'Department' 
which have a specific purpose in MSM. 
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Once placed, Zones can be used for measuring, reporting and filtering purposes. 
Measuring Area 

Once placed, the area of the zone can be calculated. This can be: 
1. Gross Area - the area of the zone without taking into account any obstructions 
2. Net Area -The area of the zone after obstructions (such as pillars and staircases) are 

taken into account 
These areas can subsequently be used for calculation purposes - for example determining 
the profit per square foot or meter.  
Reporting  
Once fixtures and merchandise are placed in a store plan, Zones can be used to get 
reports on the performance of specific parts of the store. For example, it is possible to find 
the sales turnover, sales margins, profitability, etc, for any zone.  
If there is a hierarchy of zones present in the store, it is possible to get reports of differing 
levels of detail. For example, it would be possible to get reports on the Clothing 
department or just one of its sub-departments - say Children's Clothing. 
Filtering 
Zones can be used for filtering purposes - primarily in the Object Grid. It is possible to 
associate either products or planograms with specific zones - when a zone is selected in 
the Object Browser these products or planograms will appear in the Object Grid. These 
are called Zone - Product or Zone - Planogram links and are controlled by means of 
Custom SQL.  
 
   

Overview of Zone Types and Zone Definitions 
Zones have both a Zone Type and a Zone Definition. 
Zone Types 
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Zone Types is used to set broad properties that can be assigned to a specific Zone 
Description. 
1. Description is the name given to the group of properties 
2. Layer is the AutoCAD layer the zone will be drawn on 
3. Auto Text Type describes the Text Style to use (Planning Menu in the Admin 

Module) 
4. Type describes the category the Zone Type will be assigned to - either Internal Area, 

Department Zone or Other Zone  
Zone Definitions 

 

Zone Definitions is used to create the Zone Hierarchy. This zone hierarchy will also 
appear in the Zone Tab of the Object Browser in the Planner and Merchandiser Modules. 
1. Name is the Name of the Zone 
2. Description expands on the Name of the Zone 
3. Zone Type puts the Zone into one of the classes described in the Zone Type dialog 

box 
4. Hatch Style selects a hatch style from those defined in the Hatch Styles option on the 

Planning menu in the Administration Module 
5. Color is the color the boundary of the zone (and any hatching) will be in the Planner 

and Merchandiser Modules 
6. Code is any code that a customer might assign to a Zone Definition 
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Object Browser 
Details of the Zone Definition will appear in the Properties Window of the Object 
Browser in the both the Planner and Merchandiser Modules. 

 
 
    

Criteria for Arranging Zone Types and Descriptions 
Some broad criteria have to be obeyed when designing a zone hierarchy 
Internal Area Zone  
There should be an Internal Area zone in a store plan. This determines the maximum 
area used for retailing purposes and is used in Area Calculations and assigning specific 
parts of the floor to specific fixtures. 
Zones Types of Type Department  

Zones Type of Type Department have particular properties. 

 

1. Fixtures are allocated to Zones of Type Department for calculation and reporting 
purposes when placed in a store plan. 

2. Because products are associated with specific fixtures, products are indirectly 
associated with Zones Types of Type Department for reporting purposes when 
placed in a store plan 

3. Synchronize automatically maps fixtures to Zones of Zone Type 'Type' Department 
as part of the synchronization process  

This imposes a restriction when designing a zone hierarchy: Zones of Zone Types 'Type' 
cannot overlap each other as this would cause problems with the underlying business 
logic of the software. 
'Department' Type Zone Types 
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The minimum requirement for laying out a store plan with zones is Zone Descriptions of 
Zone Type 'Type' department.  
1. This is necessary for reporting purposes, for example associating Fixtures with zones  
2. In-Store Space Collaboration requires Zones of  Zone Type 'Type' department to be 

present before a store plan can be opened. 

 

In the above example, the user might place 'Staff Area' and 'Stock Storage' Department 
Zones for the 'Back of Store' areas and 'Checkouts', 'Clothing', 'Concession Areas', 
'Electrical', 'Entrance Areas and Aisles' and Food and Drink' for the retail areas. 
Zones at other levels in the hierarchy can be placed to increase reporting flexibility, but 
are not essential. For example, 'Computing', 'Household' and 'TV and Audio' child zones 
(which are not of  Zone Type 'Type' Department) could be placed as children of the 
'Electrical' zone. 
Planner (AutoCAD) Layers 

Zones are drawn onto specified AutoCAD Layers in the Planner module. Different levels 
in the zone hierarchy can be drawn onto different AutoCAD layers. Zones that are on a 
specific AutoCAD layer can be detected as overlapping (clashing), whereas zones on 
different levels are not detected as clashing.  
Zones must be assigned to AutoCAD layers in such a way that zones that should not 
clash are on the same layer. Similarly, where zones have children, the must be drawn on 
different layers so that the child zones do not clash with the parent. For example the 
'Clothing' zone should be drawn on one AutoCAD layer and its children (Children's 
Clothing, Men's Clothing and Women's Clothing) drawn on another. This allows the 
'Child' zones to be superimposed on the parent.  
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Strategies for Zone Types and Descriptions 
There are two broad strategies for creating a zone hierarchy. 
1. Have only one level in the hierarchy of Zone Types 'Type' department 
2. Have multiple levels in the hierarchy of Zone Types 'Type' department and only 

place a Zone Description from one level in the hierarchy 
Have only one level in the hierarchy of Zone Types 'Type' department 

 

Here, the 'Department' type zones are represented by the blue folders ('Staff Areas' and 
'Food and Drink''). These, (together with the Internal Area zone) are placed as a 
minimum in the hierarchy, with other Zone Descriptions (of Zone Types Type 'Other') 
added to give more options for reporting purposes.   
For example, 'Computing', 'Household' and 'TV and Audio' child zones (which are not of 
 Zone Type 'Type' Department) could be placed as children of the 'Electrical' zone (which 
is of Zone Type 'Type' Department). 
This allows reports to be produced for either the 'Electrical' zone as a whole or the 
'Computing', 'Household' and 'TV and Audio' child zones if a finer level of granularity is 
required in the reporting. 

Note: it is important to ensure that all zones of Zone Type 
'Type' Department share the same AutoCAD layer. Clash 
Detection can then be used to detect if zones are clashing 
(overlapping).  (More Info)  

Have multiple levels in the hierarchy of Zone Types 'Type' department and only place 
a Zone Description from one level in the hierarchy 



Zone Types & Definitions 

Admin Planning 215 

 

In this form most of the hierarchy is of Zone Types 'Type' department and the user opts 
to place from one level of every branch in the hierarchy. For example, the user would 
either place a 'Electrical' zone or the 'Computing', 'Household' and 'TV and Audio' child 
zones. They could not place both the  'Electrical' zone and the 'Computing', 'Household' 
and 'TV and Audio' child zones. 
Here, reporting is by aggregating zones. The 'Computing', 'Household' and 'TV and 
Audio' child zones can be reported on as individual zones. To get a result for the 
'Electrical', the results from the 'Computing', 'Household' and 'TV and Audio' zones are 
consolidated into a single report. 

Note: it is important to ensure that all zones of Zone Type 
'Type' Department share the same AutoCAD layer. Clash 
Detection can then be used to detect if zones are clashing 
(overlapping).   (More Info)  

 

Overview of Clash Detection 
Clash Detection is used to identify where zones sharing the same AutoCAD layer are 
overlapping. It can be invoked in one of two ways: 
1. From the Configuration Module 
2. From the Object Browser Toolbar 
If zones overlap (clash) this may affect MSM functionality - particularly if they are Zone 
Descriptions of Zone Types 'Type' Department. 
From the Configuration Module 
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If the Detect Clashes option is checked, warnings will automatically be given when a 
zone being placed overlaps a zone sharing the same AutoCAD layer. 

 

From the Object Browser Toolbar 
If the Detect Clashes button is clicked, this will cause the currently active store plan to be 
checked for any overlapping (clashing) zones sharing the same AutoCAD layer. 

 

Why Clash Detection is Needed 

Fixtures are assigned to zones when they are placed in the drawing. This Zone - Fixture 
link is used for calculation purposes. If a fixture is placed in two Zone Definitions of the 
same Zone Type, MSM's internal functionality may not work correctly. In additions, 
there will be errors in reporting. 
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In the above example, fixtures have been paced in two overlapping Department Type 
Zones. This means the fixtures may be allocated to the wrong zone for reporting 
purposes. For example, it may have been intended to put the fixtures in the Food and 
Drink zone, but they may have been assigned to the clothing zone. If Clash Detection is 
On, then a warning dialog will appear, enabling the user to correct the clashing 
(overlapping) zones. 

 

 

How Clash Detection Works 
Clash detection works as follows 
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1. Create Layers in Planner 
Zone Descriptions are drawn on specific layers in the AutoCAD drawing in the Planner 
Module. Where necessary, these layers have to be created using the Layer Aliases option 
from the Format menu in Planner. 
2. Assign Layers to Zone Types 
When Zone Types are being defined in the Admin Module, each Zone Type is mapped to 
a specific layer created in Planner. For example 'Department' Type zones are mapped to 
the 'Department' Layer, 'Sub-Department' Type zones are mapped to the 'Sub-
Department' Layer, etc. 
3. Assign Zone Types to Zone Definitions 
When each Zone Definition is created, it must be assigned to a Zone Type. Each Zone 
Definition will therefore be mapped (indirectly) to a specific layer in Planner. 
4. Draw Zone Definitions in Planner 
When the Zone Definitions are drawn in Planner, they will be drawn on specified layers. 
The locations of the edges of the Zone Definition will be accurately known. 
5. Clash Detection 

After the Zone Definition is drawn, when Clash Detection is selected, the software will 
examine all Zone Definitions drawn on the same Planner Layer. If the boundaries of any 
Zone Definitions are shown to be overlapping (clashing) a warning will be generated. 
6. Consequences of Clashing 
Because Zone Descriptions that overlap (clash) can cause problems with the operation of 
the software (and with reporting accuracy) any clashes should be corrected.  
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Zones and Hatch Styles 
Zones Definitions can be assigned Hatch Styles. The Hatch Styles are specified in the 
Hatch Styles option on the Planning Menu of the Administration Module.  

 

These Hatch Styles are pre-loaded into AutoCAD, but have to be defined for the 
Merchandiser Module.  
 

Zone Technicalities 

Building Up Zones 
Internal Area Zone 
The Internal Area zone is used to specify the maximum area available for retail purposes.  
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In the example above, it is confined to the boundaries of the store. Equally, it could be 
confined to the area accessible to customers, or include areas outside of the store - for 
example those used to display and sell garden plants. 
The Internal Area Zone is also used to set the boundary for Area Calculations. 
Sales Area and Non Sales Area Zones 

Sales Area and Non Sales Area Zones can be used to divide the store into areas used for 
sales activities (i.e. accessible to the public) and areas used for support functions - offices, 
stockrooms, etc. 

 

In the example above the stockrooms and staff areas can be differentiated from the parts 
of the store used for selling to customers. 
Departments 
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Departments are used to divide the store into areas of more closely defined purpose. 

 

In the above example the store has now been divided into areas of specific use. For 
example, the area to be used for sale of clothing is designated by the red rectangle.  
Sub-Departments 
It is possible to continue dividing the store into ever finer divisions, for example the 
Clothing department could have Children's Clothing, Women's Clothing and Men's 
Clothing Sub departments. 

Note: if Zone Definitions are 'layered' on top of each other 
like this, each 'layer' must be of a different Zone Type (and 
hence drawn on a different AutoCAD Layer). (More Info) 

 

Fixtures and Zone - Fixture Links 
Fixtures can be linked to Zones using Zone - Fixture Links. Zone - Fixture links are 
stored in two places within the database.  
1. AVTTB_FIXTURE Table 
2. AVTTB_ZONE_FIXTURE_LINK Table 
Each of these tables is used for a different purpose. 
AVTTB_FIXTURE Table 
The AVTTB_FIXTURE table contains a ZON_ID (Zone ID) field. This holds the foreign 
key for the Department level zone that the fixture has been placed in. Each fixture can 
only be associated with a single Department level zone - which is why care must be taken 
that Department level zones do not clash (overlap).  
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It is important to note that the ZON_ID is read from the AVTTB_ZONE table. 

 

Note: The Zone Description may vary from that held in the 
AVTTB_ZONE_DEFINITION table as it is editable by the 
user when placing the zone. 

Where a Fixture straddles a Department zone boundary, it will be allocated to the zone in 
which the majority of the fixture is.  

 

In the above example, the insertion point of the fixture is in the left hand zone, but the 
bulk of the fixture is in the right hand zone. It will be allocated to the right hand zone. 
The information in the AVTTB_FIXTURE table is most accurate for reporting purposes as 
each fixture should only be associated with a single 'Department' type zone. This ensures 
that: 
1. Equipment take-offs do not show fixtures in multiple zones, resulting in inaccurate 

orders for equipment when building or refurbishing stores   
2. Merchandise is not reported in multiple zones, avoiding inaccurate orders for 

products when stocking stores  
AVTTB_ZONE_FIXTURE_LINK Table 
The AVTTB_ZONE_FIXTURE_LINK Table can associate fixtures with multiple zones. It 
contains ZON_ID's (Zone ID) fields - there are also read from the AVTTB_ZONE Table. 
These are the foreign keys for each zone that the fixture has been placed in. An example 
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of this would be if the "Clothing" department level zone contained a sub-department 
called "Children's Clothing". A fixture would then be associated with both the Clothing 
and Children's Clothing zones.  

 

It is important to note that the ZON_ID is read from the AVTTB_ZONE table. 

 

Note: The Zone Description may vary from that held in the 
AVTTB_ZONE_DEFINITION table as it is editable by the 
user when placing the zone. 

The ZFL_CROSSING field in the AVTTB_ZONE_FIXTURE_LINK table should be noted. 
A value of -1 indicates that a fixture crosses zone boundaries. 

 

This can mean that the same fixture (FIX_ID) is shown in multiple zones. 

 

Care needs to be taken during reporting to ensure the fixture is not duplicated in reports. 
Zone - Fixture Links and Custom SQL 

The exact nature of the reports generated from Zone - Fixture Links will depend on the 
Custom SQL used to generate the reports. Macro Space Management comes with some 
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standard reports. Anyone with a good knowledge of SQL can produce their own 
customized reports - often in conjunction with other Oracle software such as BI 
Publisher.  
 

Overview of Zone - Product and Zone - Planogram Links 
Zone - Product Links and Zone - Planogram Links provide a way of filtering products 
or planograms by the Zone they are associated with. For a given implementation of 
Macro Space Management either zone - Product Links or Zone - Planogram Links can be 
used: it is not possible to operate both. 
Zone - Product Links  
Zone - Product links operate by linking nodes in the Product Hierarchy to specific Zones. 
Clicking on that zone in the Zones tab of the Object Browser will cause all products that 
are children of the linked node in the Product Hierarchy to display in the Object Browser. 
Products are arranged in a Product Hierarchy. (This can be viewed and modified in 
Product Studio). It is possible to link specific zones to nodes in the product hierarchy. 
This is done by inserting a foreign key (PRD_ID) into the AVTTB_ZONE_DEFINITION 
table. This foreign key then links the Zone Definition (AVTTB_ZONE_DEFINITION) and 
Product Definition (AVTTB_PRODUCT_DEF) tables. This link enables products to be 
filtered by zone. 
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In the above example, Department level zones have been linked to the equivalent nodes 
in the products hierarchy and similarly Sub-department zones have been linked to nodes 
at Department level. 
This means that (for example) if the Children's Clothing zone is selected in the Object 
Browser, the Zone - Product link will result in products displaying in the Object Grid that 
are associated with (or children of) the Children's Clothing node in the product 
hierarchy.  
Zone - Planogram Links  
All planograms are arranged in a Planogram Hierarchy. Planograms are also linked to a 
specific node in the Product hierarchy. This node is the node in the product hierarchy 
that is the lowest common link between all the products in the planogram. Specific nodes 
in the Product Hierarchy are then linked to specific Zones. Clicking on that zone in the 
Zones tab of the Object Browser will cause all Planograms that contain products that are 
children of the node in the Product Hierarchy to display in the Object Browser. 
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Planograms are linked to the product hierarchy by means of the Product ID's (PRD_ID's) 
of the products in the planogram. The planogram will automatically be linked to the 
node in the product hierarchy that is the lowest common link between all the products in 
the planogram. 

 

For example, Planogram 1 contains trousers, shorts and socks.  The lowest common link 
between these products is the node above them in the product hierarchy - "Men's 
Clothing". Planogram 1 will therefore be assigned the Product ID of that node (PRD_ID = 
11 in this example). Planogram 2 only contains trousers, so can be linked to a node 
further down in the hierarchy: the "Trousers" node (PRD_ID = 22 in this example). 
In the extract from the AVTTB_PLANO table below, each planogram has automatically 
been assigned a Product _ID (PRD_ID) that corresponds to the node in the product 
hierarchy that is the lowest common link between all the products in the planogram.  

 

By using this Product _ID (PRD_ID) in the AVTTB_PLANO table, it is possible to find all 
planograms containing products associated with a specific zone. This is done by inserting 
a foreign key (PRD_ID) into the AVTTB_ZONE_DEFINITION table. This foreign key 
then links the Zone Definition (AVTTB_ZONE_DEFINITION) and Product Definition 
(AVTTB_PRODUCT_DEF) tables. This link enables planograms (containing specific 
products) to be filtered by zone. 
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The Internal Area Zone 
The Internal Area Zone is used to define the maximum area used for retail purposes. It 
may be confined to the bounds of the store walls (as in the example below), or it may 
encompass areas outside - for example a space used for selling plants for the garden. 

 

Once the Internal Area Zone has been placed, it is then used to set maximum limits for 
area calculations. 
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Individual retail organizations decide what to encompass in the Internal Area zone: some 
include non sales areas (like stock rooms and staff canteens, some do not. The area 
encompassed within the Internal Area will impact on reporting: an internal area that did 
not include non-sales areas would show a different 'profit per square meter' value than 
one that did.   

Note: if a hole is cut in the internal area zone, the space 
within the hole will not be included in area calculations, but 
area calculations will resume the other side of the hole. 

 

Cutting Holes in Zones 
Cutting Holes in Zones is used to allow for the effects of obstructions, etc. In the simple 
example below, a zone contains some gondola runs and a staircase. The staircase reduces 
the area available in the zone for retailing purchases. The 'Cut Holes' option allows the 
user to remove the area used for the staircase from the total area of the zone for 
calculation purposes.  
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The zone might therefore have a gross area of 3,600 square feet and a net area of 3,200 
square feet. Using the net area of the zone (i.e. taking into account the area enclosed by 
the hole) allows profit per square meter to be calculated more realistically.  
 

Aliased Layers 
Aliased Layers are a way for the functionality in the Planner Module of Macro Space 
Management to communicate with that in AutoCAD.   

 

AutoCAD Layers are information held within AutoCAD drawings. This cannot be 
directly written to the database, so an Alias for the Layer is provided within the database. 
This enables users to assign (Aliased) Layers to objects within MSM. For example a 
Fixture might be assigned to the 'Fixtures' Layer within Fixture Studio.  
When the time comes to insert a copy of that fixture into the drawing, the software 
identifies which Aliased Layer the Fixture has been assigned to, identified which 
AutoCAD Layer that has been mapped to and (via a connection in the code) causes the 
object to be drawn on the correct AutoCAD layer. If the AutoCAD layers does not yet 
exist in the drawing (for example, if it is the first time a fixture has been added to the 
drawing) then the software will automatically create the required AutoCAD layer at the 
same time as it inserts the Fixture into the drawing. 
Mapping between Layers and Layer Aliases is done in the Planner Module using the 
Layers and Aliases dialog box (called from the Format menu). 
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The Alias Name is the name of the Layer held in the MSM database and the Layer is the 
name of the layer in the AutoCAD (Planner) drawing. 
 

Zone Types 

Overview 
Zone Types are a way of assigning broad properties to specific Zone Descriptions. 

 

Zone Types is used to set broad properties that can be assigned to a specific Zone 
Description. 

  Description is the name given to the group of properties 

  Layer is the AutoCAD layer the zone will be drawn on 

  Auto Text Type is not currently in use 

  Type describes the category the Zone Type will be assigned to - either Internal Area, 
Department Zone or Other Zone  

Description 

The Description will appear in the Zone Type option for the Zone Definition. 
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Layer 
The Layer is the AutoCAD layer the Zone Type will be drawn on. These are configured 
using the Layers and Aliases dialog box accessible from the Format menu in the Planner 
Module. 

 

Only Zone Descriptions drawn on the same layer will be detected as clashing. So, all 
Zone Descriptions of Zone Type Department should be drawn on the Departments Layer 
so any overlaps (clashes) for that Zone Type can be detected. Similarly, all Zone 
Descriptions of Zone Type Sub-Department should be drawn on the Sub-Departments 
Layer so any overlaps (clashes) for that Zone Type can be detected.  
However, if a Zone Description of Type Sub-Department is drawn overlapping a Zone 
Description of Type Department, it will be drawn on a different layer and will not be 
shown as clashing. 
This ability to detect clashes between Zone Descriptions of the same Zone Type but not 
between Zone Descriptions of a different Zone Type is important when setting up a Zone 
Hierarchy. For example, the Internal Area encompasses the entire area used for retail 
purposes. The majority of other zones will probably be drawn within the Internal Area 
Zone, so it is important that they are not shown as clashing - arranged by ensuring the 
Internal Area Zone occupies it's own specific layer.  
Auto Text Type 

The Auto Text Type option in the Zone Types dialog box currently has no effect. 
However, the text that annotates a Zone will depend on the Custom SQL associated with 
Zones in the Text Styles option on the Planning Menu in the Administration Module.  
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The Text Style invoked will depend on the setting in the Auto Field (Internal Area, 
Department Zone or Other Zone), and any filters that might be present in the Custom 
SQL statement associated with the Text Style.  
Type 

There are three categories the Zone Type can be assigned to - Internal Area, Department 
Zone or Other Zone. 
1. Internal Area is used to for the single zone that defines an area used for retail 

purposes. The Internal Area zone is used for Area Calculation purposes 
2. Department Zones can be used for reporting purposes - they give the most accurate 

reports 
3. Other zones are assigned to all Zones Types not 'Internal Area' or 'Department' 
These types are hard coded into the software and cannot be changed 
Changes made to Zone Types and Zone Definitions  
Changes made to Zone Types in the Administration Module do not take immediate effect 
as far as Zone Descriptions are concerned.  
They are only read when the Admin Module is restarted - this must be allowed for when 
configuring Zone Descriptions.  
 

Planning Zone Types 
Before creating a zone hierarchy, it is necessary to plan the Zone Types. 
1. Decide on the Strategy for the Zone Hierarchy 
2. Decide on the Number of Levels in the Zone Hierarchy 
3. Decide on the Layer Aliases required 
4. Decide on the Text Styles Required 
5. Decide on the Zone Descriptions required and how they will map to Zone Type 

'Types' 
Decide on the Strategy for the Zone Hierarchy 

There are two broad strategies for creating a zone hierarchy (more info). 
1. Have only one level in the hierarchy of Zone Types 'Type' Department 
2. Have multiple levels in the hierarchy of Zone Types 'Type' Department and only 

place a Zone Description from one level in the hierarchy 
Which is to be used has to be decided at the outset as it will affect all other decisions on 
setting up the Zone Hierarchy. 
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Decide on the Number of Levels in the Zone Hierarchy 
The number of levels in the hierarchy must be determined. More levels will lead to more 
flexibility in reporting, but may increase the difficulty in generating accurate reports. The 
hierarchy could consist of just two levels - for example Internal Area and Departments. 
Alternatively, it could consist multiple levels - for example Internal Area, Areas, 
Departments and Sub-Departments.   

 

Not all these zones would necessarily be placed in a drawing: for example the 'Areas' 
level in the hierarchy could simply be used to  
Decide on the Layer Aliases Required 
Macro Space Management provides functionality called Clash Detection to determine 
whether Zones in a store plan are overlapping (clashing). Only Zones on the same 
AutoCAD Layer can detected as clashing.  
1. Zones that should not clash (overlap) should be placed on the same Layer 
2. Zones that are intentionally superimposed on each other need to be placed on 

different layers - for example the 'Clothing'' zone would need to go on one layer and 
its children (Children's Clothing, Men's Clothing and Women's Clothing) on another 
Layer 

How many Layer Aliases are required will depend on the whether the user has chosen to 
have only one level in the hierarchy of Zone Types 'Type' Department or to have multiple 
levels in the hierarchy of Zone Types 'Type' Department and only place a Zone 
Description from one level in the hierarchy. 
The minimum number of Layer Aliases required is two: one for the Internal Area Zone 
and one for Departments. A more complex hierarchy that places at several levels might 
require multiple Aliased Layers: in the example below, Internal Area, Areas, 
Departments and Sub-Department Layers have been set up to allow a four level 
hierarchy to be placed. 
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Decide on the Text Styles Required 

Each Zone Type can have a Text Style associated with it. This Text Style determines the 
form of the Annotation that will be drawn when the zone is placed. 

Note: Text Styles are configured by selecting the Text Styles 
option from the Planning menu in the Admin Module. 

 

Adding, Editing and Deleting Zone Types 
Zone Types can be accessed from the Edit Menu in the Administration Module.  

 
This will bring up the Zone Types dialog box. 

 

Options can be selected from the Edit pull down menu. 
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Alternatively, they can be selected from the toolbar.  

 
Exit 

 
Add Zone Type 

 
Edit Zone Type 

 
Delete Zone 
Type 

 
Refresh from 
Database 

 

Adding Zone Types 
When Add Zone is selected from the options on the pull down menu or toolbar, the Add 
Zone Type dialogue box appears. 

 

The Description can be typed in and should be appropriate to the Zone Type being 
created.  
The Auto Text Type can be selected from a drop down list and specifies the Text Style to 
be used for annotation on the drawing.  
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The Layer Type is also selected from a drop down list. 

  

This determines which Layer the Zone will be placed on.  

Note: Clashes can only be detected between Zones on the 
same layer alias. (Layer Type in the above dialogue box). 
The Type can also be selected from a drop down list. 

The type refers to one of three possible classes the Zone Type can be assigned to. 

 
 
   

Editing Zone Types 
When Edit Zone is selected from the options on the pull down menu or toolbar, the Edit 
Zone Type dialogue box appears. 

 

The Description can be edited and should remain appropriate to the Zone Type being 
created.  
The AutoText Type can be edited from a drop down list and specifies the list of what is to 
be annotated on the drawing. 

 

The Layer Type is also edited from a drop down list.  
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This determines which Layer the Zone will be placed on.  

Note: Clashes can only be detected between Zones on the 
same layer alias. (Layer Type in the above dialogue box).  

The Type can also be edited from a drop down list. 

 
 
   

Deleting Zone Types 
Zone Types can be Deleted by highlighting them, then selecting the Delete Zone type 
option from the drop down list on the menu bar, or using the appropriate icon on the 
toolbar. 

 
Delete Zone 
Type 

 

 
Note:  Zone Types cannot be deleted if there is a Zone Definition associated with it – the 
associated Zone Definitions must be deleted or assigned to another category first. 
The Internal Zone and Department Zone Types cannot be deleted – only other user 
defined Types within the Zone Type definition can be deleted.  
Zone Types cannot be deleted if there is a Zone Definition associated with it – the 
associated Zone Definitions must be deleted or assigned to another category first. 
 
    

Zone Text 
Zone Text is controlled by the Text Styles Option on the Planning Menu in the 
Administration module. 
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It provides three default text styles for Zones: Internal Area, Department Zone and Zone 
- these correspond to the three Default Zone Types. The number of available Text Styles 
may be increased by modifying the Custom SQL used to specify how the annotation is 
carried out. 
 

Zone Definition  

Accessing Zone Definition Options 
Zone Definitions can be accessed from the Edit Menu in the Administration Module.  

 

Note: changes made to Zone Definitions in the 
Configuration Module only take effect the next time the 
Planner Module is restarted.  

 

The Zone Definitions Window 
The Zone Definitions Window allows Zone Definitions to be Added, Edited and 
Deleted.  
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Options can be selected from the Edit pull down menu. 

 

Alternatively, they can be selected from the toolbar.  
 

 
Exit 

 

Add Zone Definition

 

Edit Zone Definition 

 

Delete Zone 
Definition 

 

Refresh View 

 

View Zone Types 

 
View Hatch Types 
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Adding Zone Definitions 
When Add Definition is selected from the options on the pull down menu or toolbar, the 
Add Zone Type dialogue box appears. 

 

The Name and Description can be edited and should be appropriate to the Zone 
Definition being created.  
The Zone Type can be edited from a drop down list 

 

As well as the predefined types shown in the example above, the list will also include 
any user defined types.  
The Hatch Style can also be edited from a drop down list. 

 

This will determine how the Zones appear when coloured on the drawing of the floor 
plan. 
The Zone Color can be edited from a pallet. 
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It is suggested that Zone colors are selected using a logical scheme; for example clothing 
in shades of red, electrical goods in shades of blue. 
The Zone Description Icon can also be edited from a drop down list.  

 

Finally an edited user defined Code can be typed into the Code window. 
 
  

Editing Zone Definitions 
When Edit Definition is selected from the options on the pull down menu or toolbar, the 
Edit Zone Definition dialogue box appears. 
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The Name and Description can be changed and should be appropriate to the Zone 
Definition being edited.  
The Zone Type can be selected from a drop down list 

 

As well as the predefined types shown in the example above, the list will also include 
any user defined types.  
The Hatch Style can also be selected from a drop down list. 

 

This will determine how the Zones appear when coloured on the drawing of the floor 
plan. 
The Zone Color can be selected from a pallet. 
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It is suggested that Zone colors are selected using a logical scheme; for example clothing 
in shades of red, electrical goods in shades of blue. 
The Zone Definition Icon can also be selected from a drop down list.  

 

Finally a user defined Code can be typed into the Code window. 
 

Deleting Zone Definitions 
Zone Definitions can be Deleted by highlighting them, then selecting the Delete Zone 
Definition option from the drop down list on the menu bar, or using the appropriate icon 
on the toolbar. 

 

Delete Zone 
Definition 
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A confirmation dialogue box will appear.  

 

Click on Yes to confirm deletion. 
 

View Zone Types and View Hatch Types 
View Zone Type and View Hatch Types can be activated using the buttons in the Zone 
Description toolbar.  

 

 

 

 

View Zone Types 

 

 

View Hatch Types 

 
Clicking on either button will bring up the appropriate window 

Note: If the Zone Description window is maximized, the 
View Zone Type and View Hatch Types windows will tend 
to appear behind the Zone Description window. It will have 
to be minimised before the new windows can be seen. 
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4   
Admin Merchandising 

Adjacency Rules 
Adjacency Rules can be used to set up a series of guidelines about which products 
should be in proximity to one another, and which should not be. For example, it would 
not be good placement to put bleach next to meat or vegetables. However, more pasta 
sauce will be sold if is placed next to pasta. 

 

Note: Rules are configured in the Severity Types Option 
from the same menu. 

These Adjacency Rules can then be used (in conjunction with other MSM database tables) 
to produce reports on whether products are well or badly placed. These reports (often in 
the form of Quick Reports or KPI's) can then be used to improve the layout of 
merchandise in a store plan - and hence the profitability of the store. 
 

Severity Types 
The Severity Types (rules) for the Adjacency Rules are set up using the Severity Types 
option from the Merchandising menu of the Admin Module. 
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Note: User can only alter the text and color for the Severity 
types via the dialog box. Altering the number of available 
Severity Types and only be done in the 
AVTTB_ADJACENCY_SEVERITY_TYPE table. 

 
   

Setting Up Adjacency Rules 
To Set Up an Adjacency Rule, click on the Add Button. 

 

This will bring up the Product Adjacency Rule dialogue box. 
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To add a Product Adjacency Rule: 
1. Type in a Rule Description 
2. Select Product 1 (clicking on the button will bring up the Select Products dialogue 

box) 
3. Select Product 2 (clicking on the button will bring up the Select Products dialogue 

box) 
4. Select the Severity Type 
The Select Product dialogue box allows users to manually select the required products. 
Alternatively, the find button can be used to locate successive instances of the search 
string in the product hierarchy. 

 

Users can select from products at Department, Class (Category) or Sub-Class (Sub-
Category) level in the Product Hierarchy. These levels in the hierarchy should not be 
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subject to frequent change, so a set of Adjacency Rules should only require updating at 
irregular intervals. (More Info). 
 
   

Keeping Adjacency Rules Updated 
Adjacency rules are set up at Department, Class (Category) or Sub-Class (Sub-Category) 
level in the Product Hierarchy. 

 

Products are generally subject to regular change at Style, Item and SKU levels in the 
Product Hierarchy. Department, Class (Category) or Sub-Class (Sub-Category) levels do 
not change very often, so once Adjacency Rules are set up, they should remain valid for 
extended periods of time. 
It would be possible to produce periodic reports that identify: 
1. Deleted Department, Class (Category) or Sub-Class (Sub-Category) items in the 

Product Hierarchy that are no longer needed in the Adjacency Rules. 
2. Newly added Department, Class (Category) or Sub-Class (Sub-Category) items in the 

Product Hierarchy that may need adding to the Adjacency Rules. 
 

Editing and Deleting Adjacency Rules 
Editing and Deleting Adjacency Rules can be carried out by using the appropriate 
buttons from the toolbar. 



Adjacency Rules 

Admin Merchandising 249 

 

Editing Rules 
Editing rules only allows the user to change the Severity Type. 

 

In order to change the products in an existing rule, it is necessary to delete the rule and 
create a new one. 
Deleting Rules 

To delete a rule, highlight it, then click the Delete icon. The rule will be deleted without 
further confirmation. 
 
   

Using Adjacency Rules 
After the Adjacency Rules have been set up, it is necessary to set up an output for them 
so that users can see how products in a specific drawing match the specified Adjacency 
Rules. The results can be based on either:  
1. Product Adjacencies 
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2. Aisle Adjacencies 

Note: it is also possible to base the results on distances (More 
Info). 

Product Adjacencies 

Product Adjacencies (AVTTB_PRODUCT_ADJACENCY table) can be used to look at the 
relationship of products on the same fixture and on the fixtures to the immediate left and 
right.  
Aisle Adjacencies 
Aisle Adjacencies (AVTTB_AISLE_ADJACENCY table) can be used to look at the 
relationship of products sharing an Aisle. 

Note: An Aisle is a MSM object. It is a line drawn in a store 
plan in the Planner module that is used to represent one (or 
more) real life aisles. Fixtures within a specific distance of 
that line are regarded as belonging to the MSM Aisle. As 
products are linked to fixtures in the AVTTB_PRODUCT 
table, it is then possible to determine what products belong 
to that MSM Aisle. 

SQL 

Generally, in order to make use of the Adjacency Rules, it is necessary to use SQL 
statements to link information from tables in the MSM database into an output that 
shows the results of the Adjacency rules. 
Tables 
For information on which tables to reference when using SQL to generate an output from 
the Adjacency Rules, please see the Macro Space Management data model. This is 
available to registered MSM users on application to Oracle.  
Quick Reports 
Quick Reports are available in both the Planner and Merchandiser Modules. It would be 
able to produce a Quick Report that show all the products in a drawing and the results of 
any Adjacency Rule calculations.  

 

Note: The SQL that populates the Quick Reports is stored in 
the AVTTB_CUSTOM_SQL table. 

KPIs (Key Performance Indicators) 



Adjacency Rules 

Admin Merchandising 251 

KPIs (Key Performance Indicators) are available in both the Planner and Merchandiser 
Modules. It would be able to produce KPI's that show all the products in a drawing and 
the results of any Adjacency Rule calculations. 

 

Reports 

It is possible to use Oracle tools such as BI Publisher to produce tabulated reports on the 
results of adjacency calculations within a drawing. Contact Oracle Technical Support for 
further information on Oracle applications suitable for producing reports on Adjacency 
Rules. 
 

Distances in Adjacency Rule Output 
It is possible to use distances in the results from Adjacency Rules 
AVTTB_PRODUCT_ADJACENCY_RULE Table 

The Adjacency Rule table (AVTTB_PRODUCT_ADJACENCY_RULE) has a 
PAR_DISTANCE Field. 
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This field cannot currently be accessed via the Adjacency Rule dialog box in the Admin 
module, but can be used to set a distance for each Adjacency Rule. 
AVTTB_AISLE_ADJACENCY Table 
The Aisle Adjacency table (AVTTB_AISLE_ADJACENCY) has 
AIL_DISTANCE_FROM_START and AIL_DISTANCE_FROM_AISLE fields 

 

These fields could be used to calculate the relative distances of fixtures (and hence 
products) along the Aisle 

Note: An Aisle is a MSM object. It is a line drawn in a store 
plan in the Planner module that is used to represent one (or 
more) real life aisles. Fixtures within a specific distance of 
that line are regarded as belonging to the MSM Aisle. As 
products are linked to fixtures in the AVTTB_PRODUCT 
table, it is then possible to determine what products belong 
to that MSM Aisle. 

AVTTB_PRODUCT ADJACENCY Table 
The Product Adjacency table (AVTTB_PRODUCT_ADJACENCY) contains 
PAJ_LENGTH_LEFT and PAJ_LENGTH_RIGHT fields that show the distance of 
products to the left and right of the current field. 
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AVTTB_FIXTURE Table 
The fixture table (AVTTB_FIXTURE) contains information on the X and Y coordinates 
(FIX_XPOS and FIX_YPOS) of a fixture within a store plan. 
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Products are associated with their parent fixtures in the AVTTB_PRODUCT table. Using 
the X and Y coordinates (FIX_XPOS and FIX_YPOS) of fixtures would enable Adjacency 
Rules to work on distances between products. This provides an alternative to using the 
AVTTB_AISLE_ADJACENCY and AVTTB_PRODUCT_ADJACENCY tables. 
 

Severity Types 

Overview 
Severity Types are used in conjunction with Adjacency Rules. They enable users to 
describe the form of the relationship between two products in the Adjacency Rules. 



Severity Types 

Admin Merchandising 255 

 

There are five default severity types: These range from badly placed to well placed. 
For example, a Product Adjacency Rule might state that bleach cannot be displayed 
within 5 meters of fresh meat. If this was infringed a warning might appear in the 
Product Adjacency Report flagging up that this rule had been infringed: ERROR: Layout 
groups far too close.  
Similarly, a Product Adjacency Rule might state that pasta sauces have to be displayed 
within 2 meters of pasta. If this was achieved during merchandising, then the Product 
Adjacency Report might flag up: EXCELLENT: Layout groups well placed. 
Editing Severity Types 
To edit a Severity Type, click on it to highlight it. Next, select the Edit option in the Edit 
pull down menu or click on the Edit icon. 

 

This will bring up the Severity Types editing dialogue. 
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The description and color can be customized to user requirements.  
Click OK to confirm and return to the Severity Types window. 
 

Modifying the Severity Type List 
There are five default Severity Types supplied with Macro Space Management. 

 

It is possible to increase or decrease the number of Severity Types, but this must be done 
directly in the database. This is done by changing the entries in the 
AVTTB_ADJACENCY_SEVERITY_TYPE table. 

 

All three fields are mandatory, with the AST_ID field being the primary key. This table is 
only referenced by SQL and not by the code, so changes to the table will not affect the 
operation of the Planner and Merchandiser Modules.  
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Planogram Substitution and Version Change 

About Planogram Substitution 
Planogram Substitution allows users to set up a list of planograms to be substituted. At 
present only one bay planograms can be substituted for other one bay planograms. Any 
other form of substitution will fail. 

 

The Planogram Substitution process is as follows: 

 

1. Planograms are created - either in the Merchandiser module or 3rd Party software 
2. The planograms are placed in a drawing 
3. The drawing is closed - planogram substitutions cannot be carried out on an open 

drawing 
4. Planogram substitutions are set up in the Admin Module 
5. The Planogram Substitutions are carried out by running a Stored Procedure to make 

changes in the database 
6. The drawing is reopened - if in Merchandiser or In-Store Space Collaboration the 

changes will be immediately apparent 
7. If in the Planner module, the open drawing is then 'synchronized to database' to 

bring in the changes 
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Note: Stored procedures cannot be run directly from Macro 
Space Management. They can only be run by someone with 
database administration rights. Drawings subsequently 
opened in Merchandiser and In-Store Space Collaboration 
will be automatically updated with the changed information. 
Drawings subsequently opened in Planner will require 
synchronization before they are updated with the changed 
information.  

 
Planogram Substitution is often carried out in parallel with Version Change. 
 

About Version Change 
Version Change is often done in parallel with Planogram Substitution.  
Planogram Versions occur when a small difference is made to a planogram design and it 
is saved as a different version - for example Version 1 is updated to Version 2. Updating 
the planogram design will not affect the planograms that have been already placed in 
store plans. The purpose of Version Change is to update the already placed planograms 
in drawings with any later versions that might exist.  
For Version Change to be carried out, the following conditions must be met: 
1. Store Plans on which Version Change is required must be checked in (not in use). 
2. Planograms must be Imploded (More Info). 
 

Exploding and Imploding in Merchandiser 
Planograms can be Exploded and Imploded in Merchandiser. In the example below, the 
planogram on the left is Imploded and the planogram on the right is Exploded. 
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Planograms can be toggled between Imploded and Exploded by using the options on the 
Directions toolbar. 

 

Exploded Planograms 
Exploded planograms have full information placed in the database for both products and 
shelves. Planograms placed in Merchandiser are placed in Exploded form unless the 
Implode option has been selected. 
Imploded Planograms 
Imploded planograms do not have shelf information placed in the database, and only 
have a single product block that represents the position of the planogram, not of the 
individual products on individual shelves. Planograms placed in Planner are placed in 
Imploded form. 
 

Limitations of Planogram Substitution 
Planogram Form 

Planograms can only be substituted if they are in Imploded form (More Info). 
Substituting planograms in Exploded form may lead to inaccuracies, for example in the 
shelving associated with the planogram. 
Planogram substitution in only 2D at present - that is to say one planogram placeholder 
will be swapped for another. 3D substitution is not carried out - i.e. changes in shelving 
height, etc, are not made in the drawings.  
Planogram Size 
The planograms being substituted in are not validated for size or equipment. This could 
mean that the new planogram is either a different size or uses different equipment to the 
planogram that is being replaced. It is recommended that uses manually confirm that 
planograms are compatible before carrying out a substitution. 
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Note: Because planogram substitution uses Imploded 
planograms (placeholders), planograms will substitute 
without problems in the drawing, even if they are 
incompatible in real life. Consequently, there may be 
considerable problems in actually implementing a store plan 
that has used incompatible substitutions. 

Only One to One Substitutions are Allowed 

It is generally only possible to substitute: 
1. A one bay planogram for another one bay planogram placed on a single fixture 
2. The first bay of a multi bay planogram for a one bay planogram 
All other forms of planogram solutions will fail. Examples of failures include: 
1. Attempting to substitute any multi bay planogram for any other multi bay 

planogram 
2. Attempting to substitute any single bay planogram that has simultaneously been 

placed on multiple fixtures. (Within the database, this will appear as similar to a 
multi bay planogram  

Errors in Any Substitution will cause All Substitutions to Fail 
If any substitution in the list of substitutions specified in the list of active planogram 
substitutions in the Admin Module fails, no substitutions in the list will be carried out.  

 

Note: it is recommended that individual substitutions be 
tested before a long list of automated substitutions is carried 
out. 

Active Substitutions 
Planogram Substitutions can only be run once. They are then shown as inactive by means 
of a flag in the database. This is the PGS_PROCESSED column in the 
AVTTB_POG_SUBSTITUTION table. If set to 0, the Planogram Substitution is active, if 
set to 1 the Planogram Substitution is inactive.  
There is currently no way of directly identifying in the Planogram Substitution dialog 
box in the Admin Module whether a Planogram Substitution is active or not.  
Annotation 
After the planograms are substituted and a Planner store plan is reopened, 
synchronization to database will update the information in the drawing so that the 
planograms in the drawing now match the planograms in the database. However, 
synchronization does not update the annotation. This has to be done manually. This is 
done by selecting the Annotate Option from the Retail Toolbar. 
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This will bring up the Text Styles Annotation dialog box. 

 

Highlighting the appropriate option and clicking OK will result in any substituted 
planograms having their annotation updated.  
 
  

Selecting the Planograms to be Substituted 
The planograms to be substituted are selected in the Planogram tab of the Planogram 
Substitution dialogue box.  
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The planogram which it is required to replace is selected from the list of planograms in 
the Existing Planogram frame. It can be selected or deselected using the arrows. Only a 
single planogram may be selected to be substituted. 
The replacement planogram is selected from the list of planograms in the Existing 
Planogram frame. It can be selected or deselected using the arrows. Only a single 
planogram may be selected for substitution. 
The effective date is the earliest date at which the planogram substitution can be carried 
out. For substitution to occur, the effective date must be on or before the day the stored 
procedure is run. Any substitutions set to a date after the day the stored procedure is run 
will not be carried out, and must await a subsequent re-running of the stored procedure. 

Note: The planogram hierarchy is configured in 
Merchandiser.   

While setting up planogram substitutions, the limitations on substitutions should 
be taken into account. (More Info).  
   
   

Selecting the Stores for Planograms to be Substituted In 
The stores in which the planogram substitution is carried out are determined by whether 
the Store Specific check box is selected or not.  
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If the checkbox is not ticked, then all stores containing the selected planogram will have 
the new planogram substituted for it. If the checkbox is ticked, then the substitution will 
only be carried out in a specific store.  

 

To select the store, first tick the Store Specific Checkbox. Then navigate to the store in the 
hierarchy and click on it until it shows in the Store text box. 

Note: The store hierarchy is configured in Store Manager. 
This is available in both Planner and Merchandiser. 

 
   

Carrying out Planogram Substitutions and Version Changes 
Carrying out Planogram Substitutions and Version Changes is as follows: 
Preparation 

1. Store Plans on which planogram substitutions are to be carried out must be closed 
(checked in). Store plans that are shown as in use (checked out) will not have 
planogram substitutions or version change carried out. 

2. Store Plans on which planogram substitutions are to be carried out must have the 
planograms Imploded. (More Info). If Planograms are in Exploded form, there may 
be problems with planogram substitution of version changes.   

3. The required Planogram Substitutions must have been set up in the Admin Module 
and must have an Effective Date of on or before the date the Planogram 
Substitutions. They must also be active (only identifiable through the database).  
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Carrying out Planogram Substitutions and Version Changes 
Planogram Substitutions and Version Changes are implemented by means of Stored 
Procedures.  

Note: Stored procedures cannot be run directly from Macro 
Space Management. They can only be run by someone with 
database administration rights. 

Stored procedures are held in the Macro Space Management database and need to be 
accessed using a program such as Oracle's SQL Developer.  

 

The relevant stored procedures can then be run, causing the planogram substitutions to 
be made. 
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Planogram Substitution 
The Stored Procedure is called AVTSP_2D_ONE2ONE_MAN_PLANO_SUB 
Version Change 
The Stored Procedure is called AVTSP_2D_VERS_CHNG_PLANO_SUB 

Note: it is recommended that Planogram Substitution be 
carried out before Version Change. This is because 
Planogram Substitution will automatically substitute in the 
latest version of the planogram, thus minimizing the amount 
of Version Changes required. 

 
  

Planogram Substitutions and Synchronization 
Carrying out planogram substitutions results in changes being made to the information 
in the database.  
When drawings are opened in some modules ( Merchandiser and In-Store Space 
Collaboration) the drawings are automatically updated with the changed information.  
However, if planogram substitutions have been made to a drawing in Planner, the 
drawing will not reflect the planogram substitutions made unless the drawing ha been 
synchronized with the database. 
The synchronize option can be selected from the File pull down menu. 
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This will bring up the synchronization dialogue box. 
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Selecting Match the Database will result in the drawing being updated with the latest 
planogram changes. 

Note: the store plan will also have to be re-annotated to 
ensure the substituted planograms are correctly labeled. This 
should be done after synchronization. 

 

Product Code Types 

Overview 
Product Codes are numerical codes that enable products to be identified at SKU levels. 
They are often present in Bar code form on the actual products. 

 

Product Codes come in a number of formats 
UPC Codes 

UPC (Universal Product Codes) were developed for the North American Market. They 
are normally 12 digits long (although variations exist). The most common versions are 
the UPC-A and UPC-E formats, although other variants exist.  
UPC codes are slowly being superseded by EAN (European Article Number). 
EAN Codes 
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EAN (European Article Number) are internationally accepted codes. They have been 
 renamed 'International Article Numbers', although the EAN abbreviation is retained. 
Unlike UPC's (which are specific to North America), EAN's allow the country of the 
manufacturers of the product to be identified. 
The most common form of European Article Numbers is the EAN-13 form, which is 13 
digits long. A less commonly used form is EAN-8 (8 digits long) which is sometimes used 
for smaller items, where fitting a longer bar code might be impractical. 
JAN Codes 
JAN (Japanese Article Numbers) are the same as EAN codes. 
GTIN Codes   
GTIN (Global Trade Item Numbers) are a family of codes that consolidate codes in the 
UPC, EAN and JAN systems. GTINs may be 8, 12, 13 or 14 digits long. They can be 
constructed using any of four numbering structures, depending upon the exact 
application.  

  GTIN-8s will be encoded in an EAN-8 bar code.  

  GTIN-12s will be encoded in UPC-A, ITF-14, or GS1-128 bar codes. 

  GTIN-13s may be encoded in EAN-13, ITF-14, GS1-128 bar codes 

  GTIN-14s may be encoded in GS1-128 bar codes 
Product Code Types can be used to set up masks for the Product Codes to be entered 
manually within Product Studio. They have no influence on Product Code information 
imported via the Data Import module.   

 

Product Code Types are used in the SKU dialogue box in Product Studio. The type is 
selected from the UPC type drop down list. Any data entered for the UPC must then 
conform to the masks set in the Admin module.  
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Adding and Editing Product Code Types 
Product Code Types can be added, edited or deleted using the Product Code Type 
dialogue box. The add, edit or delete options can be accessed from either the menu bar or 
toolbar.  
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The following wild card characters can be used: 

Character Meaning 

? Any letter 

# Any number 

* Any number of characters of any type 

 
In addition, the following characters can be added as permanent parts of the mask. 

Option Available 

Numbers 0 1 2 3 4 5 6 7 8 9 

Separators ! " £ $ % % ( ) - + { } : ; @ ' ~ , . < > | 
\ 

 
For example, a mask could have the form 12345###-###. Any Product Code manually 
added to a Product SKU in Product Studio will have to conform to that format. Examples 
of valid inputs are: 
12345678-123 
12345123-456 
 

Ranges 

Overview 
Ranges and Range Groups are used to set up limits for values for specific types of data. 
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These Ranges can then be used as filters to ensure that products are placed on compatible 
items of equipment in the Merchandiser Module. For example, if the Frozen Goods 
Range is assigned to both a shelf and a product, then the use of the Range will prevent 
(say) Ice Cream being placed into fixtures or shelves where it could melt. 

Note: Ranges have no effect in the Planner Module. 

Range Groups 
Range Groups are used to collect together Ranges sharing a common attribute - in the 
above example, the Temperature Range Group has been used to hold all the Ranges 
involving temperature. 
Ranges 
Ranges are the maximum and minimum values that can be assigned to a particular 
property of the equipment and products. In the above example, the Frozen Goods Range 
has been defined as temperatures between -1 and -5 degrees centigrade. 

Note: Ranges are used in parallel with Styles. 

Currently only temperature ranges can be used. They can be assigned to Fixtures, Shelf 
Object and Products. 
 

Where Ranges are Assigned 
Ranges can be assigned to fixtures, shelves and products. 
Fixtures and Shelves 
Fixtures and Shelf Objects are assigned ranges in the Styles/Ranges tab of the Block 
Details dialog box in Fixture Studio. 
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Products 
Products are assigned Ranges at SKU level using the Physical tab. 
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Where Ranges are Used 
Ranges are used as follows: 
Products and Equipment 

If both the product and the equipment (fixture or shelf) on which it is being placed, have 
been assigned a Temperature Range, a warning will be generated if an attempt is made to 
place a product on a fixture or shelf object that does not have a matching temperature 
range. 

 

Planograms and Equipment 
These is currently an option in the Configuration Module to warn if the Range assigned 
to a planogram is not compatible with the parent fixture. 
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This option is currently not active. 
 

About Ranges and Styles 
Ranges and Styles can be used interchangeably as filters to determine if products can be 
placed on Fixtures or Shelf Objects.. 

 

Styles 
If styles have been assigned to: 
1. Fixtures and Products 
2. Shelf Objects and Products 
and the requisite Style Relationships exist, then styles can be used to determine whether 
a product can be placed on either a fixture or a shelf object. 
Ranges  
If Ranges have been assigned to: 
1. Fixtures and Products 
2. Shelf Objects and Products 
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and the ranges are compatible, then they can be used to determine whether a product can 
be placed on either a fixture or a shelf object. 
Example 

1. It would be possible to create Chilled Fixture, Chilled Shelf and Chilled Product 
styles and assign them appropriately to Fixtures, Shelf Objects and Products. The 
appropriate style relationships could then be set up, and would serve to determine 
whether products could or could not be placed. 

2. It would also be possible to create Basic Fixture, Basic Shelf and Basic Product styles 
that could be assigned to all Fixtures, Shelf Objects and Products. The pertinent 
 Fixtures, Shelf Objects and Products could then be assigned the 'Frozen' temperature 
range. In this example, the Range would serve to determine whether products could 
or could not be placed. 

 

Seasons 

Overview 
The Seasons Option is used to set up the list of retailing Seasons. These seasons can then 
associated with Revisions (Store Manager), Products (via the database) and Planograms 
(Planogram design - Merchandiser). Once Revisions, Products and planograms have 
been associated with Seasons, the information can be used for filtering and reporting 
purposes. 

 

Seasons are arranged in a hierarchy and must have a start and a finish date. Unlike 
Calendars, seasons can have overlapping date ranges. 
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In the above example, the year has been divided into four quarters. Seasons can nest 
within or overlap other seasons. For example the Summer Sale Phase is entirely within 
Quarter 3, while the Christmas Phase overlaps the year end. 
 

Configuring Seasons 
Seasons can be added, edited or deleted by use of the options on the menu bar or tool 
bar.  

 

Description  
The description is user configurable - any text can be used. 
Start Date and End Date  
The Start Date and End Date can be configured using the calendars. These are available 
as drop down controls. The Start Date and End Date can overlap other seasons. 
Type  
Type is selected from the drop down list. These are two options: Season and Phase. These 
are purely for user convenience and do not have any effect within the software. One way 
of using then option is to use 'Seasons' to designate regular time intervals (for example 
Months or Quarters). 'Phases' can then be used to designate irregular time intervals - for 
example the Christmas Phase might run between 1st November to 4th January. 
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Assigning Seasons 
Seasons are specific time periods used to define when Revisions, Products and 
Planograms are valid for store planning purposes. If revisions, Products and Planograms 
are assigned a season, the information can then be used in the Custom SQL for filtering 
or sorting purposes. There information can also be used in Key Performance Indicators 
(KPI's). 
Revisions 
Revisions can be assigned a season in the Add or Edit Revision dialog box in Store 
Manager  

 

Information on which season a revision has been assigned to is held in the 
AVTTB_REVISION table in the SSN_ID field. Only a single value can be held, so a 
revision can only be assigned to a single season.  
Products 

Products can only be assigned a season directly in the database, using during data 
import. Values are added to the AVTTB_PRODUCT_SEASON_LINK table. This links 
product data in the AVTTB_PRODUCT_DEF table with the information in seasons in the 
AVTTB_SEASON table. 
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Products can have multiple seasons assigned. 
Planograms 

Planograms can be assigned a season in the Planogram Design dialog box in the 
Merchandiser module. 

 

Note: Planogram definitions will typically be imported via 
data importer. The seasons a planogram is valid for can be 
assigned during this import definition. 

Information on which seasons a planogram has been assigned to is held in the 
AVTTB_PLANO_STORE_SEASON_LINK table. Planograms can have multiple seasons 
assigned. 
 

Uses for Seasons 
Once assigned, seasons can be used for varying purposes. These include: 
1. Color coding data that appears in the Object Browser 
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2. Filtering Data that appears in the Object Grid 
3. Classifying Data that is used in KPI's 
4. Reporting Purposes 
Color coding data that appears in the Object Browser 
The data that appears in the Properties and Summary windows is powered by Custom 
SQL. If seasons have been assigned to Revisions, Products and Planograms, it is possible 
to color code data.  
For example, if the Parent revision for the active store plan has been assigned a season, it 
would be possible to color code the properties for the products or planogram selected in 
the Object Browser hierarchies in order to show whether the product or planogram 
selected in the Object Browser has a season compatible with that specified for the parent 
revision. 
Filtering Data that appears in the Object Grid 
Seasons can be used to filter the data that appears in the Object Grid. This can be either 
pre-filtered or filtered when in the Object Grid. 

a. Pre-filtering 

If the revision that is acting as a parent for the current store plan has had a season 
assigned, it is possible to use the custom SQL to pre-filter the data that appears in the 
Object Grid so that it only populates with products and planograms that have seasons 
that are compatible with the season set in the parent revision. 

b. Filtering  

If the season is a valid field in the Custom SQL that populates the Object Grid, it is 
possible for a user to filter the populated by the seasons assigned to it. 
Classifying Data that is used in KPI's 
Key Performance Indicators (KPI's) can be set up to meet customer requirements. It is 
possible to color code objects in the store plan based on date criteria - including seasons. 
This is done via the Date Tab of the Key Performance Indicator dialog box in both the 
Planner and Merchandiser modules. 
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Importing Seasons 
Seasons are stored in the AVTTB_SEASON table in the database. 

 
This table can be populated by using the Data Importer module as an alternative to 
entering data manually via the Admin Module.  
The AVTTB_SEASONS table must be populated before seasons can be assigned to 
Revisions, Products and Planograms (AVTTB_REVISION, 
AVTTB_PRODUCT_SEASON_LINK and AVTTB_PLANO_STORE_SEASON_LINK 
tables). 
 

Styles 

Overview of Styles 

Overview 
Styles are used in the Merchandiser Module as filters, primarily to ensure that products 
are placed on the correct fixture or shelf. There are a variety of styles and style 
relationships. 
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Fixtures and Shelf Objects 
Fixtures have to be assigned a Fixture style in Fixture Studio. Similarly Shelf Objects 
(shelves, pegs, etc) have to be assigned both a Fixture and a Shelf style in Fixture Studio. 
When shelving is placed in a fixture in Merchandiser, the Fixture Style assigned to the 
Fixture must match the Fixture Style assigned to the shelf to allow the shelf to be placed. 
Shelf Objects and Products  
Shelves have to be assigned a Shelf style in Fixture Studio. Products (at Display Style 
level only) are assigned a Product Style in Product Studio. If a relationship between the 
Shelf and Product Style has been defined in the Administration Module, the Product can 
be placed on the shelf. If a relationship has not been defined, the product cannot be 
placed in the Merchandiser Module. (Display styles cannot be placed in the Planner 
Module). 
Fixtures and Products  
Fixtures have to be assigned a Fixture style in Fixture Studio. Products (at Display Style 
level only) are assigned a Product Style in Product Studio. If a relationship between the 
Fixture and Product Style has been defined in the Administration Module, the Product 
can be placed directly onto the fixture. If a relationship has not been defined, the product 
cannot be placed in the Merchandiser Module. (Display styles cannot be placed in the 
Planner Module). 
Joints 
Some products cannot be placed directly onto fixtures, but must be placed into shelf 
objects such as pegs. There are two ways of achieving this: 
1. Place the shelf object (i.e. peg) first, then place the product 
2. Place the product and shelf object simultaneously - joints  
Planograms 
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Fixtures have to be assigned a Fixture style in Fixture Studio. Planograms are assigned a 
Fixture Style in the Planogram Design dialog box in the Merchandiser Module. If the 
Fixture Style of the Planogram being placed does not match the Fixture Style of the first 
of the selected fixtures, a warning will be given. The user can then accept the warning, or 
override it and place the planogram. 
 

Where Styles are Assigned 
Styles can be assigned to Fixtures, Shelf Objects, Products and Planograms. 
Fixtures 

Fixture Styles are assigned in the Fixture Studio Module in the Styles tab of the Block 
Details dialog box. 

 
A Fixture is required to have a Fixture style assigned. Only Fixture Styles will be 
available for selection in the Styles/Ranges Tab. 

Note: Whether an object is designated as a fixture is set in 
the Categories tab. 

Shelf Objects 
Both Fixture and Shelf Styles are assigned in the Fixture Studio Module in the Styles tab 
of the Block Details dialog box. 
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A Shelf Object is required to have both Fixture and Shelf styles assigned. Both Fixture 
and Shelf Styles will be available for selection in the Styles/Ranges Tab. 

Note: Whether an object is designated as a Shelf Object is set 
in the Categories tab. 

Products 
Only Products at Display Style Level can be assigned Styles. This is done in the Styles 
Tab of the Display Style dialog box in Product Studio 
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Only Product Styles will be available for Selection. 
Planograms 
Planograms are assigned Fixture Styles in the Planogram Design dialog box in the 
Merchandiser Module. 
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Only Fixture Styles will be displayed.  
 

Styles and Style Relationships 
Style Relationships are set up within the Styles option in the Administration module. 
They control: 
1. What products can be placed on what fixture 
2. What products can be placed on what shelf 
3. What products can be placed on what fixture using a specified shelf object (joints) 
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Style relationships must be set up before products are placed in Merchandiser.  
 

Preferred Styles 
Preferred Styles are used on Shelf Objects. They enable automatic switching of display 
styles for a SKU so that the preferred Display Style is placed on a shelf object. 
An example would be if electric kettles were available in two display styles: Boxed and 
Presentation. The Presentation Display Style would typically be for a electric kettle that 
has been taken out of its box and was being displayed on a shelf above the boxed electric 
kettles. The 'presentation' electric kettle would be used to show customers what the 
electric kettle looked like, the boxed' electric kettles would be purchased by customers 
An example of this would be a fixture with five shelves on it. The top shelf might contain 
examples of 'presentation' goods such as electric kettles, electric toasters, bread makers 
and toasters. The four shelves below would contain respectively boxed electric kettles, 
electric toasters, bread makers and toasters. for purchase.  
By setting the preferred style of the top shelf to accept 'Presentation' Display Styles and 
the preferred styles of the shelves below to accept 'Boxed' Display Styles, the user can 
ensure that the correct form of the merchandise goes onto the shelves. If an attempt is 
made to put  'Presentation' Display Styles onto a shelf that prefers 'Boxed' Display Styles, 
then the Display Style will automatically be switched to the correct one.  
The full process for using preferred styles is 
1. Add Appropriate Styles in Admin 
2. Set up Style Relationships in Admin 
3. Assign Styles to Shelf Objects in Fixture Studio 
4. Assign Styles to Display Style level products in Product Studio 
5. Set up Preferences for Shelves 
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6. Drag and drop Display Style products onto shelf - preferred style should be chosen if 
not correct 

Add Appropriate Styles in Admin 

The appropriate styles have to exist in the Style tab of the Styles dialog box in the 
Administration module 

 
Set up Style Relationships in Admin 
The appropriate style relationships have to exist in the Style Relationship tab of the Styles 
dialog box in the Administration module 
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Assign Styles to Shelf Objects in Fixture Studio 
Shelf styles have to be assigned to the shelf object in Fixture Studio. A minimum of two 
shelf styles are required for Preferred Styles to work. 
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Assign Styles to Display Style level products in Product Studio 

Product Styles are assigned in Styles Tab of the Product Display Style dialog box in 
Product Studio. 
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Set up Preferences for Shelves 
The preferences for shelves are set in the Merchandiser module. There are two ways of 
doing this: on adding the shelves to a fixture, or by editing a specific shelf. 
When adding shelves to a fixture, the preferred style can be set using the drop down list 
in the Add Shelves dialog box. 
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Once shelves have been added, the Preferred Style can be edited using the Preferred Style 
drop down list in the Edit Shelf dialog box. 

 
Drag and Drop Display Style products onto shelf - preferred style should be chosen if 
not correct 

Once preferred styles have been set for a shelf, they can be used to determine what 
display style for a specific SKU is placed. If there are several alternatives, dragging and 
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dropping any display style onto a shelf from that SKU will result in the type of display 
style being checked, and if necessary changed to the preferred style.  
 

About Joints 
Joints are a special type of Style Relationship. They allow a product to be placed directly 
onto a compatible fixture at the same time as the associated shelf object that the product 
will be placed on is added.   

 
In the example above products have been directly placed into a slatwall using pegs. 
Without a joint, the pegs would have to have been placed first, then merchandised with 
product in a second operation.  
 
Prior to products being added via joints, the following must be true: 
1. The Fixture that will support the shelf objects the products are being added to must 

have a Fixture Style assigned in Fixture Studio 
2. The Shelf Object the product will be added to must have a Shelf Style assigned in 

Fixture Studio 
3. The Product must have a Product Style assigned in Product Studio 
4. The appropriate Joint (Style Relationship) must be set up in the Styles option within 

the Admin Module 
 
To add a product using joints requires the following steps: 
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1. Drag the product from the Object Browser or Object Grid and drop onto the required 
Fixture. 

2. The Add Shelves dialog box will appear allowing users to specify details of the shelf 
objects to be added. 

 

Note: this dialogue box will not appear if the Add Products 
Silently option is on in the Edit Menu in Merchandiser. 

3. After the Shelf Object details have been specified and the OK button clicked, the Add 
Products dialog box will appear. 
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4. After specifying the quantity, alignment, etc, and clicking the OK button, the 

products and shelf objects will simultaneously place on the selected fixture. 
 
   

About Styles and Ranges 
Styles and Ranges can be used interchangeably as filters to determine if products can be 
placed on Fixtures or Shelf Objects.. 

 
Styles 
If styles have been assigned to: 
1. Fixtures and Products 
2. Shelf Objects and Products 
and the requisite Style Relationships exist, then styles can be used to determine whether 
a product can be placed on either a fixture or a shelf object. 
Ranges  
If Ranges have been assigned to: 
1. Fixtures and Products 
2. Shelf Objects and Products 
and the ranges are compatible, then they can be used to determine whether a product can 
be placed on either a fixture or a shelf object. 
Example 
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1. It would be possible to create Chilled Fixture, Chilled Shelf and Chilled Product 
styles and assign them appropriately to Fixtures, Shelf Objects and Products. The 
appropriate style relationships could then be set up, and would serve to determine 
whether products could or could not be placed. 

2. It would also be possible to create Basic Fixture, Basic Shelf and Basic Product styles 
that could be assigned to all Fixtures, Shelf Objects and Products. The pertinent 
 Fixtures, Shelf Objects and Products could then be assigned the 'Frozen' temperature 
range. In this example, the Range would serve to determine whether products could 
or could not be placed. 

 
   

Using Styles 

Adding and Deleting Styles 
Adding and Deleting Styles is done by using the Style tab in the Styles dialogue box. 

 
 

 

Add style 

 

Delete style 

 

 
Adding a Style 
To add a style, click on the Add Style icon. A new line will be added in the styles table.  
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The Style ID is a fixed, sequential number allocated when the style is created. 
The Name and Description will initially read Style11 and Description11, where the 
number is that of the style being created. These can be edited to the style name and 
description required.  
The Style type can be selected from a drop down list. 
 

 

Currently only Fixture, shelf and Product styles are active. 
Deleting a Style 

Styles can be deleted by highlighting a style and clicking on the Delete Style icon. If not 
in use, the style will be deleted. If in use, a warning will appear. This indicates that the 
style has been assigned to either a fixture, shelf, product or planogram. 

 
The style must then first be changed in the respective fixture, shelf, product or 
planogram before it can be deleted. 
 
  

Example of Adding a Style 
To Add a Style to the available list, open the Style option in the Admin Module. Use the 
Style Tab and click on the Add Style Icon (circled).  
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This will add another line to the information grid (circled). 

 

Edit this line until it has the desired information. 
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Finally, exit to save the styles.  

Note: There is a known issue with the Styles option at 
present. Information is temporarily lost if a second style is 
added immediately after the first. To overcome this close the 
Styles dialogue box after each style is added, then re-open it 
to add the next.  

 
   

Adding and Deleting Style Relationships 
Style Relationships can be added and deleted by using the Style Relationships tab in the 
Styles dialogue box. 
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Add style 
relationship 

 
Delete style 
relationship 

 
Adding a Style Relationship 
To add a style relationship, first select the style types which it is desired to set up a 
relationship with. This can be done from the drop down lists – for example it might be 
required to associate a Shelf style with a Product style. 
Next, select the specific types of styles from the lists provided – for example it might be 
required to associate the Pallet Shelf Style with the Multipack product style.  
Finally, click on the Add Style Relationship icon to add the relationship. It will then 
appear in the list of current relationships. 
Valid Style relationships that can be set up are: 

Style 
Relationship 

Comment 

Fixture - 
Product 

Determines which products can be placed on which fixtures  

Shelf Product Determines which products can be placed on which shelves  

Joints Joints allow products to be placed on fixtures while simultaneously placing any 
required shelf objects (i.e. pegs, etc). Joints set up the relationship between 
fixtures, certain types of shelf objects and products.  
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Deleting a Style Relationship 
Styles relationships can be deleted by highlighting a style and clicking on the Delete Style 
Relationship icon. 

Note: Style relationships in use can be deleted without any 
warning being given. This will not affect any objects placed 
before the relationship was deleted, but if further objects are 
to be placed using this relationship, it must be reinstated 
before they are. 

 
     

Example of Adding a Style Relationship 
To Add Style Relationships to the available list, open the Styles option in the Admin 
Module. Click on the Style Relationship Tab.  

 

Set the options as required. First select the required style types from the drop down list. 
Next highlight the styles it is desired to have a relationship with. 
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Finally, click on the Add Style Relationship icon. This will cause the Style to be added to 
the list of available Style relationships.  
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Note: If we need place products directly onto a fixture, a 
Style Relationship would be required between the Fixtures 
Style and the Product Style. An example of this would be 
putting products of Boxed Style onto fixtures of Pallet Style.  

 
   

Adding and Deleting Joints 
Adding and Deleting Joints is done by using the Style Relationships tab in the Styles 
dialogue box. 
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Add joint relationship 

 

Delete joint 
relationship 

 
Adding a Joint 

To add a joint, first select the style types which it is desired to set up a relationship with.  
First select Fixture Style in the left hand drop down list. Next select Product Style in the 
central drop down list. Finally select Shelf Style in the right hand drop down list.  
Next highlight the required styles in each of the three lists. (For example Metal as a 
Fixture Style, Hung as a Display Style and Peg as a Shelf Style. 
Finally, click on the Add Joint Relationship icon to add the relationship. It will then 
appear in the list of current relationships. 
Deleting a Joint 

Joints can be deleted by highlighting a style and clicking on the Delete Style Relationship 
icon. 

Note: Joints in use can be deleted without any warning 
being given. This will not affect any objects placed before the 
relationship was deleted, but if further objects are to be 
placed using this relationship, it must be reinstated before 
they are. 
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Example of Adding a Joint 
To Add a Joint to the available list, open the Styles option in the Admin Module. Click on 
the Style Relationship Tab.  

 

First select Fixture Style in the left hand drop down list. Next select Product Style in the 
central drop down list. Shelf Style will automatically appear in the right hand drop down 
list.  
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Next highlight the required styles in each of the three lists.  

 

Finally, click on the Add Joint Relationship icon to add the relationship.  
It will then appear in the list of current relationships. 
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Testing Style Relationships 
Testing Style Relationships is done by using the Test tab in the Styles dialogue box. 
Equipment 
To see which product styles are associated with an item of equipment, click on that item 
of equipment in the list of available equipment.  
The list of associated product styles will then display. 
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Note: The list of equipment can be sorted in ascending or 
descending order by clicking on the column headers.  

 
Products 
To see which equipment styles are associated with a product, click on that product in the 
list of available products. The list of associated equipment styles will then display. 
Product can be found by entering the product name or code and clicking on the search 
icon. 
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Note: The list of products can be also sorted in ascending or 
descending order by clicking on the column headers.  

 
Joints 
Joints can only be tested by trial placements on equipment. 
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5 
Tools 

Next ID 

Overview of Update ID Tables Option 
The Update ID Table Option is called from the Tools Pull down Menu. 

 

Its function is to reset the AVTTB_NEXTID table in the central Macro Space Management 
database in the event of a serious system failure.  
This option would normally be used by Administrators. 
 

The Update ID Tables Option 
The central Macro Space Management database contains a AVTTB_NEXTID table.  
This contains the next primary key for a number of key pieces of information in the 
database. 

 

These values are used to assign primary keys when new items (for example stores or 
planograms) are added to the database.  
If there is a serious failure and the software crashes, these primary keys may not be fully 
updated, leading to problems when the software is restarted.  
Similarly, if the database is updated by a major import of data, some of the information 
in the Next ID table can become outdated.  
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Running the Update ID Tables option takes the latest values of the specified Next ID's 
(primary keys) from the referenced tables in the database and ensures the Next ID values 
are updated.  
 

Unlock Tables  
The Unlock Tables option allows administrators to unlock tables that have been locked 
by (for example) a system failure or by people leaving objects such as products checked 
out.  

 

The Unlock Tables Option 
After the Unlock Tables option has been selected from the Menu Bar, the Unlock Tables 
dialogue box will appear.  

 

If there are objects to be checked in, this can be done by highlighting them, right clicking 
to bring up the pop-up menu and choosing the appropriate option. 
 

Purge 

Overview 
Purge Options are available using the Purge option on the Tools pull down menu. 
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This will bring up the Purge dialogue box. 

 

Clicking on OK will purge the selected items. 
 

Purge Fixtures Option 
Deleting Fixtures 
Fixtures are deleted in Fixture Studio.  
This is done by highlighting the selected fixture and using <Ctrl> + right click to bring 
up the pop-up menu. 

 

The highlighted fixture can then be marked for deletion by clicking on the Delete Block 
Option. Fixtures marked for deletion will appear grey rather than black in the Fixtures 
Hierarchy. 
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Purging Fixtures 
The fixture will not be permanently deleted from the database until the Fixtures option is 
checked on the Purge dialogue and the OK button clicked.  

 

Results will be reported in the Purge Results dialogue box. 

 

 
   

Purge Products Option 
Deleting Products 
Products are deleted in Product Studio. This is done by highlighting the selected product 
and using <Ctrl> + right click to bring up the pop-up menu. 
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The highlighted product then be deleted by clicking on the Delete Block Option. 
Purging Products 

The product will not be permanently deleted from the database until the Product option 
is checked on the Purge dialogue and the OK button clicked.  

 

Results will be reported in the Purge Results dialogue box. 
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Purge Images Option 
Deleting Images 
Images are deleted in Product Studio. This is done by highlighting the selected image 
and using <Ctrl> + right click to bring up the pop-up menu. 
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The highlighted image then be deleted by clicking on the Delete Option. 
 
Purging Images 
The image will not be permanently deleted from the database until the Image option is 
checked on the Purge dialogue and the OK button clicked.  
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Images will then be deleted without further confirmation. 
 
  

Purge Planograms Option 
Deleting Planograms 
Planograms are deleted in Merchandiser. This is done by highlighting the selected 
planogram and using <Ctrl> + right click to bring up the pop-up menu. 

 

The highlighted fixture can then be marked for deletion by clicking on the Delete Block 
Option. 
Purging Planograms 
The planograms will not be permanently deleted from the database until the Planograms 
option is checked on the Purge dialogue and the OK button clicked.  
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Results will be reported in the Purge Results dialogue box. 

 

 
   

Purge Logs Option 
Deleting Logs 
Logs are deleted in Store Manager.  

 

This is done by selecting the Purge > Logs option from the Admin pull down menu.   
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Note: The Admin pull down menu is only available to users 
with Administrator's privileges. It is toggled on and off by 
means of <Ctrl + A>.  

This will bring up the Log File Purge dialogue box. 

 

Log files can then be selected and marked for purging. 
Purging Logs 
The logs will not be permanently deleted from the database until the Logs option is 
checked on the Purge dialogue and the OK button clicked.  

 

Results will be reported in the Purge Results dialogue box. 
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Purge Targets Option 
The Purge Targets Option is not enabled in this release of Macro Space Management. 

 

 
   

Purge EPOS Data Option 
The Purge EPOS Data Option is not enabled in this release of Macro Space Management. 
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6 
Logs 

Log are in two forms: Text Logs and Database Logs.  
Text Logs 
Text logs include .log, AVT5 Store Manager.log, AVT5CAD.log, AVT5Controls.log, 
AVT5Legacy.log, dbTreeControl.log, Macro Space Management.log, Store Manager.log. 
These are used mainly for debugging purposes and are not generally used in normal 
operations.  
Database Logs 

Log Description 

AVTTB_FILE_PROCESS_LOG Identifies all files that have been 
subjected to batch processes 

AVTTB_FILELOG Identifies all files that have been 
checked in or out 

AVTTB_IMPORT_ERROR_LOG Identifies all errors during data 
import 

AVTTB_IMPORT_LOG Identifies all data imports 

AVTTB_POG_IMPORT_LOG Identifies all planogram imports 

AVTTB_POG_SUBST_LOG Identifies all planogram 
substitutions 

AVTTB_PROCESS_LOG Identifies all processes that have 
been invoked [not in use] 

AVTTTB_USER_LOG Identifies the times users have 
logged into MSM 

AVTTB_ERROR Holds errors reported by In-Store 
Space Collaboration 

 

Note: The AVTTB_FILE_PROCESS_LOG_TYPE table gives 
information on which processes are being recorded in the 
AVTTB_FILE_PROCESS_LOG 

Logs can be viewed from the Logs option on the menu bar. 

 

Logs can be purged using the Purge option on the tools menu. 
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AVTTB_COMMAND_LOG 
The AVTTB_COMMAND_LOG table is not presently in use. 
 

AVTTB_FILELOG 
The AVTTB_FILELOG Table identifies the files that have been logged out and by which 
user. 

 

The AVTTB_IMPORT_ERROR_LOG table can be purged via the Purge option in the 
Administration module, or via the Purge option on the Tools menu in the Store Manager 
module. 
Purging in the Admin Module will remove all entries from the table. Purging in Store 
Manager allows users to remove entries for specific users or between specific dates. 
 

AVTTB_FILE_PROCESS_LOG 
The AVTTB_FILE_PROCESS_LOG table stores the results of automated processes.  

 

The Type of Process is specified by the FPT_ID (File Process Type ID). This is a foreign 
key to the AVTTB_FILE_PROCESS_LOG_TYPE table. 
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File 
Process 
Type 
(FPT_ID) 

Description Comment 

0 Result of Synchronization process from 
Drawing Automation 

Not presently active 

1 Result of Save process from Drawing 
Automation 

Not presently active 

2 Result of Publish process from Drawing 
Automation 

Not presently active 

3 Store Section No longer active 

4 Bulk Planogram No longer active 

5 Update Store - Open Result of running UpdateStatus.exe 

6 Update Store - Close Result of running UpdateStatus.exe 

7 Update File - Publish Result of running UpdateStatus.exe 

8 Update File - Current Result of running UpdateStatus.exe 

9 Planograms Substitution Clone Result of Planogram Substitution 

11 Adjacency Calculation Result of running Automated 
Calculations 

 

Note: Update Status and Automated Calculations are in the 
C:\Program Files\Oracle Retail\MSM\APPS directory. 
Planogram Substitution is run using a Stored Procedure. 

 

AVTTB_IMPORT_LOG 
The AVTTB_IMPORT_LOG identifies the results of imports generated by the Data 
Importer Module - including the number of records imported, updated, deleted, expired, 
skipped and failed. 
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The contents of the table are visible in the Import Log dialog box in the Data Importer 
module. 

 

The AVTTB_IMPORT_LOG table can be purged via the Purge option in the 
Administration module, or via the Purge option on the Edit menu in the Import Log 
dialog box. 
 

AVTTB_IMPORT_ERROR_LOG 
The AVTTB_IMPORT_ERROR_ LOG identifies the errors that occur during imports 
generated by the Data Importer Module. 
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The contents of the table are visible in the Import Error Log dialog box in the Data 
Importer module. 

 

The AVTTB_IMPORT_ERROR_LOG table can be purged via the Purge option in the 
Administration module, or via the Purge option on the Edit menu in the Import Error 
Log dialog box. 
 

AVTTB_PLANO_LOG 
The AVTTB_PLANO_LOG table records details of all planograms that have been Added, 
Edited or deleted in the Merchandiser Module. 

 

The table can only be purged directly in the database. 
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AVTTB_POG_IMPORT_LOG 
The AVTTB_POG_IMPORT_LOG table holds information on all planograms imported 
into Macro space Management via the Planogram Import Module. 

 

The table can only be purged directly in the database. 
 

AVTTB_POG_SUBST_LOG 
The AVTTB_POG_SUBST_LOG table holds the reports of all planogram substitutions. 

 

The table can only be purged directly in the database. 
 

AVTTB_PROCESS_LOG 
The AVTTB_PROCESS_LOG table contains details of when files (store plans) were made 
Authorised or Current in Store Manager. 
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The table can only be purged directly in the database. 
 

AVTTB_USER_LOG Table 
The AVTTB_USER_LOG Table records the times users log into Macro Space 
Management 

 

It also records when a user has failed to log in.  

Note: if the Log In ID does not match any user in the 
database, this indicates a possible unauthorized attempt to 
access the software.  

 

AVTTB_ERROR 
The AVTTB_ERROR Table mainly holds errors generated during there operation of In-
Store Space Collaboration. 
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The table can only be purged directly in the database. 
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7 
Security 

MSM Security is based on three options. 

 

1. Security Options control the form that access to the software takes: password 
format, number of log in attempts allowed, etc. 

2. Functional Security controls the access to specific modules in Macro Space 
Management. 

3. Data Security controls access to specific parts of the functionality - currently what 
stores and file statuses are visible in In-Store Space Collaboration.  

 

Security Options 
Security Options allows Administrators to configure the log in parameters.  
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These include the number of incorrect log-ins allowed, maximum and minimum 
password length, password format, the password change period and Excluded 
Passwords.  
 

Maximum Logins 
The Maximum Number of Log In attempts can be set by means of the spin controls. 
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Any user exceeding the maximum number of log in attempts will have their account 
deactivated.  
This is a security measure to prevent unauthorized users attempting to guess passwords. 

Note: Accounts can be reactivated by editing the user's 
account in the Functional Security option. 

 

Minimum and Maximum Password Length 
The Maximum and Minimum Password Lengths can be set by means of the spin 
controls.  
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This enables users to set the minimum and maximum number of characters allowed in 
the password.  
The minimum value can be set in the range 1 - 10 characters. The maximum value can be 
set to a maximum of 15 characters. It cannot be set below the value defined in the 
minimum value. 
 

Password Format 
The Password Format determines what characters are allowed in the password.  
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It is possible to enter three characters in this field. They are: 

a Alphabetical character 

n Numerical character 

? Alphanumeric 
character 

 
It is thus possible to determine the precise form of the password, or leave it in a more 
general alphanumeric form, as in the example above). 
 

Change Password Period 
The Change Password Period option allows the Administrator to set the time required 
between enforced password changes.  
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This is set by means of the drop down list. It can be set to any interval between 1 day and 
yearly. It can also be set to 'never' in which case users will never be asked to change their 
password. 
 

Excluded Passwords 
The Excluded Passwords option allows Administrators to exclude obvious and easy to 
guess passwords from those allowed to users. 



Security Options 

Security 335 

 

For example, it might be desired to exclude Password, Admin and SysOp as obvious 
passwords.  
It is also possible to exclude obscenities, first names, surnames, etc - anything that might 
assist an anatomized user to guess a password. 
Entering Passwords 

To enter a password, type it into the text box and press <Return>. The excluded 
password will now be stored in the database. 

Note: If you do not press <Return>, the Excluded Password 
will not be stored. 

Editing Passwords 
To edit a password, click on it in the list, make the required changes and press <Return>. 
The edited excluded password will now be stored in the database. 

Note: If you do not press <Return>, the changes will not be 
stored. 

Deleting Passwords 
To delete a password, highlight it in the list then press the <Delete> key,  
 

Exiting Security Options 
To Exit Security Options either click on OK or Cancel 
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Clicking on OK will save all settings to the database and exit. 
Clicking on Cancel will result in all changes (except to Excluded Passwords) being lost. 
 

Functional Security 

About Functional Security 

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management.  

Functional Security is used to control who can log in to the software, and also which 
parts of the software can be accessed. 
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Note: User Groups can also be used within Data Security to 
control access to Stores and Files accessible to users in In-
Store Space Collaboration. 

Users  

Users can be added - and their User Names and Passwords assigned. This can be used to 
control logging in to both Macro Space Management and In-Store Space Collaboration. 
User Groups 
Users are put into User Groups. Membership of a User Group confers the privileges of 
that User Group on the User. For example the Admin User Group will typically allow the 
User to access all parts of the software, while membership of other User Groups will give 
more restricted access.  
User Groups are also used in Data Security, which is currently used to control what 
stores and file (store plan) statuses are visible in In-Store space collaboration. 
The Functional Security Dialog Box 

The Functional Security dialog box has two tabs: User Groups and Group Relationships. 
1. User Groups Tab 
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The User Groups tab allows Administrators to create Users and User Groups. 

Note: in the default Database supplied, only users belonging 
to the Admin User Group can access the functionality within 
In-Store Space Collaboration. To give other User Groups 
access to the functionality in ISSC, changes need to made 
directly in the database. (More Info) 

2. Group Relationships Tab  
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The Group Relationships Tab allows Administrators to determine which User Groups 
can access which modules. 
 

The Functional Security Window 
The Functional Security Window has a series of components.  
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The Menu Bar allows Administrators to access a limited number of options.  
The Toolbar allows Administrators to access a series of options affecting User Groups 
and Group Relationships. 
The Tabs allow operations to be switched between User Groups and Group 
Relationships. 
The Hierarchy shows the current list of User Groups or Group Relationships. 
 
   

Functional Security Menus and Toolbar 
The File pull down menu allows users to exit this option. 
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The View pull down menu allows users to refresh the hierarchical tree and to call the 
Find dialogue 
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The Help pull down menu allows users to check the version of this software. 

 

The Toolbar allows users to access various Functional Security options. 



Functional Security 

Security 343 

 

Icon User Groups Group Relationships 

 

 

Exit 

 

Exit 

 

 

Add User Group 

 

Add Command Group 

 

 

Edit User Group 

 

Edit Command Group 

 

 

Delete User Group 

 

Delete Command Group 

 

 

Add User 

 

Not Available 

 

 

Edit User 

 

Not Available 

 

 

Delete User 

 

Not Available 

 

 

Cut 

 

Cut 

 

 

Copy 

 

Copy 
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Paste 

 

Paste 

 

 

Search 

 

Search 

 

 

Refresh 

 

Refresh 

 
  

<Ctrl> + A and the Command Groups Tab 
Using <Ctrl> + A in the Functional Security dialog box brings up the Command Groups 
tab. 

 

This functionality is for future releases and is not currently enabled. 
 

Users and User Groups 

User Groups 

Overview of User Groups 
User Groups are groups of users. User Groups can be any logical grouping of users. 
Examples include: 
1. Functional Groupings: Store Planners, Merchandisers, etc 
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2. Responsibilities: Planners, Managers, etc 
3. Geographical Groupings: North America, Europe, etc 
Each User Group can be assigned specific privileges within the software. When Users as 
assigned to User Groups, the Users inherit the privileges of the User Group, thus 
enabling Administrators to control access the program without configuring it for each 
individual user.  
When planning User Groups, it is recommended that the different ways Macro Space 
Management and In-Store Space Collaboration use User Groups.  
1. User Groups in Macro Space Management are used to give access to Modules - for 

example the Planner or Merchandiser modules. 
2. User Groups in In-Store Space Collaboration are currently used to give access to 

Stores and to Files of a specific status.  
Example of 'Functional' User Groups 

 

Example of 'Responsibility' User Groups 

 

The Store Planner and Manager User Groups will have different privileges in Macro 
Space Management and In-Store Space Collaboration. 
1. In MSM the different User Groups will be able to access differing numbers of 

modules 
2. In ISSC the different User Groups will have differing privileges set in Data Security. 

For example, the Store Planner User Group will be able to edit stores and submit 
them for approval. The Manager User Group will be able to edit stores and approve 
the layout. 

Example of 'Geographic' User Groups 
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Note: at present Geographic User Groups only find an 
application in In-Store Space Collaboration. They can be 
used in Data Security to specify which Stores users can see. 

Users can be assigned to multiple User Groups. 

 

User 1 can only work in functionality assigned to the Asia User Group 
User 2 can work in functionality assigned to both the Asia and Europe User Groups 
User 3 can only work in functionality assigned to the Europe User Group 
User 4 can only work in functionality assigned to the both the Europe and America User 
Groups 
User 5 can only work in functionality assigned to the America User Group 
 

The User Group Hierarchy 
The User Group Hierarchy shows the relationship of User Groups and their associated 
users.  
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User 
Group 

 

User 

 
Users Groups can be planned in a hierarchy - for example the Store Planner User Group 
has Fixture Planner as a child. The Store Planner User Group might allow (Group 
Relationships Tab) Users to access both the Planner and Fixture Studio Modules, while 
the Store Layout User Group will only allow access to the Planner Module. 
Users can be allocated to Single or Multiple User Groups. 

Note: If users are allocated to multiple User Groups in a 
hierarchy the most restrictive permissions will apply. If a 
function is allowed in one User Group and denied in 
another, the deny permission will take precedence.  

Before Adding, Editing or Deleting User Groups, Administrators should consider how 
access to both Macro Space Management and In-Store Space Collaboration will be 
controlled. User Groups can then be configured as required. 
 
   

Adding a User Group 
To Add a User Group select the node in the hierarchical tree that the new User Group is 
to emanate from and click on the Add User Group Icon. 
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This will bring up the User Groups dialogue box. 

 

1. Enter the Name of the User Group and the Description.  
2. If the mandatory check box is ticked, all new users will automatically be added to 

this group when they are created.  
3. Click on OK and the User Group will be added to the hierarchy. 

Note: A User Group cannot be added unless a valid node 
has been selected in the hierarchical tree.   

 
   

Editing a User Group 
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To Edit a User Group select the User Group in the hierarchical tree and click on the Edit 
User Group Icon. 

 

This will bring up the User Groups dialogue box. 

 

1. Change the Name of the User Group and the Description.  
2. (If the mandatory check box is ticked, all new users will automatically be added to 

this group when they are created). 
3. Click on OK and the edited User Group will be appear in the hierarchy. 
 
  

Deleting a User Group 
To Delete a User Group select the User Group in the hierarchical tree and click on the 
Delete User Group Icon. 



Functional Security 

350 Oracle Retail Macro Space Management  Administration Guide 
 

 

This will bring up the Delete Confirmation. 

 

Click on Yes and the User Group will be removed. 
 
   

User Groups and Functionality in ISSC 

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management.  

Privileges in Macro Space Management can be set using the Functional Security option 
in the Admin Module. However, privileges in In-Store Space Collaboration have to be 
assigned by a combination of actions in the Administration module and the database. 
What functionality users can access in ISSC is controlled by which buttons are active and 
which buttons are grayed out. 
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The buttons that are active in In-Store Space Collaboration are controlled by the 
AVTTB_MESSAGE_USER_GROUP_LINK table.  

 

1. The USG_ID is the ID of the User Group it is desired to activate buttons for. It is 
determined from the AVTTB_USER_GROUP table. 

2. The MSC_ID is the identity of the button or form it is desired to give a User Group 
permissions for. 

3. THE MUG Permission Mask determines whether the button is active or grayed out. 
(1 = active, 0 = disabled). 

When a User Group is created in Functional Security, any users associated with that User 
group will be able to get into In-Store Space Collaboration, but will then find all the 
buttons on the toolbar grayed out and unavailable. In order for the buttons in In-Store 
Space Collaboration to become available, all the entries for USG_ID = 1 (Admin Users) 
have to be duplicated for the additional User Groups it is desired to make In-Store Space 
Collaboration available to. 
This can be done with a simple SQL Insert statement of the form 

 

where the value of the User Group ID in the AVTTB_USER_GROUP table (for example 9) 
is substituted for [User Group ID]. If it is necessary to disable specific functionality, the 
MUG_PERMISSION_MASK can be set to 0 (Disabled).  

Note: for more information on what is controlled by 
MSC_ID, please contact Oracle Technical Support. 

 

Users 

Adding a User 
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Users are Added to User Groups. The users then inherit the privileges of those User 
Groups. To Add a User select a User Group in the hierarchy then click on the Add a User 
Icon. 

 

This will bring up the User dialogue. 
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First Name is the first name of the User. 
Last Name is the last name of the User. 
Initials are the User's initials. 
Login ID is what will appear in Macro Space Managements Log In dialogue box. 
Password and Password Confirmation allow the administrator to set the initial 
password. These will be required when logging in to Macro Space Management. 
Expiry Date sets the initial date at which the password will expire and require changing. 
(The interval at which the password will require further resets is determined by the 
Change Password Interval option in the Security Options option). 

Note: the expiry date can be set to a date in the past for new 
users. This will force a password change when they first log 
on. 

Language sets the default language for Macro Space Management.  

Note: For any other language than English the 
AVTTB_MESSAGE table must first be populated with the 
appropriate information.  

Activate is grayed out and unavailable when adding a new user. It becomes available 
when the user is edited. 

Note: A User cannot be added unless a valid node has been 
selected in the hierarchical tree. 

 

User Configuration and Logging In 
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When Users are added (or User properties are Edited), Administrators can set the User 
Name and Password that will be required in the User Log in dialogue box that appears 
the first time Macro Space Management is opened.  

 

Note: the Expiry Date can be set to a date in the past. This 
will force a password change when the user first logs on. 

Thus, the 'Mark Twain' user has a user name of MT and a password set for their log in. 

 

 
   

Editing a User 
To Edit a User highlight the user in the hierarchy then click on the edit user icon. 
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This will bring up the User dialogue. 

 

Edit the details as required and press OK.  
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Deleting a User 
To Delete a User highlight the user in the hierarchy and click on the delete icon.   

Note: Deleting a user will remove the user from all user 
groups. Use an alternative method if it is desired to remove 
the User from a single User Group. Removing Users from 
User Groups 

 

This will bring up the Delete Confirmation. 

 

Click on Yes and the User will be removed from all User Groups. 
 
   

Adding Users to Multiple User Groups 
Adding Users to Multiple User Groups is done so that a User can have the privileges 
associated with both groups. 
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1. In Macro Space Management it might be desired to give a user access to the a 
combination of modules that are only possible by putting the User into two separate 
User Groups.  

2. In In-Store Space Collaboration it might be desired to give a user access to User 
Groups containing multiple geographic areas.  For example, a User might be put into 
two different users groups (France and Germany) to give them access to stores in 
both of those countries.  

To add Users  to multiple User Groups use the Copy and Paste options. 

 

1. Open up the hierarchical tree and highlight an instance of the user you wish to copy. 
2. Click on the Copy icon. 
3. Highlight the User group it is desired to copy the User to. 
4. Click on the Paste icon. 
The user will now be copied to the required User Group. 
 
  

Moving Users from one User Group to Another 
Moving Users to from one User Group to Another is carried out by using the Cut and 
Paste options. 
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1. Open up the hierarchical tree to find and instance of the user you wish to move. 
2. Click on the Cut icon. 
3. Highlight the User Group it is desired to move the user to. 
4. Click on the Paste icon. 
The User will now be removed from the first User Group and copied to the second User 
Group. 
 
   

Removing Users from Multiple User Groups 
Removing 'Multiple User Group' Users from some of those User Groups is not directly 
possible with the current functionality, but it can be achieved indirectly. 

Note: Do not use the Delete option to remove a User from a 
single User Group - this will result in the User being deleted 
from all User Groups. 
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1. Click on the Add Group Icon to create a Temporary Group. 
2. Name the Group Temporary or some other similar name. 
3. Open the hierarchy and select the User Group and the User it is desired to remove 
from the Group. 
4. Click on the Cut icon. 
5. Highlight the Temporary User Group.  
6. Click on the Paste icon. 
The User will be removed from the selected User Group and copied to the Temporary 
User Group. 
7. Delete the Temporary User Group. 
 
   

Purge Users Option 
Purge options are available using the Purge option on the Tools pull down menu. 
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The user will not be permanently deleted from the database until the Users option is 
checked in the Purge dialogue box and the OK button clicked.  

 

Note: Until the user is purged from the database, they will 
still be able to use their User Name and Password. Deleting 
a user in Functional Security alone is not enough to prevent 
then from accessing Macro Space Management or In-Store 
Space Collaboration. 

 
   

Group Relationships 

Overview of Group Relationships 

Note: Group Relationships only affect access to the modules 
in Macro Space Management. Specifying what functionality 
is available to a User Group in In-Store Space Collaboration 
can currently only be done directly in the database.    

Group Relationships  
Group Relationships are used to define areas of functionality for which security can be 
set. These control access to the main modules of Macro Space Management - for example 
Fixture Studio. User Groups can then be assigned to these areas of functionality - 
allowing access to be controlled to the different modules. 
Adding, Editing and Deleting Command Groups 
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At present Adding Command Groups has no effect as there is no way of tying the newly 
added Command Group into any functionality. The names of Command Groups can be 
edited, but this is not recommended as it may make it difficult to establish which 
functionality is having its access controlled. Command Groups can be deleted. This is not 
recommended as deleting a command group removes all control over access to the 
module it references.  
Using Group Relationships 
User Groups can be created in the User Groups Tab. Permissions to access specific parts 
of the Macro Space Management and In-Store Space Collaboration can then be granted 
by associating User Groups to the top level command groups. 

 

In the above example, Fixture Studio has been made available to users belonging to the 
Administrator and Store Planner User Groups.  
 

Adding a User Group to a Command Group 
To Add a User Group to a Command Group highlight the required Command Group 
and right click to bring up the pop-up menu.  
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Select Add User Group to bring up a list of available User Groups. 



Functional Security 

Security 363 

 

Check the boxes for the required User Groups and click on OK. 
 

Removing a User Group from a Command Group 
To Remove a User Group from a Command Group highlight the required User Group 
and right click on it to bring up the pop-up menu. 
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Select the Delete Links option. This will bring up a confirmatory dialogue. 

 

Click on OK to confirm. 
 
   

Setting Permissions 
The Edit Permissions option is not active in this release of Macro Space Management 
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Data Security 

About Data Security 

Note: In-Store Space Collaboration is an optional application 
that can be used in parallel to Macro Space Management. It 
may not be installed in all implementations of Macro Space 
Management.  

Data Security is an extension of Functional Security. It allows Administrators to further 
restrict the permissions a user may have for a particular Macro Space Management or In-
Store Space Collaboration function to specific data within that function. For example a 
merchandiser may have permissions to add, change and delete merchandise, but it may 
be desired to restrict those permissions to specific stores.  

Note: at present Data Security is only operational in In-Store 
Space Collaboration and has no effect in Macro Space 
Management. 

Data Security allows Administrators to further define permissions for User Groups for:  
1. Stores 
2. Products  
3. Statuses.  
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In the above example, the Boston Store has been made available to ISSC users that are 
members of the North America User Group. This means that only users with the correct 
privileges can edit that store.  

Note: User Groups are defined using the Functional Security 
option (available from the Security menu). 

 
 

About Data Security 
Data Security is an extension of Functional Security. It allows Administrators to further 
restrict the permissions a user may have for a particular Macro Space Management 
function to specific data within that function. For example a merchandiser may have 
permissions to add, change and delete merchandise, but it may be desired to restrict 
those permissions to specific stores.  
Data Security allows Administrators to further define permissions for User Groups for 
Stores, Products and Statuses.  

Note: at present Data Security is only operational in In-Store 
Space Collaboration. 

 

The Data Security Window 
The Data Security Window allows users to set varying options concerning Data Security. 
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The Menus allow users to access various Data Security options. 
The Toolbar gives access to a limited number of Data Security options.  
The Tabs allow the users to switch between setting Data security options for Stores, 
Products and Status. 
The Hierarchy allows users to see a list of Stores, Products or Statuses. 
The Permissions List enables users to see the list of permissions allocated to that aspect 
of Macro Space Management. 
 

Data Security Menus and Toolbar 
The File pull down menu allows users to exit this section of the Admin Module. 

 

The Edit pull down menu allows users to configure the permissions for the data. 
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The View pull down menu allows users to access the find dialogues and to refresh the 
information in the Data Security window with the latest information in the database. 

 

The Help pull down menu calls the About option 

 

The Toolbar has three options: 

 

 

Exit 

 

Find 

 

Refresh 

 
Exit closes this part of the Admin Module. 
Find brings up the search dialogue. 
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Refresh loads the latest version of the information in the database to the Data Security 
window.  
 

Using Data Security 

Overview of Data Security for Stores 
Data Security for Stores is intended to allow Administrators to assign permission for 
User Groups to see specific stores. 

Note: at present this functionality only affects In-Store Space 
Collaboration. If Macro Space Management users have the 
appropriate privileges to use either the Planner or 
Merchandiser Modules, they can access all stores in the Store 
Hierarchy. 

 

In the above example the Berlin store has been made visible to ISSC users. (Other stores 
can also be made visible if required). 

 

Stores then become visible to In-Store Space Collaboration Users - note how stores in the 
Europe cluster in MSM's Store Manager that have not been given permissions to be 
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accessible in In-Store Space Collaboration do not become visible in ISSC. (London, Paris 
and Tallinn would need to have the ISSC User Group assigned to them before they 
became visible). 

 

Also note that any store plans it is desired to edit for the store must also have been given 
the appropriate permissions in the Statuses Tab of the Data Security dialog box and then 
must be set in Store Manager for the specified statuses.. 
 
  

Adding and Removing Permissions for Stores 
Adding Permissions for Stores  

Note: at present this functionality only affects In-Store Space 
Collaboration. If Macro Space Management users have the 
appropriate privileges to use either the Planner or 
Merchandiser Modules, they can access all stores in the Store 
Hierarchy. 

Adding Permissions for Statuses is done in three stages. 
1. Highlight the required store and select the Add User Group option from the right 

click menu. 
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2. This will bring up the Add User Group dialog box. The User Groups it is desired to 
add can be selected from the list. 
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Note: User Groups (and the Users assigned to them) are set 
up using the Functional Security option. 

3. On clicking OK, the selected User Group will be added to the list of those that can 
view that store in In-Store Space Collaboration. 
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All Users belonging to the selected User Groups will be able to access that store In-Store 
Space Collaboration.  (The store will also have to contain store plans at a status that can 
be viewed in In-store Space Collaboration). 
Deleting Permissions for Stores 

Deleting Permissions for Stores is done by highlighting the User Group it is desired to 
remove and selecting 'Delete User Group' from the right click menu. 
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Overview of Data Security for Products 
Data Security for Products is intended to allow Administrators to assign permission for 
User Groups to change specifically identified products.  

 

Note: This functionality is not fully implemented in this 
release. Data Security for Products is not available in either 
Macro Space Management or In-Store Space Collaboration.  

 

Overview of Data Security for Statuses 
Data Security for Statuses is intended to allow Administrators to assign permission for 
User Groups accessing In-Store Space Collaboration to see store plans at specific statuses.  

Note: at present this functionality only affects In-Store Space 
Collaboration. If Macro Space Management users have the 
appropriate privileges to use either the Planner or 
Merchandiser Modules, they can access store plans at all 
statuses in the Store Hierarchy. 

At present Data Security for Statuses only operates on Files. Setting Data Security for 
Statuses will have no effect on Blocks, Floors, Planograms, Products, Reports, Revisions 
and Stores.  
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In the above example the ISSC status has been made visible to ISSC users. (Other statuses 
can also be made visible if required). 

 

When a store plan is ready for use in In-Store Space Collaboration, it is set to ISSC Status 
in Store Manager. 

 

Store plans of ISSC status then become visible to In-Store Space Collaboration Users - 
note how store plans set to statuses other than ISSC in store Manager are not visible in In-
Store Space Collaboration. Also note that the parent store for the store plan must also 
have been given the appropriate permissions in the Stores Tab of the Data Security dialog 
box. 
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It is possible to set permissions for statuses by function: i.e. Admin Users, ISSC Users, etc. 
It is also possible to set permissions using other criteria. For example if ISSC User, Junior 
Manager and Senior Manager User Groups are set up in Functional Security, it would be 
possible to set up file statuses to that they are visible at the appropriate levels of 
management.  
 

Adding and Removing Permissions for Statuses 
Adding Permissions for Statuses  

Note: at present this functionality only affects In-Store Space 
Collaboration. If Macro Space Management users have the 
appropriate privileges to use either the Planner or 
Merchandiser Modules, they can access store plans at all 
statuses in the Store Hierarchy. 

Adding Permissions for Statuses is done in three stages 
1. Highlight the required status and select the Add User Group option from the Edit 

menu 

 

2. This will bring up the Add User Group dialog box. The User Groups it is desired to 
add can be selected from the list. 
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Note: User Groups (and the Users assigned to them) are set 
up using the Functional Security option. 

3. On clicking OK, the selected User Group will be added to the list of those that can 
view store plans of that status in In-Store Space Collaboration. 
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All Users belonging to the selected User Groups will be able to access store plans of that 
status in In-Store Space Collaboration (providing they also have rights to access that 
store). 
Deleting Permissions for Statuses 

Deleting Permissions for Statuses is done by highlighting the User Group it is desired to 
remove and selecting 'Delete Link' from the Edit menu. 
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